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Foreword

When digital content is created in any type of format (textual, graphic, audio or
multimedia), it is necessary to keep in mind that users of such content may be
people with physical, sensory or cognitive limitations, who could find barriers to

access the information.

In fact, at some point in our lives, we all probably will have limitations that can
affect our access to digital content. This is evident if we have a permanent
disability. Nevertheless, even if we do not have it, it does not mean we are out of
this issue. On the contrary, itis very likely that several times our physical, sensory
or cognitive abilities will be temporarily reduced by any event or accident, or
simply by the conditions of our environment. For example, we might ever need
to hear a story in a noisy environment that prevents us from clearly hearing what

the speaker is telling.

And, of course, we lose our capacities as we are aging. It is more difficult for us
to access information, and we need assistive products. The clearest example is

the need for corrective lenses to read small text.

In general, the use of assistive products for accessing digital content is
something we all use regularly. These are often called "assistive technologies"
and can be software or hardware. We do not realize that we are often using these
aids. For example, when we zoom to better view the content on a screen, we are
using assistive software, in this case a program to increase the size of content,

which is integrated into the operating system itself.
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This book will often refer to assistive technologies, which can be simple and
commonly used as the zoom of the screen. However, they can be much more
advanced, such as screen readers, commonly used by people with visual
disabilities to hear the description of visual content that they cannot see on the

screen.

Therefore it is very important that the authors of digital content take into account
minimum standards to ensure that content can be used by the widest audience.

It must be accessible content.

In this context, accessibility is a characteristic that makes digital content
perceivable, understandable and usable by anyone, regardless of whether he or
she has a disability. It is very difficult to get fully accessible content, but following
some simple tips, it is easy to reach an acceptable level of accessibility, which

allows interested persons to access the information without trouble.

The guidelines set out in this book are not new. In general, they are common
sense recommendations, and many are suggestions proposed by the creators
of content editing tools, which for some years have provided mechanisms to
generate accessible content, but are often unknown by authors. Most of the
guidelines are independent of the technology used in the creation of content. For
example, the recommendation of “content in video format must include subtitles”

is generic and applicable to any video editing technology.

This book is intended to be a practical guide. Therefore, in addition to providing
guidance, examples of how to perform them using some of the most used editors
of digital content are presented. Among others, Microsoft Office suite to create
documents (with Word) and slide presentations (with PowerPoint) are used,
because they offer advanced mechanisms that help the author to create and
revise the accessibility of content.

This guide is useful for creating accessible digital content, even if the reader does
not use the editing tools showed in the practical cases, because requirements
can be found for such content, and it is easy to locate the features in another

editor. For example, to meet the requirement that every image in a document or
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presentation should have a text that describes it, this guide explains how to do it
in a few editors, but any current editor allows the author to enter that description,

and the user only has to find such functionality in the editor used.

The book consists of five chapters, which try to cover the widest variety of digital
content formats. Each chapter has been created by different authors, who come
from a total of four different countries: Colombia, Ecuador, El Salvador and

Spain.

The first chapter is about how to create accessible documents with a text
processor. This chapter provides general guidelines that can be applied using
any text processor. These guidelines start with the requirement of establishing
the language of the document, which is important because the screen reader
used by a blind person generates the audio in the same language of the
document. After that, many other recommendations are described for getting
accessible documents. Finally, the way to use the tools for checking the

accessibility of a document is described.

The second chapter shows general guidelines for creating accessible
presentations, as well as practical cases using PowerPoint. Many of the
recommendations introduced in the first chapter are showed again in this
chapter, although they are adapted to a presentations editor. Moreover, one

section describes how to check the accessibility using tools such as PowerPoint.

The third chapter is dedicated to the accessibility of files and documents in PDF
format. In this case, if the PDF document is obtained using an accessible source
document we could confirm that the resulting PDF is accessible. However, in
some situations there are non-accessible PDF documents published in the web,
and therefore the source version is not available. Because of this, this chapter
shows how to use the tools for automatically checking the accessibility of a PDF
document, as well as the way to solve some accessibility issues directly in a PDF

document.

The fourth chapter is based on accessible audiovisual content. It is divided into

two main sections: the first part is based on accessibility in videos, which explains
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how to easily create videos with subtitles and an audio description; and the
second part is about audiobooks, which shows how to convert a text document

into voice and into an audiobook format, compatible with the main players.

The fifth chapter is about accessibility in webpages. Much of the digital content
currently used is showed in a webpage format, so it is important to provide
accessible web content. In this field, World Wide Web Consortium (W3C) is the
organization responsible of providing the standards supported in websites, such
as HTML or CSS languages. The aim of this organization is also to promote
accessibility in webpages, by providing recommendations. This chapter is
oriented to describe the guidelines about accessible web content, known as Web
Content Accessibility Guidelines (WCAG). These guidelines have to be taking
into account when creating webpages or web content. This chapter also shows

how to check the accessibility of a webpage using automatic tools.

Finally, a bibliography section has been included, where the reader can find
references to other documents and guides for obtaining more information about

these aspects of accessibility.

The aim of this guide is being a starting point for authors of digital contents.
These authors have to be aware of the accessibility issues that can be in digital
resources: documents, presentations, videos, books or webpages. This guide
also provides practical examples for easily showing the guidelines and

recommendations for improving the accessibility of these resources.

This book has been created as part of ESVI-AL project, in cooperation between
Latin American and European universities, funded by the European Union
through ALFA Il program. Participants of another ALFA Il project called USo+I
have contributed with their experience to this project and this book. Both ALFA
Il projects have been coordinated by the University of Alcala: USo+| project was
coordinated by Professor Elena Campo Montalvo, and ESVI-AL project was
coordinated by Professor José Ramén Hilera Gonzalez. The aim of these

projects and the ALFA Ill program is contribute to improve higher education.
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The tools proposed in this guide can help to obtain accessible digital content,
progressing towards a more inclusive and therefore better and fairer education,

without barriers for disabled students.

The guide in electronic format, as well as other resources can be found on the

web www.esvial.org.

Alcala de Henares, Spain, January 2015

José Ramoén Hilera Gonzalez
Elena Campo Montalvo
Eva Garcia Lépez

Antonio Garcia Cabot
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Chapter 1. Creating accessible text documents

using Word

Translators: Authors:
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Antonio Garcia Cabot Universidad Catdlica del Norte, Colombia
University of Alcala, Rocio Alicia Quintanilla Flores

Spain Oscar de Jesus Aguila Chavez
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Considering that most of the learning resources published in a virtual
educational environment are designed in a text format. Microsoft Word
becomes one of the most known and used applications for creating written

documents.

This chapter contains a set of guidelines about the accessibility requirements
and the essential criteria for creating educational contents based on the
principles of universal design or design for all, in order to incorporate the
principles into the design and production of educational resources that will
facilitate the process of teaching and learning of students with and without

disabilities.
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1.1 Guidelines for creating accessible contents in
Microsoft Word

When learning content (as well as any type of document) is created, a good
level of readability of the content should be ensured, regardless of the
disabilities or a temporary disability, age or language. It is important to make
people aware that poorly-designed or difficult to understand content not only
affects people with disabilities or people with limited communication, mobility or

understanding but also general users.

For creating accessible educational content, it is important to make three
aspects understandable: content, structure and format. Following, are

described the main criteria to consider.

1.1.1 Simple text

The content should be written in brief and simple language, without using
complex grammatical structures. The message to be conveyed should be
concrete and direct, avoiding where possible abstract terms which could be

confusing.

A document does not become more valuable even if it is longer. Unnecessarily
long sentences should be avoided, the document should not be full of
redundant expressions such as «it is knowny, «it is generally accepted thaty,
«in my personal opinion», «and so on», and «As A and B both think».
Whenever possible, use simple words, try to divide sentences into shorter
ones, but remember to include linking words («but», «so», «although») for
consistency (European Commission & Directorate-General for Translation,
2011).

1.1.2 Document language

Visually impaired users use screen readers that convert document texts into
spoken audio. Therefore, indicating the language is fundamental so that these

devices are able to correctly transmit information.



GUIDE FOR CREATING ACCESSIBLE DIGITAL CONTENT

When using words in another language, the change to a different language

should be marked, except for proper names, technical terms, words of

indeterminate language and words not belonging to the general language of the

document but the use of which is widespread.

Instructions for establishing or checking the document language.

= Option 1: using a mouse:

Select the “Review” tab. Click “Language” and select the “Set proofing

language” option.
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FouiGlt

Set Proofing Language

Set the language used to check the
spelling and grammar of the
selected text.

Figure 1-1. Language selection menu.

= Option 2: using a keyboard:

Press the “Alt + R” keys to activate the “Review” tab, and then press the “W”

key and the “Language” menu will appear. Press the “N” key to select “Set

proofing language”.
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When one of the two options is performed, the “Language” window will appear.

The language preference can be selected by using the arrow keys up and

down, and then pressing the “Enter” key (Figure 1-2).

@' =] Q= Documentl - Microsoft Word
Home Insert Page Layout References Mailings Review View Add-Ins EndNote X4
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To create T & Galidan
navigation o A Spanish (International Sort)
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Figure 1-2.

A quick way:

The speller and other proofing tools automatically use
dictionaries of the selected language, if available.

[] Do not chedk spelling or grammar
Detect language automatically

[ set As Gefaut | [ ok ][ coneel

£ C IS =R N = S § IS U E S N N - ]

Window for setting the language.

The document language can be selected in a quick way by clicking on the

language in the status bar (Figure 1-3). The status bar is located under the

edit box of the document, but it is not possible to access it through any key

combination in Windows. Therefore, it is not an accessible option.

160 1 15"

Page:1 ofl |

Words: 0 | @ Spanish (International Sort] |

Figure 1-3.

Selecting the language from the status bar, a quick but not

accessible way.
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1.1.3 Font characteristics

As mentioned at the beginning of this section, contents should be as clear and
simple as possible in order to be accessible, but the font used in texts can

assist or impede the complete understanding of information.

The most commonly used font is of the “serif” type, which has small ornaments
usually located at the end of the character lines. Fonts Times, Georgia and
Garamond are some examples of this kind. “Sans serif” (without serif) fonts

lack the ornaments.

The difference between these two font types is in their readability: the “serif”
type shows a very high print resolution on a printed page, so the small
ornaments in the letters are well defined. On the contrary, the resolution is not
very high on a computer screen, which produces effects on the letters that

make reading difficult (Gracia Murugarren, n.d.).
Comparison of the “serif” and “sans serif” fonts, plain format, size 12:
Serif (Garamond, 12) Sans Serif (Verdana, 12)

Because of this, using “Sans Serif” fonts such as Arial and Verdana is
recommended, in a no smaller size than 12 points, avoiding where possible the

use of italics and moderately using bold to highlight texts.

=) rayc vviuu | wWindow All wWindows = ot
Zoom Window Macros

1-|-R-|-1-|-2-|-E-|-4-|-E-|-s-|-_-'--|-5-|-5-|-1:--|-11-|-12-|-1E-|-14-|-J\-|
i} g g g 0 g g g g g g g g

CASE 5TUDY

Mowadays we sts
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PHH+HHIHLI'I-HJ- I

Figure 1-4.  Screen magnifier that allows low vision users to read a

document.
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Low vision users have some problems with focus or clarity, hyperopia, myopia
and tunnel vision. While reading documents, it is very likely that these users
benefit from high contrast color schemes, large fonts and large icons with the
help of screen magnifiers (Figure 1-4). Although these devices can set the
presentation options for the computer, using a font too small should be
avoided. As a general rule, the smallest font size to be used is 10 points
(Office, n.d.-b).

1.1.4 Titles

Before starting writing a document it is necessary to define its structure, which

should be logical and coherent.

Of Computer Users

7 \\\

N Mozilla Firefox,
."f Components of \ Google Chrome,
| o }—b Of Web Browser Internet Explorer,
| Web Accesibility f Safarip

\\ / Opera

Ny %
e
Of Content Authors

Figure 1-5. Example of contents scheme.

It is important to define the groups and titles of the main contents in levels 1, 2
and 3 which form the main title. A scheme may be used for organizing and
guiding about how to structure the document. An example of such a scheme is

shown in

Figure 1-5, which contains the main title “Components of Web Accessibility”,
which is divided into three secondary titles: “Of Computer” (with an item called
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“Users”), “Of Web Browser” (with items “Mozilla Firefox”, “Google Chrome”,
“Internet Explorer”, “Safari” and “Opera”), and “Of Content” (with an item called
“Authors”).

Instructions for creating main titles and subtitles.

= Option 1: using a mouse:
The desired format for the document text is set in the “Styles” section/group

on the “Home” tab (Figure 1-6).

MWH9-™ 3= Documenl tl - Microsof ft Word "D v L |
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- ) —
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Paste B 7 U -~ ake x, X° 1 Figura T Normal |7 NoSpad. Headingl Heading2 Title Subtitle Char
= ~ 1 e

- Format Painter

Subtitle
AgBbCcDr AoBbCcDe AaBbCcDi AaBbCeDe AaBbCcDi AaBbCcDi A-EEC:LL—L

Clipboard Font
> % |[d] RN R Gt 23 L3 Ll SuptieEm..  Emphasis  IntenseE..  Strong Quote  Intense Q.. Subtle Ref..
n P - =
AABBCCDL  AABBCCDL  AaBbCcDe
EREC=! - Intense R.. BookTitle 1 ListPara...
A Save Selection as a New Quick Style..
This d - X
ac &, Clear Formatting
contain - P )
headings. B T apply stles..
To create =
navigation
tabs, creste
heading

adings in
your document
by applying

Heading Styles.

Figure 1-6.  Applying styles to normal text and headings 1, 2 and 3.

= Option 2: using a keyboard:
The text style is selected by simultaneously pressing the following keys
combinations (Office, s.f.-c):
Normal style: “Ctrl + Shift + A”.
Heading 1: “Ctrl + !”.
Heading 2: “Ctrl + “.
Heading 3: “Ctrl + Shift + 3”.

1.1.5 Paragraphs and section breaks

1.1.5.1 Paragraphs

Users with cognitive impairments or even with low vision cannot perceive the

text and/or get lost while reading if the text is presented in a way that is difficult
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to read. That is why attention should be paid to paragraphs by considering
three important aspects: text alignment, margins and line spacing and

paragraph spacing.
Text alignment

When creating documents, the text alignment to the left is the default
configuration, although alignment to the center, to the right or justified
alignment can also be used. Many people prefer to read a justified text but
some studies have demonstrated that texts aligned to the left are easier to read

(Lujan Mora, n.d.). Therefore, the text should not be justified.

In the guide to understanding and implementing Web Content Accessibility
Guidelines (WCAG) 2.0 (World Wide Web Consortium, 2014) about making it
easier for users to see and hear content (guideline 1.4), success criteria 1.4.8
[Visual Presentation], it is suggested that people with certain cognitive
disabilities have problems reading text that is both left and right justified. The
uneven spacing between words in fully justified text can cause “rivers of white”
space to run down the page making reading difficult and in some cases
impossible. Text justification can also cause words to be spaced closely
together, so that it is difficult for people with cognitive disabilities to locate word
boundaries (World Wide Web Consortium, 2014).

Instructions to align paragraphs to the left.

= Option 1: using a mouse:
Select the “Home” tab, the “Paragraph” section/group and then the “Align

text left” option.

= Option 2: using a keyboard:
Simultaneously press the “Ctrl + Q” keys.

Margins

The success criterion 1.4.8 indicates that users with some reading or vision
disabilities may have trouble keeping their place and following the flow of long

lines of text, which can become a significant barrier. They have trouble keeping
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their place and following the flow of text. Having a narrow block of text makes it
easier for them to continue on to the next line in a block, so lines should not
exceed 80 characters (World Wide Web Consortium, 2014).

Figure 1-7 shows a screenshot of a non-accessible text having narrow margins,

and line and paragraph spacing of 1.5 points.

CHAPTER |
WHICH TREATS OF THE CHARACTER AND PURSUITS OF THE FAMOUS GENTLEMAN DON
QUIXOTE OF LA MANCHA

In avillage of La Mancha, the name of which | have no desire to call to mind, there lived not long since one of those
gentlementhat keep alance in the lance-rack, an old buckler, a lean hack, and a greyhound for coursing. An olla of
rather more beefthan mutton, a salad on most nights, scra[as on Saturdays, lentils on Fridays, and a pigeonor so
extraon Sundays, made away with three-quarters of his income. The rest of it wentin a doublet of fine cloth and
velvetbreeches and shoes to match for holidays, while on week-days he made a brave figure in his besthomespun.
He had in his house a housekeeper past forty, a niece undertwenty, and a lad for the field and market-place, who
used to saddle the hack as well as handle the bill-hook. The age of this gentleman of ours was bordering on fifty; he
was of a hardy habit, spare, gaunt-featured, avery early riser and a great sportsman. They will have it his surname
was Quixada or Quesada (for here there is some difference of opinion among the authors who write on the subject},
although from reasonable conjectures it seems plain that he was called Quexana. This, however, is of but little
importance to our tale; it will be enough notto stray a hair's breadth from the truth in the telling of it. You must
know, then, that the above-named gentleman whenever he was at leisure (which was mostly all the year round)
gave himself up to reading books of chivalry with such ardour and avidity that he almost entirely neglected the
pursuit of his field-sports, and even the management of his property; and to such a pitch did his eagernessand
infatuation go that he sold many an acre of tillageland to buy books of chivalry to read, and broughthome as many
of themas he could get. But of all there were none he liked so well as those of the famous Feliciano de Silva's
composition, for their lucidity of style and complicated conceits were as pearls in his sight, particularly whenin his

readinghe came upon courtships and cartels, where he oftenfound passages like "the reason of the unreason with

Figure 1-7. Example of a not accessible text.

Figure 1-8 shows a screenshot of an accessible text that contains maximum of
80 characters per line, line spacing of 1.5 points and paragraph spacing of 20

points.

CHAPTER|

WHICH TREATS OF THE CHARACTER AND PURSUITS OF THE FAMOUS GENTLEMAN DON
QUIXOTE OF LA MANCHA

In a village of La Mancha, the name of which I have no desire to call to mind, there lived not
long since one of those gentlemen thatkeepalance in the lance-rack, an old buckler, a lean
hack, anda greyhound for coursing. Anolla of rather more beefthan mutton, a salad on most
nights, scraps on Saturdays, lentils on Fridays, and a pigeon or so extraon Sundays, made away
with three-quarters of hisincome. The restof it wentin a doubletof fine cloth and velvet
breeches and shoes to match for holidays, while on week-days he made a brave figure in his
besthomespun. He hadin his house a housekeeper past forty, aniece undertwenty, anda lad
for the field and market-place, who used to saddle the hack as well as handle the bill-hook. The
age of this gentleman of ours was bordering on fifty; he was of a hardy habit, spare, gaunt-
featured, averyearly riser and a great sportsman. They will have it his surname was Quixada

or Quesada (for here there is some difference of opinion among the authors who write on the

Figure 1-8. Example of an accessible text.
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Instructions for creating accessible margins:

= Option 1: using a mouse:
Select the “Page layout” tab, the “Margins” option and then choose/select

“Normal” or “Wide”.

= Option 2: using a keyboard:
Press “Alt + C” to activate the “Page layout” tab, press “E” to select the
“Margins” option and select “Normal” or “Wide” by using the arrow keys up

and down, and then pressing the enter key.
Line spacing and paragraph spacing

People with some cognitive disabilities find it difficult to track text where the
lines are close together, and they are not able to track the next line and do not
recognize the end of a paragraph. It is recommended to use space-and-a-half
for line spacing, i.e. that the top of the one line is 150% further from the top of
the line below it (World Wide Web Consortium, 2014).

According to Lujan Mora (n.d.), paragraphs should be easily distinguished from
each other for easy understanding and reading of the texts. Printed contents
such as newspapers, books or journals, usually follow the convention to
remove blanks above and below paragraphs, and instead indent the first line of
each paragraph. However, it is recommended to keep this convention for
printed contents (only). Figure 1-9 shows how paragraphs separated by blank
lines present the text in a more accessible way, which is easy to read and

understand.
Instructions for creating line and paragraph spacing:

= Option 1: using a mouse:
Select the “Home” tab, in the “Paragraph” section/group, and the “Line and

Paragraph Spacing” option, as shown in Figure 1-10.

= Option 2: using keyboard (simultaneously pressing):
For single-spaced lines: “Ctrl + 1”.

For double-spaced lines: “Ctrl + 2”.
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For adding or removing one line space before a paragraph: “Ctrl + 0” (zero).

CHAPTER |

WHICH TREATS OF THE CHARACTER AND PURSUITS OF THE FAMOUS GENTLEMAN DON
QUIKOTE OF LA MANCHA

Ina vilage of La Mancha, the name of which | have no desire to call to mind, there
lived not long since one of those gentiemen that keep 2 lance in the lance-rack, an old buckler,
a lean hack, and  greyhound for coursing. an olfa of rather more beef than mutton, a sslsd on
most nights, scraps on Saturdays, lentils on Fridays, anda pigeon or soextra on Sundays, made
away with three-quarters of his income. The rest of it went in a doublet of fine cloth and velvet
breeches and shoes to match for holidays, while on week-days he mage a brave figure in his
best homespun. He had in his house 3 housskesper past forty, 2 nisce under twenty, and a lad
for the field and market-place, who used to saddle the hack as well as handie the bilkhook. The
ageof this gentleman of ours was bordering on fifty; he was of a hardy habit, spare, gaunt-
featured, a very early riser and great sportsman.

They will haveit his surname was Quixaia or Quesada [for here there is some
difference of opinion among the authors who write on the subject], although from reasonable
conjectures it seems plain that he was called Quexana. This, however, s of but littie
importance to our tale; it will beenough not to stray 2 hair's breadth from the truth in the
telling of it. You must know, then, that the above-named gentieman whenever he was at
Ieisure [which was mostly all the year round) gave himself up to reaing books of chivalry with
such arggur and avidity that he aimost entirely neglected the pursuit of his figkd-sports, and
eventhe management of his property; and to such a pitch did his eagerness and infatuation go
that be sold many an acre of tilageland to buy books of chivairy o read, and brought home as

Figure 1-9.

cHAPTER |

WHICH TREATS OF THE CHARACTER AND PURSUITS OF THE FAMOUS GENTLEMAN DON
QUIKOTE OF LA MANCHA

Ina vilage of La Mancha, the name of which | have no desire to call to mind, there fived not
long since: one of those gentiemen that keepa lance in the lance-rack, anold buckier, alean
hack, and a greyhound for coursing. an ola of rather more besf than mutton, 3 salad on most
nights, scraps on Saturdays, lentils on Fridays, and 2 pigeon orso extra on Sundays, made away
with three-quarters of his income. The rest of it went in 2 doublet of fine doth and velvet
breeches and shoes to match for holidays, while on week-days he made a brave figure in his
best homespun. He had in his hous a housskesper past forty, 3 nisce under twenty, and a lad
for the fiekd and market-place, who used to saddle the hack as well as handle the bilkhook. The
ageof this gentleman of ours was bordering on fifty; he was of a hardy habit, spare, gaunt-
featured, 3 very early riser and s greatsportsman.

They will have it his surname was Quixaga, or Quesada [for here there is some difference of
opinion among the authors wha write on the subject},, although from reasorable conjectures it
seems plain that he was called Quexana. This, bowever, i of but fitle importance to our tale;
it will be enough not 1o stray a hair's breadth from the truth in the telling of it. You must know,
then, that the above-named gentieman whenever he was at leisure (which was mostly all the
year round] gave himsef up to reading books of chivairy with such argour and avidity that he
almost entirely neglected the pursuit of his field-sports, and even the management of his
property; and to such a pitch did his eagerness and infatuation go that he sokd many anacre of

Comparison between paragraphs separated by indentation (left)

and paragraphs separated by blank lines (right).
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Figure 1-10. How to set line and paragraph spacing.

Section break or page break

It is necessary to use section breaks or page breaks provided by Word instead

of using carriage return so that the text goes to the next page.
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Instructions for creating section breaks:

= Option 1: using a mouse:
Select the “Page Layout” tab, the “Page Setup” section/group, and the

“Breaks” menu (Figure 1-11).

= Option 2: using a keyboard:
Press “Alt + C” to select the “Page Layout” tab, and then press “B” to select
the “Breaks” menu that shows the types of page breaks and section breaks.
It is recommended to use the “Page” option (press the “P” key to select it)

instead of using the “Enter” key.

When the document has several chapters, using the “Next Page” option is

recommended (press the “N” key to select it).
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Q breadth from the truth in the telling of it. You must know, then, that the above-named not
= gentleman whenever he was at leisure [which was mostly all the year round) gave himself up twe
b

Figure 1-11. How to set section breaks and page breaks.
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1.1.6 Lists, numbering and bullets

Regarding lists, using dashes, asterisks or symbols as a separating element
should be avoided, because when done a list is simulated, but this is not the

correct way to do so.
Instructions to create numbered lists or bullets.

= Option 1: using a mouse:
Select the “Home” tab, the “Paragraph” section/group, and the “Bullets” or

“‘Numbering” option.

= Option 2: using a keyboard:
Write an asterisk to start a bulleted list or number “1” to start a numbered list

and then press the spacebar or the tab key, and a list will be automatically

generated.
@l H Sl ] _l |= Documentl - Microsoft Word
Home Insert Page Layout References Mailings Review View Add-Ins EndMote X4
J ibri - - AT - | B i=|| iz . 4= | EE EE | A
E Calibri(Bocy) - /11~ A" A" | Aam ) (= E FE LT fue 1 a | Aaboede | Ac
Paste . 2 . a7 . A . | Recently Used Bullets
+ < Format Painter B I U-absx x =9 THNormal |TH
Clipboard 1 Font 1 ®
Mavigation * X I F.1 8 1
g lg = Bullet Library P
Search Documen 2 - . .
None ® @) u +* *
oo | =
SRS o
This document _ ~ ‘/
does not -
contain = Document Bullets
headings.
To create B L
navigation
tabs, create = =
headings in =
your document - Define New Bullet...
by applying -
Heading Styles.
I Correct Way Incorrect way
- s Pointl * Point 1
; e Point2 * Point 2
n

Figure 1-12. Correct way to create lists.
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1.1.7 Columns and tables

1.1.7.1 Columns

If the requirement is to write a newspaper article or newsletter where placing
the text in more than one column is necessary, it is recommended to use an
adequate tool for this, avoiding the tab key to separate text or simulating it by

means of tables.

@“ H ™ _31, |= Documentl - M
Home Insert Page Layout References Mailings Review View Add-Ins EndMote X4

j E Calars = J Ly s lj H=) Breaks - j @ J Indent
= Fonts ~ -j %_1 Line Numbers = = left Ocm

Themes Margins Orientation Size |Columns Watermark Page Page
- E Effects = - - - - b~ Hyphenation - - Color~ Borders | == Right: 0cm

Themes Page Se " Page Background
One
Mavigation > X |[]

search Documen Q@ -

ERERE -

|
g
[=]

Three

This document =
does not
contain =
headings.

LL l_IL ]

Left

To create = Right
navigation B =
tabs, create —
headings in - EE  More Columns...
your document - ‘

by applying
Heading Styles.

Figure 1-13. How to create text columns.

Furthermore, ample spaces between columns should be set when using text
columns as shown in Figure 1-13 (Moreno Lopez, Martinez & Gonzalez, 2014).
If this is not taken into account, readers will read the lines in a row instead of
going down by the column. Following this recommendation will make the
document easy to read by assistive devices, by people with low vision and by

everyone in general.
Instructions to create text columns:

= Option 1: using a mouse:
Select the “Page Layout” tab, the “Page Setup” section/group, and the

“Columns” option.

14
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= Option 2: using a keyboard:
Press “Alt + C” to access the “Page Layout” tab and then press the “J” key

to select the “Columns” menu.

Figure 1-14 shows that an ample space between columns provides a more

accessible presentation.

Figure 1-14. Text columns should be separated by ample blank spaces.

The information showed in the columns may be difficult to access by a person
with disabilities who needs assistive technology, so using columns is

recommended only if really necessary.

1.1.7.2 Tables

As mentioned in the previous section, using the tool provided by Word is
recommended to put the text in columns, avoiding using tables or tabulators.
This is due to tables being elements that cause accessibility problems. For
example, a user with total or partial blindness who uses assistive devices such
as readers and/or braille devices reads tables row by row across the columns

(Office, n.d.-e), as shown in Figure 1-15.
Al L} B1 +’ c1

A2 == B2 Fcz

Figure 1-15. Direction in which an assistive device reads the content of a
table.

15
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Because of this, if tables are included for analysis in a document, it is important

that the information contained can be read consistently line by line.

Example 1: Table seen by users with normal vision:

Destination Month Amount Concept
Colombia January 500 Product B
El Salvador March 200 Product A
Spain February 600 Product B

Table 1-1. Table structure for users with normal vision.
Example 2: Table read by an assistive device:

Destination, Month, Amount, Concept, Colombia, January, 500, Product B,
El Salvador, March, 200, Product A, Spain, February, 600, Product B.

Users with normal vision can analyze the table shown in example 1 without
difficulties, due to the eyes recognizing the heading for each piece of data and
associating the information contained in the cells. However, users with visual
disabilities lose the information that the table provides, and should be aided by
a device to read the rows, which may be relevant or not depending on the

design and layout of information.

Therefore, it is appropriate to describe how a table fits in the context of the
document. Even if a title is not provided, it is very important to provide a

summary as shown in Example 3.
Example 3: Summary of the content of the table.

“Details about importation of products A and B. The table is divided into four
columns. From left to right, the first column “Destination” includes the three
main destinations of importation: Colombia, El Salvador and Spain. The
second column shows the month in which the importation was done (in this
case, January, March and February, respectively). The third column shows

an amount the values of which are 500, 200 and 600 respectively. The
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fourth column specifies the type of product imported. In conclusion based
on the data shown in the table, 500 importations of product B were done in
Colombia in January; 200 importations of product A were done in El
Salvador in March; and 600 importations of product B were done in Spain in

February”.

Furthermore, Moreno, Lopez et al. (2014) recommends:

Tables should not be too large and if possible they should be kept on one

page.
Tables divided into several pages tend to cause accessibility issues.

When tables are inevitably large and take up more than one page, the
headers of the table should be repeated on each page and rows should not

be divided when moving to the next page.

If a table is inevitably large and it is divided into several pages, the headers
of the table should be repeated in each page and rows should not be
divided.

1. Select the table and click the right button.
2. In the menu select “Table Properties".

3. In the “Row” tab, select the option “Repeat as header row at the top of

each page”.

17
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. — y
Table Properties 5 d“—H
Table Row Colymn Call AR Text
Rows: e
Size
Specify height:
Options
¥ | Allow row to break across pages
“ Previous Row v Next Row
oK Cancel

Figure 1-16. Repeat the header row in each page.

In conclusion, it is important to design simple tables, avoiding combining

complex cells and tables.

1.1.8 Figure captions

When inserting figures it is recommendable to include a title or a figure caption.
This will help users to identify the content and help the document authors to

reference the figure and to better structure the document.
Instructions for creating figure captions.

= Option 1: using a mouse (Figure 1-17):
Select the figure and then the “References” tab. Then select the “Insert
Caption” option in the “Captions” section/group. A window will be opened,
giving the option to write the title (caption) of the figure. The steps should be
repeated for each figure, and Word will automatically add similar titles and

numbering.

= Option 2: using a keyboard:
Press “Alt + S” to activate the “References” tab and then press the “P” key

to select the “Insert caption” option.

18
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Figure 1-17. How to set figure captions.

1.1.9 Table captions

If the document has data tables, a title should be included for each of them.
These titles will help the users who access the document using a reader to get
familiar with the information contained in the tables. The same procedure is
carried out for adding figure captions. In this case, the “Table” option is

selected in the “Label” field, as shown in Figure 1-18.

1.1.10 Tables of contents

A table of contents provides a general visualization about the content of a
document, schematizing the structure of the topics and subtopics of which is
composed, establishing a direct link or a reference to a specific point in the

document.
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Figure 1-18. How to set table captions.
Instructions for creating tables of contents:

= Option 1: using a mouse:
Select the “References” tab, the “Table of contents” section, and the “Table

of Contents” option.

= Option 2: using a keyboard:
Press “Alt + S” to activate the “References” tab, press the “T” key to activate
the “Table of Contents” menu (Figure 1-19), and then use up and down

keys to select any of the options of presentation contents.

Widd9-0 Qs

m_ Home Insert Page Layout References hail
ddT wt rt Endnot j
=~ ext - ABi Ui 58 nanate &l

pdate Table ﬁ@ex‘t Footnote -

Table of Insert Insert

Cntsv Foptngte ihnw Motes Caﬁfn
hle of Contents Foi tes ¥

Figure 1-19. How to create a table of contents.
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As new topics and/or subtopics are included, the table of contents can be

updated by using the “Update table” option.

@“ I.H e _-l = Documentl - Microsoft Wo

Home Insert Page Layout References kailings Review

[Ep Add Text - ABl [y Insert Endnote m‘j ] Insert Table of F

- _.T'?Update Table ﬁg Mext Footnote - =¥ Update Table
Table of Insert ) Insert
Contents ~ Footnote = Show Notes Caption [fy Cross-reference
Table of Contents Footnotes ¥ Captions
! | Secur Update Table d. Enable Content
.. Update the Table of Contents so 5
Navigation| nat ail the entries refer to the P2 a - VB[l
correct page number,
Search Do
ao =1 ™
J oo (= | ™ -
Thic Anariimant -

Figure 1-20. How to update the fields of tables of contents.

1.1.10.1 Tables of figures

The procedure for creating tables of figures is similar to creating tables of

contents.
Instructions for creating tables of figures.

= Option 1: using a mouse:
Select the “References” tab, and then select the “Insert Table of Figures”

option in the “Captions” section (Figure 1-21).

= Option 2: using a keyboard:
Press “Alt + S” to activate the “References” tab, and then press the “G” key
for selecting the “Insert Table of Figures” option. A setup window will

appear, as shown in Figure 1-22.
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Figure 1-22.
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Creating a table of figures using a mouse.
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1.1.11 Page numbers

With the aim of facilitating the access to the contents of the document, it is
necessary to insert page numbers. This will help the user to find the page in

which he/she is interested through the table of contents, and then to access it.
Instructions for creating page numbers.

= Option 1: using a mouse:
In the “Insert” tab, in the “Header and footer” section, select the “Page
number” menu, which will show the options to insert the page numbers in

the document (Figure 1-23).

= Option 2: using a keyboard:
Press “Alt + B” to activate the “Insert” tab. Then press the “J” key to select

the “Page number” menu.

@' H9-0 % = Documentl - Microsoft Word
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Cover EBlank Page Table Picture Clip Shapes SmartArt Chart Screenshot | Hyperlink Bookmark Cross-reference | Header Footer | Page Text  Quick WordAr
Page~ Page Break = Art = ~ ~ = Mumber~| Box~ Parts~ ~
Pages Tables Illustrations Links Header & Fi é] Top of Page y L
Navigation N SN W ‘é'l‘l:l'Z'II'E'I'I-"' ‘5 1617 ' {[}] Bottom of Page v [
Search Documen O~ [ Page Margins r
#]  Current Position b
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J oo | =l
Format Page Numbers...

Remove Page Numbers

e
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does not
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Figure 1-23. How to set page numbers.

1.1.12 Alternative texts

Non-text elements such as figures, graphs or schemes should have an
alternative text to describe the information we want to communicate. The
description contained in these elements should be able to replace the visual or
auditory information in order to make sure users with sensory disabilities, who
access the document using an assistive device such as Braille lines or readers,

can get all the information.

Non-text elements that require alternative texts are figures, mathematical

formulas, diagrams or schemes, videos, audios and text boxes.
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Instructions for assigning an alternative text to a figure.

= Step 1: Click on the figure with the right mouse button and select “Format

picture...” (Figure 1-24).
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Figure 1-24. How to set the format to a picture.

= Step 2: Select the “Alt Text” option in the “Format Picture” window, and write

a description for the information provided in the figure (Figure 1-25).

Alternative text of the example figure:

“The image shows the International Symbol of Access in white color with

blue background”.

For creating an alternative text, imagine that you are talking to someone on the
phone and that you have to describe a particular image. The description should
be as objective and graphical as possible for the listener to know exactly what
the image looks like without having to see it. The resulting description will be

the alternative text (Fundacion Universidad, 2013).
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-

Glow and Soft Edges
3D Format

3-D Rotation

Picture Corrections
Picture Calor

Artistic Effects

Crop

Text Box

[ Alt Text l

Format Picture l E EE |
Fil Alt Text
Line Calor Title:
Line Style
Shadow Description:
) The image shows the International Symbol of Access in white color
Reflection with blue badckground

Titles and descriptions provide alternative, text-based
representations of the information contained in tables, diagrams,
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understand the object.
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determine whether they wish to hear the description of the
content.

Close

Figure 1-25. How to set an alternative text to the figure.

1.1.13 Accessible graphs

As in the case of figures, graphs should be accessible to all users, regardless

of their limitations. To do this, it is necessary to consider the use of color,

alternative texts and titles, which facilitate to access the information to be

conveyed.

1.1.14 Using flashing elements

Checkpoint 7.1 of WCAG 2.0 suggests: “Until user agents allow users to control

flickering, avoid causing the screen to flicker. [Priority 1]”.

When using flickering elements, such as animations, screen flashes or

flickering content, users who have photosensitive epilepsy may suffer an

attack.
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1.1.15 Multimedia elements

If the document contains audio or video, the information to be conveyed should
be accessible, ensuring that users with visual or hearing disabilities can receive

the message.

According to access to information commission of the European Blind Union
(EBU) (n.d.), multimedia material should be described in a manner that the
reader knows what he/she can expect. If a user with visual disabilities is
informed that the content of a video does not contain any audiodescription,
then he/she will know that it can be ignored. Second, to make the information
accessible to all users, some alternatives should be provided, such as the

following:

= Audiodescription: Particularly aimed at users with visual (or limited visual)

disabilities, where the videos or the image content are narrated on screen.

= Subtitles: Subtitles about what characters are talking about are shown on

the screen. They are for hearing impaired people.

= Braille: It is a point system, which is used by people with visual disabilities to

read and write.
= Sign language: It is the language used by deaf people to communicate.

= Easy reading: Easy reading texts are written in a short and simple language

that can be understood by people with cognitive or intellectual disabilities.

Chapter 1 of this course goes deeper into guidelines for creating accessible

audiovisual content.

1.1.16 Using color

When writing documents, it should be taken into account that among all users
that may access the information, a small number could have, to some extent,
color blindness. In many cases the problem may be not distinguishing colors or

just a specific color, or being able to see only black and white.
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Since we cannot know what the users’ limitations are who access the
information, we should be careful with semantic use of color and contrasting

colors and always provide an accessible design for all.

1.1.16.1 Semantic use of color

Using color as an indicator element should be avoided. Ultimately, if the use is
necessary, verify that all information conveyed with color is also available

without color.
Wrong way:

Relating to enrolment on the Web Accessibility course, available groups are
marked in blue, and those marked in red are not available.

Group 01: Monday and Tuesday

Group 02: Wednesday and Thursday

Group 03: Friday and Saturday

Group 04: Sunday

Right way:

Relating to enrolment on the “Web Accessibility” course, available groups
are marked as “Available”, and closed groups (i.e. not available) are marked
as “Not available”.

Group 01: Monday and Tuesday (Available)

Group 02: Wednesday and Thursday (Not available)

Group 03: Friday and Saturday (Not available)

Group 04: Sunday (Available)

1.1.16.2 Contrasting colors

Foreground and background color combinations should have enough contrast

to be perceived by people with color blindness or deficient color perception.

Web Content Accessibility Guidelines 1.0 (World Wide Web Consortium, n.d.),
which are also useful for document accessibility, suggest in Guideline 2: “Don't

rely on color alone”.
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Checkpoint 2.2: “Ensure that foreground and background color combinations
provide sufficient contrast when viewed by someone having color deficits or
when viewed on a black and white screen. [Priority 2 for images, Priority 3 for

text]”.

In “Pautas para el disefio de entornos educativos accesibles para personas
con discapacidad visual” (in Spanish, title translated: “Guidelines for designing
accessible educative environments for people with visual disabilities”) (Centro
de Investigacion, Desarrollo y Aplicacion Tiflotécnica, 2005), some examples
are shown of foreground and background color combinations which have a high

contrast facilitating the reading of users with visual disabilities.

It is worth remembering that letters and their size affect reading and text
comprehension. In order to make text readable enough, a minimum size of 12

points should be used, and sans serif typography.

Example:

BLACK ON WHITE WHITE ON BLACK

YELLOW ON BLACK WHITE ON BLUE

WHITE ON RED BLUE ON WHITE

RED ON WHITE YELLOW ON GREEN

Figure 1-26. Foreground and background color combinations.

1.1.17 Navigation links

If using links within the document is necessary, the target of each link should

be clearly identified.

According to “Manual de accesibilidad y buenas practicas” (in Spanish, title
translated: “Manual of accessibility and good practice”) by Universidad del Pais
Vasco, Spain (n.d.), links such as “click here”, “more info” or “read more” are
not recommended because they do not sufficiently describe the link. When an
internal or external link takes the user to a different page, the target should be

correctly indicated before the user clicks on the link.



GUIDE FOR CREATING ACCESSIBLE DIGITAL CONTENT

Examples for writing navigation links are detailed below.

Wrong way:

Once the pre-enrolment period is over, the University will publish a list for
setting a date and time for each student to enroll.

+ info

More...

Information

Enrolment
Right way:

Once the pre-enrolment period is over, the University will publish a list for
setting a date and time for each student to enroll.
More information about the enrolment process.

Performing online enrolment.

For inserting a navigation link or hyperlink in a document, as shown in Figure
1-27.

.
Insert Hyperlink ? =
Link to: Text to display: |Link
Look in: ‘| Mis documentos = =]
Existing File or | = E
Web Page Set Hyperlink ScreenTip M » Bookmark. ..
— Current |—|
Folder 1| coreenTip text: | | TargetFrame...
Flace in This |
Eomenk Browsed)| | yote: Custom ScreenTips are supported in Microsoft® Internet
Pages | | Explorer® version 4 or later.
Create New Recent OK ] [ Cancel ]
Document Files

Address:
E-mail Address

Cancel

Figure 1-27. How to insert navigation links.

Instructions for creating accessible navigation links:
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= Step 1: Select the “Hyperlink” option on the “Insert” tab.

= Step 2: Insert the text of the link and the address and select the

“ScreenTip...” option to include the description about where the link takes

the user.

1.1.18 Converting to a PDF document

For converting a document to PDF format, in addition to meeting the above

criteria, the accessibility options for converting to PDF should be set as follows:

= Step 1: Select the “File” tab.

= Step 2: Select the “Save & Send” option and then “Create PDF/XPS

Document”.

= Step 3: In the dialog box, press the “Options...” button to save the document

and check the “Document structure tags for accessibility” box.

(W]l = LS
Home Insert Page Layout References Mailings Rewvit
H Save
Save & Send
Save As
£ Open LﬂE -] Send Using E-mail
Lj Close
@ Save to Web
Info
Recant Save to SharePeoint
New @ Publish as Blog Post
Rust File Types
Save &‘S‘E“d H_ Change File Type
Help I
Create PDF/XP5 Document J
=] Options =
B9 Exit

Figure 1-28. How to convert a document to PDF.
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Options I._l_]t@ e e

Page range
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() Selection
) Page(s) From: | 2l To: [
Publish what
@ Document
Document showing markup
Include non-printing information
Create bookmarks using:
(@ Headings
Word bookmarks
Document properties
Document structure tags for accessibility
PDF options
[] 150 15005-1 compliant (PDF/A)
Bitmap text when fonts may not be embedded
[ Epcrypt the document with a password

[ oK l[ Cancel l

Figure 1-29. Accessibility options for conversion to PDF.

1.2 Accessibility evaluation tools

Several tools and techniques are available for evaluating the accessibility of
documents. This evaluation warns about the problems with accessing content
that people with disabilities may have due to their functional variety and/or
using assistive products, and it also allows evaluating the compliance with

accessibility guidelines defined by Web Accessibility Initiative (WAL).

1.2.1 Checking accessibility in Office 2010

Microsoft Office (Word, PowerPoint, Excel...), version 2010, offers an

automatic tool for checking whether or not a document is accessible.

To perform this review, select the “File” tab, then the “Info” option, and then
“Check for Issues”. Select the “Check Accessibility” option, as shown in Figure
1-30. All the non-accessible elements such as the alternative text of a figure will

appear, which will need to be rectified in the document.
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Figure 1-30. Location of tool “Check Accessibility”.

The tool for checking accessibility presents a task panel that shows the results

of evaluation divided into three categories, “Errors”, “Warnings” and “Tips”,

supplemented with an additional information section that guides the author with

the motive and method of correction.

The categorization of validations specifically performed for the word processor

(W) is presented below. These validations can also be presented in spread

sheet documents (E) and slideshows (P).

Errors: An error is for content that makes a file very difficult or impossible for

people with disabilities to understand:
— All objects have alternate text (E, P, W).
— Tables specify column header information (E, P, W).

— Long documents use styles to provide structure (W).
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= Warnings: A warning is for content that in most, but not all, cases makes a

file difficult for people with disabilities to understand:

Hyperlink text is meaningful (E, P, W).

— Table has simple structure (E, P, W).

— Tables do not use blank cells for formatting (E, P, W).
— Avoid the use of repeated blank characters (W).

— Headings do not contain too much information (W).

— The use of floating objects is avoided (W).

= Tips: Atip is for content that people with disabilities can understand, but that
might be better organized or presented in a way that would improve their

experience:

— Closed captions are included for inserted audio and video (E, P, W).
— Layout tables are structured for easy navigation (W).

— No image watermarks are used (W).

— All headings are in the correct order (W).

1.2.2 AccessODF

AccessODF is an extension for the word processor LibreOffice Writer which
supports the author to evaluate and repair incidences of accessibility that may
hinder or prevent people with disabilities to read documents in Open Document
Text (ODT) format. Among the validations that the extension performs are the

following:
= Validation of color contrast between text and background.
= Validation of text alternatives for images and other objects.

= Validation of, for example, language identification for the document and for

language changes inside the document.
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= Validation of the use of proper heading styles.
= Validation of the use of proper tables.

= Validation of the compatibility of images with Digital Accessible Information
System (DAISY).

1.2.3 Usability testing

The validation of usability and accessibility of the document by the final user is
the most important in order to check whether or not he/she can perform all
tasks, find the information and access the whole content and find out how long
the process is. Validation can be done through tests with people with different
disabilities, with different levels of expertise and different familiarity with the
content; and using assistive tools such as screen readers, among which we

can mention:
= JAWS (payment software).

= NVDA (free software).

1.2.4 Document conversion to other formats for validation

If the Office version does not have any functionality for checking accessibility,
the document can be saved as a portable PDF document or as an HTML page

in order to validate accessibility with other available tools.

For validating accessibility of documents exported as an HTML page the
following tools are suggested. The options will be discussed in more detail in
Chapter 5.

= Examinator (WCAG 2.0 validation).

= Achecker (WCAG 2.0, HTML and CSS validation).
= TAW (WCAG 2.0 beta validation).

= HERA (WCAG 1.0 validation).

= WAVE (Web Accessibility Evaluation Tool).


http://www.freedomscientific.com/
http://www.nvda-project.org/
http://www.examinator.es/
http://www.achecker.ca/
http://www.tawdis.net/
http://www.sidar.com/hera
http://wave.webaim.org/
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For validating accessibility of documents exported as a portable PDF the
following tools are proposed. Furthermore, other options will be studied in
Chapter 3.

= Online validation tools: Check a PDF (Tingtun Checkers, n.d.).

= Validation tool: PDF Accessibility Checker (PAC).
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Chapter 2. Creating accessible presentations

with PowerPoint

Translators: Authors:

Eva Garcia Lépez Carmen Pagés Arévalo
Antonio Garcia Cabot Luis Fernandez Sanz
University of Alcala, Spain University of Alcala, Spain

PowerPoint is the Microsoft Office tool for creating presentations. Its use has
become so widespread that in many cases presentations are created to directly

convey the information, without the speaker being present.

A PowerPoint presentation is composed of multiple slides that are passed
sequentially and that may contain text, shapes, figures, graphs and multimedia
files. Therefore, when creating accessible presentations we should take into
account the accessibility of the presentation itself (format in which it is
distributed, transitions between slides, narration, slides design, etc.) as well as
the accessibility of the elements of the slides (text, figures, audio, video,

animations of the elements, etc.).

This chapter explains the guidelines to be followed for creating accessible
presentations and tools that help creating accessible presentations, and

verifying that they are.
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2.1 Creating accessible PowerPoint presentations

2.1.1 Tips for creating an effective presentation

Before explaining the points to be taken into account for creating an accessible
presentation, some tips will be presented for creating effective presentations,
because an accessible presentation should be equally or more effective than
any other presentation. Here are some points to be taken into account when

creating an effective presentation, which can be considered as good practices:

2.1.1.1 Reduce the number of slides and structure them

In order to convey a clear message and to keep the attention and the interest of
the public, reduce the number of slides of the presentation to a minimum. The
slides should have a hierarchical structure that facilitates the comprehension of
the overall presentation, by using titles, subtitles, lists, etc. It is more convenient
to use slide preexisting designs instead of starting from a blank slide and then
adding elements. For example, using a slide with a title element provides
information about the structure of the presentation. This does not happen when
using a blank slide and including a text which is then bold formatted and is set
to a large size, simulating a title. It is also convenient to include a slide's index
at the beginning of the presentation, which explains the structure of the
presentation and, if it is long or has a complex structure, remember on each
slide to the public which part of the structure of the presentation is he/she
explaining, so that the receiver does not feel lost. Including the number of the
slide will help the receiver and also to the own speaker, to be oriented during

the presentation.

21.1.2 Select a size and type of font suitable for the public

Select the most suitable font size helps to convey the message. The public
should be able to read the slides from a certain distance, so a font size below
24 points may be too difficult to read. It is also recommendable to use a clear

font type and a sufficient line spacing to facilitate reading.
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21.1.3 Simplify the slide text

Use vignettes or short sentences, trying to include each of them in one line,
because some projectors cut the edges of the screen. Complete the sentences
with dots or semicolons and use bulleted or numbered lists. If acronyms are
used, it is recommended to explain the full meaning of the acronym in its first

appearance.

21.1.4 Use visual controls to help expressing the message

Add meaningful figures to complement the text, because figures and graphs
help the public to remember, always limiting the number of figures to not
overload the presentation. Avoid the use of text as figures, which may lose
clearness. Do not use color as the only expressive medium, for example, using
the colors of a traffic light to indicate something allowed, dangerous or
prohibited, because some users will not be able to distinguish it. If it is used,

then add a meaningful text to the color.

2.1.1.5 Create tags for graphs and diagrams so that they are

understandable

Use simple and concrete tags for graphs and diagrams in order to make them
understandable. Do not include too much information, as it would force to use a

small font size or little separation between lines, which may difficult the reading.

2.1.1.6 Apply subtle and consistent backgrounds to the slides

The theme used for the presentation should not be too colorful to not distract
the attention of the listeners. It is also important that there is enough contrast
between the foreground and the background, in order to achieve an easy

reading. It is best to use black text on white background.

2.1.1.7 Use templates and patterns

Using templates and patterns simplifies creating presentations because the
structure, design and theme used in the presentation are already defined.

Templates can be customized and created for different types of presentations.
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If a template is accessible, using it in future presentations will avoid many
accessibility problems. Patterns can be created for all those elements that are
considered to be included in every slide. Do not include indispensable

information in a pattern, as it is not verbalized by screen readers.

2.1.1.8 Check spelling and grammar

Before showing a presentation to a public it is very important to check its
spelling and grammar, because one error of this type would give a bad
impression to the audience. Therefore, it is necessary to define the language of
the document as the language used during the presentation. If some sentences
or paragraphs are used in other languages, the correct language for each of
them should be defined (it is also useful for correct intonation of screen
readers). Short sentences and grammatically simple should be used, so that all

people that are listening can understand the message.

2.1.2 Good practices for designing and creating accessible

presentations

Below are the points to be followed in order to create accessible presentations

for users with disabilities.

2.1.21 Adding alternative text to figures and objects

Alternative text (Alt text) appears when you hover the mouse over a figure or
object, and helps people who use screen readers to understand their meaning.

It should be included for the following objects:
= Figures.

= Clip arts.

= Graphs (not available in version 2007).

= Tables (not available in version 2007).

= Pivot tables (not available in version 2007).

= Shapes not containing text.
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= SmartArt graphs.
= Embedded objects.

= Groups (all objects in a list, except shapes, should also have alternative text

when they are in groups).
= Pen inputs.
= Audio and video files.

To add alternative text, press with the right mouse button over the figure or
object and select “Format picture...”. In the left column, select option “Alt text”
and add a title and a description (Figure 2-1). For adding alternative text to an
entire graph or a SmartArt graphic, press over the edge of the graph or

SmartArt graphic and not over a specific shape or part.

[ Format Picture @I_J"
o Alt Text
Line Color Titie:
Line Style
Shadow Description:
Reflection

Glow and Soft Edges

3-D Format
3-D Rotation
Picture Corrections Titles and descriptions provide alternative, text-based i
representations of the information contained in tables, diagrams,
Ficture Calor images, and other objects. This information is useful for people
. with vision or cognitive impairments whao may not be able to see or
Artistic Effects understand the object.
Crop A title can be read to a person with a disability and is used to
: determine whether they wish to hear the description of the
Size content.
Position
Text Box

Alt Text

Close

Figure 2-1. How to set alternative text for an object.

In the “Description” field, type an explanation about the shape, figure, graph,
table, SmartArt graph or other object. This field should always be filled.
Optionally, in the “Title” field, type a brief summary. This field should only be
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filled if a long and detailed explanation is written in the “Description” field. Only
the description is usually typed, unless the graph or the table are complex. If
so, it would be also useful to fill the title, so it is not necessary to read the whole

description unless the user wants to read it.

People with disabilities can listen the title and determine whether or not they
want to listen the description. If an element is purely decorative and it is not
necessary to add information about it, a blank space should be included

instead of a description.

For best results, add alternative text in field “Description”, not in field “Title”.
The information contained in the field “Title” will not be saved as alternative text

when the file is saved as HTML.

Alt Text command can be added to the toolbar shortcut to create a shortcut.
This is usually useful when adding alternative text to shapes, figures, tables,
SmartArt graphs or other objects. To do this, select “Customize quick access
toolbar” in the upper left corner over the ribbon tabs. After selecting “More
commands...”, select “Commands not in the ribbon” (below “Choose commands

from:”), then select “Alt text...” and press button “Add >>“.

For using command Alt Text in the toolbar shortcut, firstly select the shape,
figure, graph, table, SmartArt graph or other object before pressing the button

in the toolbar, and then add the alternative text.

2.1.2.2 Enter information in the table column header

Having clear information about the column headers may put into context the
listener and help navigating the table. This guideline means that data tables
(except pivot tables) should have one or more header rows. For creating
accessible row headers it is necessary to select the table, click over “Design”

and then “Header row”.

21.2.3 Check that each slide has a title and it is unique

Titles of the slides are used for that people with visual disabilities are able to

navigate and select the correct slide, so it is essential that each of them has a
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title and that it is unique, i.e., that uniquely identifies each slide. It is convenient
that the titles of slides are meaningful and a useful way to convey the structure

of the presentation to the reader.

For showing the titles of all slides, select tab “Outline”. This will show all the
slides and their elements (Figure 2-2). Each slide is represented with a
rectangle and its title, and below it, the elements of the slide appear in a
bulleted list.

Slides Outline x

»

L
i Analysis of standards and
specifications of quality and
accessibility in e-learning
2 Activity A311

3| Loja, Ecuador
4 Fva Garcia (UAH), Antonio

e e s
e e g

» Comparative analysis
» Conclusions

bbb e R b

2 » IS0 (International
Organization for
Standardization):
Standardization
organizations network of
140 countries, which work

Figure 2-2.  Outline view, showing some slides and their elements.

Titles may be assigned to slides in order to make the presentation more
accessible, even when we do not want that they are visible. This may be useful
in presentations completely visual, without text. There are two ways to include
titles:

= Visible titles. In “Home” tab, press “Reset” to reset the placeholders on the
selected slide. Placeholders are boxes with dotted borders that are part of

all slide layouts. These boxes contain text of a title and main text; or objects
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such as SmartArt graphs, graphs, tables and figures. Once the placeholders

have been reset, write a unique name in the title field.

= Not visible titles. Select “Home”, then “Arrange” and then “Selection
Pane...”. Finally, press over the eye icon that is located next to the title text

field of the slide to change visibility.

21.2.4 Use meaningful text for hyperlinks

The text of the hyperlinks should provide a clear description about the target of
the link and should be presented in a legible format. The text of the hyperlink
should not provide only the URL or only the name of the target file. Therefore,

the following are not correct:

= The text of the hyperlink is the same as the target. For example, the text of
the link is http://office.com/en-us/help/HA103691921033.xml.

“n

= The text of the hyperlink has five or less characters, starts with “.” and does
not show information on the screen. For example, using a file extension

(e.g., .pdf) as the text of the hyperlink.

For making a hyperlink more accessible, firstly select the link, then select tab
“Insert” and then “Hyperlink”. In field “Text to display”, type a sentence that
describes briefly the target of the link. It is also possible to add additional
information to a hyperlink. To show some text in a floating box when the mouse
is over the hyperlink, press button “ScreenTip” and type the message. This
message, for example, may give some indication about the type of information

that will be accessed, and the degree of accessibility.

21.2.5 Use simple table structures

Navigation will be much simpler when not using nested tables, or combining
and dividing cells. A table should have a simple two-dimensional structure so
that people with disabilities are able to navigate through it and understand it

easily.
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To test and simplify a table structure, select the first cell and then press the tab
key more than once just to make sure that the focus is firstly moved by the row
and then down to the next row. The focus should always move from one cell to
the next column, if it is not the last one in the row; and if it is the last one, the
focus should move to the first cell of the next row. If combining or dividing cells
is necessary to simplify the table, click on “Layout” (in “Table tools”) and then

“Merge cells” or “Split cells”, as appropriate.

Figure 2-3 shows two tables. In the first one, the tabulator moves from the cell
containing number 7 to the cell containing number 11, which is not the next
column (it is column B and it should move to column C). In the second one, the
tabulator moves from the cell containing number 10 to that containing number
11, which is not the next row (it is the second one and should move to the
third). In both tables, the cell containing number 11 should not exist, and it

should be combined with the cell containing number 7 to get just one cell.

S S - - N
1 2 3 4 5

B 7 11 8 9 10

1 4 5

6 8 9 10
11

12 13 14 15 16

Figure 2-3. Examples of incorrect tables’ structures.

2.1.2.6 Avoid using blank cells for formatting

Using blank cells (blank single cells or blank rows and columns) may confuse
the user when using screen readers, because they may think that there is no
more content to read in the table. To avoid this, the blank row or column should
be removed, by locating the tabulator in a cell of the row or column, then
clicking with the right mouse button and select “Delete rows” or “Delete
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columns”. When single blank cells are used, if they cannot be removed, it is
better to type on them the word “empty” or any other value representing the

absence of content.

Avoid using tables when for only formatting content. For example, if a text in
two columns is desired, do not use a table with three columns and one row,
and type the text in the first and the third columns. In such a case, a two
content design should be selected for the slide and then type the text in each of

the placeholders.

2.1.2.7 Include captions for audio and video

The multimedia audio, voice and video may convey important information that
probably is not available for people with disabilities. When inserting multimedia
content in a presentation, it is necessary to check that the content is available
in alternative formats such as captions in videos, alternative text or transcripts

of a narrative in the notes, which users with disabilities can use.

Recording a narration for the presentation allows people with visual disabilities
to hear the presentation content. Typing the narration as notes in the slides

may benefit people with hearing impairments or whose computers do not have
sound card. When saving the presentation as a webpage file (.htm), the notes
will appear below each slide. If the presentation is saved as a presentation file

(.pptx), the notes can be printed.

If the presentation will be subtitled during its oral presentation, the bottom of the

slide should not be used, since normally the captions occupy that space.

There is an add-in for inserting captions in Microsoft PowerPoint, called
Subtitling Text Add-in for Microsoft PowerPoint (STAMP) (Office, n.d.-d). It
allows creating closed captions for the video and audio of the presentations

(only available in version 2010). This add-in allows to:

= Import captions from a Timed Text Markup Language (TTML) file, for
creating captions from a video or audio file in the presentation.

= Create and edit captions in PowerPoint 2010.
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= Remove the captions.

= Export captions to a TTML file.

= Enable and disable the captions in the presentation mode.

= Align captions.

= Importing text with information about the format of the TTML file, for

example, style, color and alignment.

To install STAMP in a computer, the correct version (32 or 64 bits) should be
downloaded from the repository. The downloaded file is a .zip file that has to be
saved in the computer and subsequently decompressed. A .msi file will be
extracted, and then it should be executed and follow the installation steps. To

check whether it has successfully been installed, open PowerPoint and select

“File” and then “Options”. In the dialog box, select “Add-Ins”. If STAMP is

installed, “Subtitling Add-In for Microsoft PowerPoint” should appear in “Active

Application Add-Ins”, as shown in Figure 2-4.
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Figure 2-4.

STAMP add-in installed.
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When a presentation has an audio or video file included and the add-in STAMP
is installed, the options of group “Add captions” (in tab “Playback”) will be
available. Figure 2-5 shows the option for creating captions for a video in a

PowerPoint presentation.

n ——
Pld9-0|= ft PowerPaint
m Home Insert esign if Animations Slide Show Review View Format Playback
o n i [ Start: On Click M '5}'
O g‘j : | W [[] Loop until stopped
E 4¢] Fade In: 00,00 - B [ Play Full Screen
Play Add Trim . . Volume Add
Bookmark Video Fade Out: 00,00 = - [0 Hide While Not Playing [C1 Rewind after Piaying EphonT ) options
Preview Bookmarks Editing Video Options gk Create Captions ptions
Slides Outline X [z W B o 41 |EQ  Captions From File e G B
1 . Create Captions
% Create new captions for this media
5 element.
@
< m Subtitling Add-In for Microsoft
B = PowerPoint
- ‘ Press F1 for add-in help.
e
o }
: : o
B 0
B - <l > L]

Figure 2-5. How to create captions for a video in a PowerPoint presentation.
The options of group “Add captions” allow to:

= Create captions (option “Create Captions”). The steps for creating captions
are shown in Figure 2-6, which represents dialog box “Caption Editor”.

These steps are explained below.

Press button “Play” (1) to start playing the audio or video. Press button “Add
a new caption” (2) to add a new row of captions. The title will be created to
start at the moment the video or audio is playing (i.e. at “Start Time”). You
can also locate the moment of the video you want, stop it and press over (3)
to fix that time as start time or end time of the caption shown in the row. If
the end time is not entered, the end time will be the start time of the
following row. Press over text field “Caption text” (4) and type the text that

will appear as a caption.

By repeating the previous steps, new rows for captions can be created.
When finished, press button “Update” (5). It is not mandatory to create

captions in order. To add a new caption between two existing rows, create
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the new row at the end and press over “Sort the captions” to put them in

order of time sequence.

STAMP Sample Lueme O000:26.7) - Caption Editor U
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Figure 2-6. How to edit captions for a video in a PowerPoint presentation.

Insert captions by importing them from a TTML file (option “Captions from
File”).

Edit captions (option “Edit Captions”). It allows modifying the captions' text,
the time they start and end, their size, color and font type, their

transparency, adding and removing captions rows, etc.
Hide or show captions (options “Hide” and “Show”).

Remove existing captions (option “Remove”).
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= Align the captions when a video has been moved or has changed its size
(option “Align Captions”). They may be located at the bottom of the video or

at the bottom of the slide.

= Set default values for formatting the captions (option “Options”). These

values are:

- The transparency of the captions can be modified by changing the
percentage. By default, transparency is set to 50% but it may be

changed for ensuring that the captions can be clearly read.

- The fade duration can be modified by changing the fade duration. By

default, it is set to 0.2 seconds.

- Timing accuracy for start time and end time of captions. They are always
defined as hours, minutes and seconds, but it is possible to add tenths,

hundredths or thousandths of a second.

- Selection of automatic action about inserting a video or audio file (when
adding new media). It determines what PowerPoint will do when a file of

this type is inserted. The options are: “Do nothing”, “Create captions”
(selected by default, it automatically opens the captions editor) and
“Import captions” (it automatically opens the dialog box to import a TTML

file with captions).

- The font type, size, style, etc. of the captions can be modified by using

the font options that are displayed in the window.

2.1.2.8 Check the reading order

Someone who cannot see a slide, listens its content, its shapes or the text of
the slide in a certain order. It is important to check the reading order that screen
readers will use in each slide, in order to follow a logical order and making
sense. To do this, in tab “Home”, group “Drawing”, select “Arrange” and then
“Selection pane...”. The reading order of the elements of each slide will be

showed, in reverse order to be read (they will be read from bottom to top).
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If content is only placed in the placeholders of the slide, it is ensured that the
reading order will be correct. Therefore it is important to use one of the slides
designs when adding a new slide, and do not include any new element to the
original design. When new elements are necessary to be included, then the

reading order should be verified and corrected by means of the selection pane.

The selection pane shows all the objects of the slide. These objects are read
starting with the element of the list that is located at the bottom and finishing
with the element of the list that is at the top. Correct all elements that do not
follow the order by using the “Re-order” arrows located at the bottom of the
pane. Figure 2-7 shows that when an element is highlighted in the selection
pane it is also selected in the slide. In the example showed, the latter element
of the list will be the first read, it is highlighted in the selection pane and

selected in the slide (the number of slide).
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Figure 2-7.  Selection pane showing the reading order.

51



CHAPTER 2: CREATING ACCESSIBLE PRESENTATIONS WITH POWERPOINT

52

2.1.2.9 Increase visibility for people with color perception

disabilities

When creating a presentation, it is important to choose elements that increase

the visual contrast for people who do not distinguish colors. Some good rules to

follow are:

Avoid using orange, red and green colors, both in the template and in the

text.

Use animations or circles marks to highlight information instead of using

laser pointers or colors.

Use a high overall contrast in the presentation. According to the WCAG
(World Wide Web Consortium, 2008), a minimum contrast of 4.5:1 is
needed, not only for images, but for text; except large-scale text, which
allows a contrast ratio of at least 3:1. The contrast ratio is calculated by the
formula (L1 + 0.05) / (L2 + 0.05), where L1 is the relative luminance of the
lighter of the text or background colors, and L2 is the relative luminance of
the darker of the text or background colors (0 luminance is for the darkest
black and 1 for the lightest white). Luminance is calculated with RGB color
values, which can be obtained in PowerPoint by opening the font color
menu and selecting option “More colors...”. A dialog box will be open
(Figure 2-8), which provides the three RGB color values. For detailed
calculation of the luminance with those three values please visit the WCAG
2.0 website, and for a better knowledge of colors luminance visit the RGB

color model page (Wikipedia).

Do not use background with gradient color or patterns, especially if some

information (text, figures, graphs, etc.) will be inserted over.

Use textures instead of colors in graphs to highlight remarkable points. Do
not use different colors to mark information in graphs. For example, on a
linear graph, two different type lines may be used (e.g., continuous and

dashed) in addition to a different color for showing two series of different


http://www.w3.org/TR/WCAG20/
http://www.w3.org/TR/WCAG20/
https://en.wikipedia.org/wiki/RGB_color_model
https://en.wikipedia.org/wiki/RGB_color_model
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values. In pie graphs and bar graphs, a grayscale or filling with different

patterns may be used.

Colors

Colors:

Color model: |RGB |E|
Red: 255 =
Green: 255 k=
Blue: 255 =

Current

Figure 2-8. Showing the three values of a RBG color.

2.1.2.10 Avoid animations and automatic transitions

Animations should be not used because they may disorient some users.
Automatic transitions between slides should also be avoided because when
using them, the user may not have enough time for seeing, listening or reading
the whole content of the slide. It is better to allow the user to decide when
he/she wants to go to the next slide, so that way we are sure that he/she will

always be able to see, listen or read it completely.

Action buttons allow changing from one slide to another. They can be used
when their aim is clear (if the icon is not explicit enough, a text can be added
over the button), an alternative text is used to describe them and they are big

enough that people with disabilities are able to press over them.

The use of animated images or flickering elements can produce photosensitive
epilepsy attacks to some users. The Accessibility Observatory from the

Spanish Government (2011) recommends the following:
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= Do not use more than three general flashes (six transitions from light to

dark, or from dark to light) per second.

= Flickering may take up to five seconds. Otherwise, mechanisms to pause,

stop or hide it should be provided.

2.1.2.11 Do not include relevant information in the pattern of the

slide or in the footer

The pattern of the slide is not read by screen readers so any element
conveying information should not be included in it. The pattern is the perfect
place to include the companies' logos. Similarly, information in the footer is not

read by screen readers so it should not contain relevant information.

2.1.2.12 Convert to other formats

In many cases it would be useful to convert a PowerPoint presentation to other
types of files, such as HTML, PDF or video (WMV). The accessibility of the new
document remains unchanged from the original one. To be sure about it, the

following should be checked:

= PDF documents. When selecting PDF as document type in option “Save as”
from tab “Home”, button “Options...” is showed. When this button is
pressed, a new dialog box will appear (Figure 2-9), and we should be sure

that option “Document structure tags for accessibility” is selected.

= Videos. To record a video of a presentation, select “File”, then “Save &
send” and finally “Create a video”. For getting an accessible video it is
convenient to have previously recorded timings between slides (with a
sufficiently long time) and narrations of slides. When creating the video,

option “Use recorded timings and narrations” should be selected.

= Word. To create or add all or some slides of the presentation to a Word

document, select “File”, “Save & send” and finally “Create handouts”. In the
Word document, the slides will appear as images, so screen readers will not
be able to read their information. This problem can be solved by typing the

content of the slide or explaining it in the notes area of each slide. When the
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notes of a slide are converted to Word, they are showed below the

corresponding image.

-

Options

2 |

) Current slide Selection

Custom show:

Slide(s) From: |1 To: |4

Publish options
Publish what:
Slides E
[] Frame slides
[7] 1ndude hidden slides
[7] tndude comments and ink markup

Slides per page:

Order:

Incude non-printing information
Document properties
Document structure tags for accessibility
PDF oplions
[T 150 19005-1 compliant (POF/A)
Bitmap text when fonts may not be embedded

&

(@ Horizontal

[l [s] ]
[z][e] ]

Vertical

[

OK ]’ Cancel ]

Figure 2-9. Options for saving a document as a PDF.

2.1.3 Tips for presenting in an accessible way

PowerPoint is often used by a speaker as a support for a presentation to a

group of people. Some tips and techniques should be used to guarantee that

the speaker is able to address to any member of the audience in the most

effective way:

Look straight ahead at all times when talking. If you are writing on a

blackboard, you have to turn around every time you talk. Always speak in

front of the audience. This is important because deaf people may be in the

public and they need to see how the speaker's lips are moving in order to

understand him/her.

text and images or graphs. In a big

All content in a slide should be read and explained to the audience, both

room, the information of a slide may not
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be read from the back of the class or a person with visual disabilities may

not do it.
Use a microphone or an audio system, if possible.

If an animation has been included into a presentation, be sure that it has
finished moving before you start talking. If an animation is moving,
participants will lose concentration on the speaker to dedicate it to the

animation.

The readability of text on the screen will be affected by the light levels in the
room. As a general rule, if the presentation takes place in a room well lit, the
text will be more legible when it is dark and the background is light. On the
contrary, in a dark room, the presentation will be easier to read with a dark
background and a light text. Take into account that a text may look thinner
when the background is dark. In that case, the readability can be increased

by setting the text to bold.

Leave enough time for moving from one slide to another and make small

pauses when moving from one topic to another.

Do not create a very long presentation: some people need to take a break
every so often. If a presentation is planned to take up all morning or all

afternoon, divide the presentation into at least two or three parts.

Plan with the event organizers whether the screen will include captions or
the image of a sign language interpreter. In those cases, design the

presentation by considering the available space.

2.2 Checking the accessibility of a PowerPoint

presentation

2.2.1 Executing the accessibility checker

For checking whether all guidelines have been taken into account, Microsoft
PowerPoint has the Accessibility Checker, which will check the whole

presentation and will mark all possible problems for people with disabilities. To
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run it, go to tab “File” and select “Info”. Click on “Check for issues” and then

select “Check accessibility” (Figure 2-10) (Office, n.d.-a).

IE“ s | |= Presentationl - Microso
m Home Insert Design Transitions Animations Slide Show Review View

H Save
Save As

Information about Presentationl

o —r
[& Open . Permissions
£ Close ’I'?i ?J Anyone can cpen, copy, and change any part of this presentation,
Protect
Presentation =
Recent

- Prepare for Sharing
Mew | ﬂ Before sharing this file, be aware that it contains:

Document properties and author's name

; Check f
Print I e Content that pecple with disabilities are unable to read
ssues ~
Save & Send == Inspect Document

Erl Check the presentation for hidden properties
or personal information.

Help
& Check Accessibility thic file.
=] Options _@ Check the presentation for content that people
with disabilities might find difficult to read.
3 et [3] 5 Check Compatibility
.ﬁ Check for features not supported by earlier

versions of PowerPoint.

Figure 2-10. How to run the Accessibility Checker.

The accessibility checker will examine the whole presentation, will show the file
and will open a dialog box indicating all problems found as a result of the

inspection (Figure 2-11).
2.2.2 Additional information about the problems found

Microsoft provides more information about the problems found by the
accessibility checker. When the dialog box is open, if you click over one of the
problems found, the slide containing the problem will be showed, and more
information is showed in field “Additional Information” at the bottom of the box.

It shows the following:

= Reason for correction that explains why the problem found is a problem for

accessibility.
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= Correction procedure, including the steps that can be followed for modifying

the content and make it accessible.
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Figure 2-11. Results of an examination by the Accessibility Checker.
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The Accessibility Checker flags three different issues, from most to least

important: errors, warnings, and tips.

disabilities to understand.

Error: content that makes a file very difficult or impossible for people with

Rule name

Accessibility Checker checks that

All objects have alternate text

Tables specify column header

information

All slides have titles

All objects use alternate text.

Alternate text doesn’t contain an image or file

extension.

The header box is selected for each table in a
deck.

Each slide in a deck has a title.

Table 2-1.

Accessibility Checker, errors detection.

Warning: content that in most, but not all, cases makes a file difficult for

people with disabilities to understand.

Rule name

Accessibility Checker checks that

Hyperlink text is meaningful

Table has simple structure

Tables don’t use blank cells

for formatting

Link text has a Screen Tip and matches the link

target.

There are no issues that cause tables to be non-
rectangular, such a split cells, merged cells or

nested tables.

There are no entirely blank rows or columns in a
table.

Table 2-2.

Tip: content that people with disabilities can understand, but that might be

Accessibility Checker, warnings detection.

better organized or presented in a way that can improve their experience.
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Rule name Accessibility Checker checks that

Closed captions are included for  All audio and video objects in the document have closed

inserted audio and video captioning.

The reading order of a slide Slides appear to be in a logical order.

should be logical

The slide titles in a deck should Each non-blank slide in a deck has a unique title.

be unique

Table 2-3.  Accessibility Checker, tips.

In all cases, the accessibility checker explains how to solve the problem found
(“How to fix”, within “Additional information” field). There are only two cases in

which a problem is found but it does not exist or it has already been corrected:

= The case of subtitling an audio or video (type tip). The checker simply
marks all audio and video objects for the user to verify that it meets
accessibility, i.e., it has an alternative text, captions, descriptions,

transcripts, etc.

= The case of reading order of elements in a slide (type tip). The user should
be sure that, when used objects that are not part of the template of the
slide, the reading order of the content of the slide makes sense. The check
is very basic because the checker simply marks all slides containing objects
of that type, without discerning whether the reading order is correct or not,

since it only alerts the user to check it.

2.2.3 Checklist

This section summarizes the key concepts of the chapter. It tries to check the

degree of accessibility of a PowerPoint presentation by means if a checklist.

1. Structure the presentation: templates, slide's index, page numbers, using

existing slides design.
2. Do notinclude indispensable information in a pattern or in the footer.

3. All slides have a title and it is unique (it may be invisible).
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4. Check the reading order of the elements in a slide, especially those

included in the existing slides designs.

5. Text size is at least 24 points and the font is legible, sufficient spacing, and

high contrast between background and text.

6. Apply the correct language to the document and its exceptions (paragraphs,

sentences).

7. Short sentences that do not occupy the whole screen and that are
grammatically simple, ending in a point or a semicolon, or organized in

numbered or bulleted lists.
8. Graphs and diagrams have simple tags.
9. Text in hyperlinks is meaningful.

10.Figures and objects have alternative text: field “Description” is mandatory,
field “Title” is optional. If a figure or an object is not meaningful, insert a

blank space in “Description”.

11.Tables do not have blank cells, blank columns or blank rows. If they are

necessary then type “Empty” within.

12.Tables have a simple structure, not nested or with combined or divided

cells.

13.Tables have meaningful headers and repeat the header row when moving

to the next page.
14.Audio and video files have captions.

15.The recorded narration of the presentation is transcribed as notes or

captions of the presentation.

16.Do not use colors as the only mean to convey information (very important in

graphs).

17.Do not use color gradients or frames when any information is going to be

inserted over them.
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18. Avoid using orange, red and green colors.

19. Avoid using animations, blinking elements, animated images and automatic

transitions.

20.The action buttons are big and expressive enough (both figures and text).

21.Make sure to preserve accessibility when changing between formats.

2.3 Keyboard shortcuts

2.3.1 Navigating the ribbon

To do this:

Press’:

Select the active tab of the ribbon and
activate the access keys.

Move left or right to another tab of the
ribbon, respectively.

Hide or show the ribbon.

Display the shortcut menu for the selected
command.

Move the focus to select each of the
following areas of the window:

- Active tab of the ribbon.

- Any open task panes.

- Your document.

- Show the status bar at the bottom of the
window.

“Alt” or “F10”. Press either of these
keys again to move back to the
document and cancel the access keys.

“Alt” or “F10” to select the active tab,
and then “€“ or “>*.

“Ctrl + F1".

“Shift + F10”.

“F6”.

' The key may change when using versions of Microsoft Office previous to 2013.
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To do this: Press’:

Move the focus to each command on the “Alt” or “F10” and then “Tab” or “Shift +

ribbon, forward or backward respectively.  Tab”

Move down, up, left, or right among the AN, NV € 0D,

items on the ribbon, respectively.

Activate the selected command or control ~ “Space bar” or “Enter”.

on the ribbon.

Open the selected menu or gallery on the  “Space bar” or “Enter”.

ribbon.

Activate a command or control on the “Enter”.

ribbon so you can modify a value.

Finish modifying a value in a control on “Enter”.
the ribbon, and move the focus back to

the document.

Get help on the selected command or “F1”
control on the ribbon. (If no help topic is
associated with the selected command, a
general help topic about the program is

shown instead.)

Table 2-4.  Keyboard shortcuts for navigating the ribbon.

2.3.2 Common tasks while running a presentation

To do this Press’

Start a presentation from the beginning. “F5”

Perform the next animation or advance to  “N”, “Enter”, “Page down”, “=”, “W” or

the next slide. “Space bar”

Perform the previous animation or return “P”, “Page up”, “f\",”€”, or “Back
to the previous slide. space”.

Go to slide number. “Number + Enter”.
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To do this Press’
Display a blank black slide, or return to “B” or “.".
the presentation from a blank black slide.

Display a blank white slide, or return to “W” or “,”.
the presentation from a blank white slide.

Stop or restart an automatic presentation.  “S”.

End a presentation. “Esc” or “-”.
Erase on-screen annotations. ‘BE”.

Go to the next slide, if the next slide is “H”.
hidden.

Set new timings while rehearsing. “T".

Use original timings while rehearsing. “‘O”.

Use mouse-click to advance while “M”.
rehearsing.

Re-record slide narration and timing. “‘R”.

Return to the first slide.

Change the pointer to a pen.
Change the pointer to an arrow.
Change the pointer to an eraser.
Show or hide ink markup.

Hide the pointer and navigation button

immediately.
View the All Slides dialog box.
View the computer task bar.

Display the shortcut menu.

Press and hold right and left mouse

buttons for 2 seconds
“Ctrl + P”.
“Ctrl + A”.
“Ctrl + E”.
“Ctrl + M”.

“Ctrl + H".

“Ctrl + S”.
“Ctrl + T,

“Shift + F10”.
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To do this Press’

Go to the first or next hyperlink on a slide.  “Tab”.

Go to the last or previous hyperlink on a “Shift + Tab”.

slide.

Perform the “mouse click” behavior of the  “Enter” while a hyperlink is selected.

selected hyperlink.

Table 2-5. Keyboard shortcuts for common task while running a

presentation.

2.3.3 Media during presentation

To do this Press’

Stop media playback. “‘Alt + Q”.

Toggle between play and pause. “Alt + P”.

Go to the next bookmark. “‘Alt + End”.

Go to the previous bookmark. “Alt + Home”.

Increase the sound volume. “Alt + AN,

Decrease the sound volume. “Alt + ",

Seek forward. “Alt + Shift + Page down”.
Seek backward. “Alt + Shift + Page up”.
Mute the sound. “‘Alt + U”.

Table 2-6.  Keyboard shortcuts for media during presentation.

65



CHAPTER 2: CREATING ACCESSIBLE PRESENTATIONS WITH POWERPOINT

66

2.3.4 Working with shapes, text boxes, and WordArt

To do this

Press’

Select an object (with text selected

inside the object).

Select an object (with an object

selected).

Select text within an object (with an

object selected).
Select all objects.

Select an object that is under other
objects and cycle forward through the

stack of objects.

Select an object that is under other
objects and cycle backward through the

stack of objects.

Open the Selection pane.
Cut selected object.

Copy selected object.
Paste cut or copied object.
Copy formatting only.
Paste formatting only.
Paste special.

Group shapes, pictures, or WordArt.

Ungroup shapes, pictures, or WordArt.

Show or hide the grid.

“Esc’.

“Tab” or “Shift + Tab” until the object you

want is selected.

“Enter”.

“Ctrl + A” (on the “Slides” tab).

“Tab” after you select the top object.

“Shift + Tab” after you select the top

object.

“Alt", “H", “SL”, and then “P".
“Ctrl + X".

“Ctrl + C,

“Ctrl + V.

“Ctrl + Shift + C”.

“Ctrl + Shift + V.

“Ctrl + Alt + V",

“Ctrl + G” after you select the items that

you want to group.

“Ctrl + Shift + G” after you select the

group that you want to ungroup.

“Shift + F9”.
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To do this Press’

Show or hide guides. “Alt + F9”.
Undo the last action. “Ctrl + Z7.
Redo the last action. “Ctrl + Y.

Table 2-7.  Keyboard shortcuts for working with shapes, text boxes, and

WordArt.

2.3.5 Working with SmartArt graphics

To do this Press’
Select the next element in a SmartArt “Tab”.
graphic.

Select the previous element in a “Shift + Tab”.
SmartArt graphic.

Select all shapes. “Ctrl + A”,
Remove focus from the selected shape.  “Esc”.
Nudge the selected shape up. “AN.

Nudge the selected shape down. “\,

Nudge the selected shape left. e’

Nudge the selected shape right. ‘7,

Edit text in the selected shape. “Enter” or “F2”.

Delete the selected shape.

Cut the selected shape.

Copy the selected shape.

Paste the contents of the Clipboard.

Undo the last action.

Enlarge the selected shape horizontally.

“Delete” or “Backspace”.
“Ctrl + X” or “Shift + Delete”.
“Ctrl + C”.

“Ctrl + V.

“Ctrl + Z”.

“Shift + =",
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To do this Press’
Reduce the selected shape horizontally.  “Shift + €.
Enlarge the selected shape vertically. “Shift + AN,
Reduce the selected shape vertically. “Shift + ¥,
Rotate the selected shape to the right. “‘Alt + =",
Rotate the selected shape to the left. “‘Alt + €7,
Move one character to the left. ‘e’

Move one character to the right. ‘P,

Move up one line. “AN

Move down one line. “N,

Move one word to the left. “Ctrl + €”.
Move one word to the right. “Ctrl + =",
Move one paragraph up. “Ctrl + AN,
Move one paragraph down. “Ctrl + V.
Move to the end of a line. “End”.

Move to the beginning of a line. ‘Home”.
Move to the end of a text box. “Ctrl + End”.
Move to the beginning of a text box. “Ctrl + Home”.
Cut selected text. “Ctrl + X".
Copy selected text. “Ctrl + C”.
Paste selected text. “Ctrl + V”.
Undo the last action. “Ctrl + Z”.
Delete one character to the left. “Backspace”.

Delete one word to the left.

“Ctrl + Backspace”.
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To do this Press’

Delete one character to the right. “Delete”.

Delete one word to the right. “Ctrl + Delete”.
Promote the selected text. “Alt + Shift + €.
Demote the selected text. “Alt + Shift + =",
Check the spelling. “F7”.

Table 2-8.  Keyboard shortcuts for working with SmartArt graphics.

2.3.6 Working with the caption editor of add-in STAMP

To do this Press’

Move back 2 seconds of playback. “F2”.

Set start time of the current caption. “F3”.

Set end time of the current caption. “F4”.

Set focus to caption text for editing. “‘F5”.

Insert new caption at the bottom of grid, “F6” o “Insert”.

and set start time.

Delete current caption. “Delete”.

Start or pause the playback. “Ctrl + P”.

Slows the playback speed. “Ctrl + Shift + S”.
Resumes normal playback speed. “Ctrl + Shift + N”.
Increases the playback speed. “Ctrl + Shift +G”.

Table 2-9.  Keyboard shortcuts for working with the caption editor of add-in
STAMP.
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Chapter 3. Creating accessible PDF documents

Translators: Authors:

Eva Garcia Lépez Maria Patricia Valencia Chaverra
Antonio Garcia Cabot Universidad Catolica del Norte, Colombia
University of Alcala, Spain Janneth Chicaiza Espinosa

Universidad Técnica Particular de Loja,

Ecuador

This chapter is aimed to readers who have prior knowledge on computer
science and technology. Knowledge acquired will contribute to the professional
education of the learner through the use of technological tools that will provide

accessibility in online contents.

More specifically, it will be learn how to create accessible PDF files from
documents or presentations, and to evaluate and improve accessibility of the
generated documents. An accessible PDF ensures accessibility from different
devices and offers support to people with disabilities, especially with visual

disabilities.

Finally, the chapter explains how to create an accessible PDF from Word

documents and PowerPoint presentations.
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3.1 Accessibility in PDF documents. Basics

Many digital resources are available on the web in Portable Document Format
(PDF). Several institutions and educational content providers have published
on the web many educational resources, so it is important that they are
accessible in order to users are able to use them from any device and with any

type of disabilities they may have.

A PDF document should meet different conditions for ensuring that it can be
read by users with disabilities. However, because it is mainly a textual
resource, the main aspects of accessibility attended in PDF documents target
people with no vision. Nevertheless, there are more types of disabilities, such
as auditory, motor, cognitive and different kind of visual disabilities, which
should also be taken into account when creating an accessible PDF document

(Centro de Referencia en Accesibilidad y Estandares Web, 2009).

In this section, the basics necessary to create an accessible PDF document are

presented.

3.1.1 What is an accessible PDF and how do people with
disabilities access to the content of a PDF?

Company Adobe created Acrobat, which works with documents in PDF format.

These documents may include mostly text, but also tables and figures.

PDF is one of the most widely used formats on the Internet for document
exchange. The software necessary to access to a PDF is called PDF file
viewer, and one of the most used is Adobe Acrobat. A free trial of version

Adobe Acrobat Reader Xl Pro can be downloaded from the official website.

Other applications that allow to open PDF files and that do not require to be

paid for being used are:
= Foxit Reader.

= Sumatra PDF.


http://www.adobe.com/uk/products/acrobatpro.html
http://www.foxitsoftware.com/Secure_PDF_Reader/
http://blog.kowalczyk.info/software/sumatrapdf/free-pdf-reader-es.html
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According to their source, PDF documents can be of two types (Centro de

Referencia en Accesibilidad y Estandares Web, 2009):

= PDF image. It is generally a scanned document, and an Optical Character

Recognition (OCR) is needed to convert images into text.

= A document generated from a file text. This type of PDF can be processed

to support various accessibility characteristics.

This chapter teaches how to generate PDFs of the second type, i.e., text

generated by a computer.

In August 2012, standard ISO 14289-1 (International Organization for
Standardization, 2012) was published, which defines a new PDF/Universal
Accessibility (PDF/UA) file format, which is accessible for people with
disabilities. This is a milestone in the evolution of PDF format (Carreras, 2011),
and means that Acrobat will soon offer support for creating PDF files in
PDF/UA format.

About this new format, Carreras (2011) says that PDF/UA is not a specification
to evaluate accessibility of a PDF content or a guide to create accessible PDF,
but it is aimed at developers of PDF viewers and developers of tools for

creating PDF, as well as at providers of support products.

3.1.2 Characteristics of an accessible PDF

The characteristics that an accessible PDF should meet are (Centro de

Referencia en Accesibilidad y Estandares Web, 2009):

= The document is correctly structured. The four elements that define a
document with a correct structure are shown in Figure 3-1 (Sama Rojo &
Sevillano Asensio, 2012-a).

Figure 3-2 shows the structure of a PDF document, which includes
bookmarks. This way, having marked or tagged the sections, tables and
figures of the document, a screen reader will be able to navigate and locate
in an easier way the information of the document, if and when explicit

indications have been given about the reading order of the text.
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+The document should be marked with tags for
screen readers are able to read it in the correct
order.

Logical
reading order

Figure 3-1.

Figure 3-2.

Options

& Iﬂ Creating Accessible Adobe®
PDF Files
[ Contents
[E] Introduction
Iﬂ Section One: Checking PDF
Documents for Accessibility
[¥] section Two: Accessibility
Basics
E| Section Three: Accessible
PDF documents from Mative
Applications
Iﬂ Section Four: Creating
Accessible PDF Documents
from Untagged PDF
Documents
[E] Section Five: Creating
Accessible PDF Documents
from Scanned Documents
=5 Section Six: Creating
Accessible Forms
= 5] Using Acrobat 6.0
Professional to create
accessible forms

=Y Using the Adobe PDF

N

*The PDF document, in addition to having the
content, should include information about its logical
structure and the reading order. This information
should indicate which elements are text, which of
them are titles, which are images, etc.

A

«If the document has many sections, a good practice
is to add a table of contents that allows to quickly
locate any section in the document.

A

+*The lists of elements should be properly formed and
labeled.

_d

Elements that define a PDF document properly structured.

Creating an accessible form from an untagged PDF document

If you have an untagged PDF document with no interactive forms, you canst
to the document and then adding interactive form fields. The recommendec
to use the Adobe PDF Forms Access tool.

Totag an untagged PDF decument:
1 Open the untagged PDF form in Acrobat 6.0 Professional.
2 Open the Navigation pane.

3 From the menu bar, choose Advanced > Accessibility > Add Tags To Doc

|- B -

ELtton Too

[+ check Bos Toal

= combo B Toal

SR List B o Tad

(@) Rade Button Tool
1Trt P Toal

E’grjmlﬁgnsum Tacl

Shogs Formes Toalbar

Form field aptions in the Advanced Editing toolbar

To add electronic form fields to your newly tagged PDF document:

1 Click the Tags tab in the Navigation pane, or choose View > Navigation ”
2 Choose Highlight Content from the Options menu on the Tags tab.

3 Choose Tag Annotation from the Options menu of the Tags tab.

4 Select the element of the tags tree that should precede the field you are al

Structure of a PDF with bookmarks.
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Alternative text in figures. An accessible PDF document has a descriptive
text in each figure so that screen readers are able to read the text that

describes the figure.

Language of document. An accessible PDF specifies the language of
document explicitly so that the reader is able to detect it and perform

reading better.

Accessible security. An accessible PDF document should have proper

security settings so that it does not interfere on screen readers' work.

Links. Internal and external links of a PDF document should be well defined,

i.e., inserted as hyperlinks in the source document.

Navigation. An accessible PDF document should support navigation and
organization such as a table of contents, bookmarkers or headers so that
the user is able to navigate the document easily without having to read the
content until he/she finds what is looking for (Centro de Referencia en
Accesibilidad y Estandares Web, 2009).

Moreover, if a document is designed for collecting data from people, forms are

created using aggregation fields such as text fields, option groups and

checkboxes, among others. Figure 3-3 shows an example form designed to

collect data of projects from a group of students.

If a document has a data form, the PDF file should meet at least two

characteristics to have a proper structure:

Tabulation order. It is the order in which the fields in the form will be

navigated while being filled or examined using the keyboard.

Field identification. Each data field should be clearly identified and include

the corresponding accessibility properties for each of the objects.
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PROJECTS REGISTRATION FORM

Project title: |

Project type:
O social
(O Finantial
O Educational
O Political
O Environmental

Project description:

Start date: |:|

Figure 3-3. Form example.

3.1.3 Accessibility standard WCAG 2.0. Principles applicable

to PDF documents

WCAG 2.0 (World Wide Web Consortium, 2008) proposes a set of
recommendations to create more accessible web content. When they are
followed, a more accessible content is guaranteed for a greater number of
people with disabilities, including blindness and low vision, deafness and

hearing impaired, mobility limitations and combinations of the above.
Four principles are proposed by WCAG 2.0:

1. Perceivable: Information and user interface components must be
presentable to users in ways they can perceive. That is, the content should
be perceived by one or more senses of anyone, even though he/she is blind

or has a low vision.
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Operable: User interface components and navigation must be operabile, i.e.,
a user should be able to perform the action required to interact with it. This

interaction can be achieved in PDF files by means of forms.

Understandable: Information and the operation of user interface must be

understandable, both information and interaction.

Robust: Content must be robust enough that it can be interpreted reliably by

a wide variety of user agents, including assistive technologies.

3.1.3.1 Statement of WCAG 2.0 guidelines

For each of the above principles, WCAG 2.0 establishes a set of guidelines,

which should be met by an accessible PDF and are the following:

Guideline 1.1. Text alternatives: Provide text alternatives for any non-text
content so that it can be changed into other forms people need, such as

large print, braille, speech, symbols or simpler language.

Guideline 1.2. Time-based media: Provide alternatives for time-based
media, which includes audio, video, audio and video, and audio and/or

video combined with interaction resources.

Guideline 1.3. Adaptable: Create content that can be presented in different

ways (for example simpler layout) without losing information or structure.

Guideline 1.4. Distinguishable: Make it easier for users to see and hear

content including separating foreground from background.

Guideline 2.1. Keyboard accessible: Make all functionality available from a

keyboard.

Guideline 2.2. Enough time: Provide users enough time to read and use

content.

Guideline 2.3. Seizures: Do not design content in a way that is known to

cause seizures.

77



CHAPTER 3: CREATING ACCESSIBLE PDF DOCUMENTS

= Guideline 2.4. Navigable: Provide ways to help users navigate, find content,

and determine where they are.
= Guideline 3.1. Readable: Make text content readable and understandable.

= Guideline 3.2. Predictable: Make Web pages appear and operate in

predictable ways.
= Guideline 3.3. Input assistance: Help users avoid and correct mistakes.

= Guideline 4.1. Compatible: Maximize compatibility with current and future

user agents, including assistive technologies.

Each guideline is directly related to one or more types of disability (Table 3-1).
If these guidelines are not met when creating a PDF, some special groups will

not be able to access to it.

Guideline Description Blindness '_-°_W Hearing Motor
vision
1.3. Automatic speech Yes Yes Empty Empty
synthesizer.
1.3. Alternative presentation of Empty Empty Yes Yes

images, tables and graphs.

14. Contrast. Empty Yes Empty  Empty
1.4. Larger texts. Empty Yes Empty  Empty
1.4. Alternative text. Yes Empty Empty Empty
2.1. Move from the bookmarkers Yes Yes Empty  Empty

window to the document

window using the keyboard.

2.1. Mechanisms to jump, go Empty Empty Yes Yes
forward, go backward and
navigate.

24. Create two versions of a Yes Yes Yes Yes
document
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Guideline Description

Blindness LOW  Hearing Motor

vision
3.1. Set the language of each Yes Yes Yes Yes
document
41. Compatibility between Yes Yes Yes Yes
content and current
technologies
Table 3-1.  Accessibility guidelines and types of disability.

3.1.3.2 Summary tables of accessibility requirements by type and

level of adaptation

WCAG 2.0 proposes three levels of adaptation to accessibility (conformance

levels):

= Level A: For level A conformance (the minimum level of conformance), the

PDF document satisfies all the level A success criteria, or a conforming

alternate version is provided.

= |Level AA: For Level AA conformance, the document satisfies all the level A

and level AA success criteria, or a level AA conforming alternate version is

provided.

= Level AAA: For level AAA conformance, the web page satisfies all the level

A, level AA and level AAA success criteria, or a level AAA conforming

alternate version is provided.

Table 3-2 shows the principles, guidelines and success criteria that a PDF

document should meet to be technically accessible. In Carreras (2011), a table

can be observed, which also includes a reference to the PDF technique that

allows achieving all the success criteria.
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Principle Guideline success criteria Level
1. Perceivable 1.1 Text alternatives 1.1.1 Non-text content A
1. Perceivable 1.2 Time-based media 1.2.1 Audio-only and video- A
only (prerecorded)
1. Perceivable 1.2 Time-based media 1.2.2 Captions (prerecorded) A
1. Perceivable 1.2 Time-based media 1.2.3 Audio description or A
media alternative
(prerecorded)
1. Perceivable 1.3 Adaptable 1.3.1 Info and relationships A
1. Perceivable 1.3 Adaptable 1.3.2 Meaningful sequence A
1. Perceivable 1.3 Adaptable 1.3.3 Sensory characteristics A
1. Perceivable 1.4 Distinguishable 1.4.1 Use of color A
1. Perceivable 1.4 Distinguishable 1.4.2 Audio control A
2. Operable 2.1 Keyboard 2.1.1 Keyboard A
accessible
2. Operable 2.1 Keyboard 2.1.2 No keyboard trap A
accessible
2. Operable 2.2 Enough time 2.2.1 Timing adjustable A
2. Operable 2.2 Enough time 2.2.2 Pause, stop, hide A
2. Operable 2.3 Seizures 2.3.1 Three flashes or below A
threshold
2. Operable 2.4 Navigable 2.4.1 Bypass blocks A
2. Operable 2.4 Navigable 2.4.2 Page titled A
2. Operable 2.4 Navigable 2.4.3 Focus order A
2. Operable 2.4 Navigable 2.4.4 Link purpose (in A
context)
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Principle Guideline success criteria Level
3. Understandable 3.1 Legible 3.1.1 Language of page A
3. Understandable 3.2 Predictable 3.2.1 On focus A
3. Understandable 3.2 Predictable 3.2.2 On input A
3. Understandable 3.3 Input assistance 3.3.1 Error identification A
3. Understandable 3.3 Input assistance 3.3.2 Labels or instructions A
4. Robust 4.1 Compatible 4.1.1 Parsing A
4. Robust 4.1 Compatible 4.1.2 Name, role, value A
1. Perceivable 1.2 Time-based media 1.2.4 Captions (live) AA
1. Perceivable 1.2 Time-based media 1.2.5 Audio description AA
(prerecorded)
1. Perceivable 1.4 Distinguishable 1.4.3 Contrast (minimum) AA
1. Perceivable 1.4 Distinguishable 1.4.4 Resize text AA
1. Perceivable 1.4 Distinguishable 1.4.5 Images of text AA
2. Operable 2.4 Navigable 2.4.5 Multiple ways AA
2. Operable 2.4 Navigable 2.4.6 Headings and labels AA
2. Operable 2.4 Navigable 2.4.7 Focus visible AA
3. Understandable 3.1 Legible 3.1.2 Language of parts AA
3. Understandable 3.2 Predictable 3.2.3 Consistent navigation AA
3. Understandable 3.2 Predictable 3.2.4 Consistent AA
identification
3. Understandable 3.3 Input assistance 3.3.3 Error suggestion AA
3. Understandable 3.3 Input assistance 3.3.4 Error prevention (legal, AA

financial, data)
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Principle Guideline success criteria Level

1. Perceivable 1.4 Distinguishable 1.4.9 Images of text (no AAA
exception)

2. Operable 2.1 Keyboard 2.1.3 Keyboard (no AAA
accessible exception)

2. Operable 2.4 Navigable 2.4.8 Location AAA

2. Operable 2.4 Navigable 2.4.9 Link purpose (link only)  AAA

3. Understandable 3.1 Legible 3.1.4 Abbreviations AAA

Table 3-2.

Success criteria by conformance level.

3.1.4 Tools for analysis and correction

Once the PDF document has been created, the user should analyze it using
checking accessibility tools and then optimize its accessibility characteristics. In

this section, some of those tools are mentioned.

Tool

Description

Check a PDF.

TINGTUN CHECKEers

PDF Reader.

PDF Accessibility
Checker (PAC).

Adobe Acrobat.

E Adobe

Online tool for checking accessibility created by the Norwegian
Government. It allows checking accessibility of PDF documents
(as well as web pages). Users can choose between using the

web address (URI) of the PDF file or uploading a document.

Free checking tool, which can be free downloaded and installed
in Microsoft Windows 2000, XP or Vista.

Free checking tool, which can be free downloaded and installed
in Microsoft Windows XP, Vista or Windows 7. It is also
possible to run it in Mac after some adjustments.

Commercial package that allows users to view, create and
modify PDF files. The Pro version can be free downloaded from

web.

Table 3-3.

Tools for accessibility checking.


http://accessibility.tingtun.no/en/pdfcheck
http://accessibility.tingtun.no/en/pdfcheck
http://webbie.org.uk/pdfreader/index.htm
http://www.access-for-all.ch/en/pdf-lab/pdf-accessibility-checker-pac/downloading-pac.html
http://www.access-for-all.ch/en/pdf-lab/pdf-accessibility-checker-pac/downloading-pac.html
http://www.adobe.com/downloads/cs2_downloads/
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Table 3-3 shows four tools that can be used to check the accessibility of a PDF
document. The automatic check performed with tools such as those mentioned
in Table 3-3 includes checking the technical characteristics of the document,
but not all accessibility criteria. Below are described two of the most popular

checking tools.

3.1.41 Checking using Adobe Acrobat

Adobe Acrobat Professional provides a set of tools and functionalities to help
creating accessible PDF documents. The functionalities provided are (types

(Centro de Referencia en Accesibilidad y Estandares Web, 2009):
= Checking accessibility issues using tool Accessibility checker.
= Correct issues in PDF documents tagged using tab Tags palette.

= Check the document by a screen reader included in some versions of
Adobe Acrobat.

= Create accessible PDF forms using tab Tags palette. Tagged PDF forms
allow screen readers to recognize the fields, read the textual descriptions

associated to each field and identify the reading order of them.

= Function read out loud allows seeing how the document will be presented to

readers when using this tool for converting text to speech.

Two types of accessibility checking are provided by Adobe Acrobat

Professional, quick and full:

= Quick: checks for document structure tags, searchable text, and appropriate

security settings for accessibility.

= Full: in addition to the standard option, it validates some of the accessibility
guidelines in WCAG 2.0 and other standards.

Table 3-4 shows a summary of the characteristics analyzed during each type of
check.
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Characteristic examined Quick check Full check
Logical structure of the tagged PDF document X

Reading order X
Alternate text for images and other visuals X
Specification of the document language X
Reliable character encoding X
Descriptions for all form fields X
Structure of tables and lists X
Security settings appropriate for accessibility X X

Table 3-4.  Accessibility checking provided by Acrobat.

More checking options of this tool can be found in Acrobat help website, as well

as the results and effects that may be obtained after correcting errors.

3.1.4.2 Checking using PDF Accessibility Checker

Tool PDF Accessibility Checker (PAC) conducts the following tests within PDF

documents:

Test 1: Document is marked as tagged.

Test 2: Document title available.
= Test 3: Document language defined.
= Test 4: Accessible security settings.

= Test 5: Tab follows tag-structure, i.e., it checks whether all pages in the
PDF document are configured such that when Tab key is used, the jumps

performed follow the structure of tags.
= Test 6: Consistent heading structure.
= Test 7: Bookmarks available.

= Test 8: Accessible font encodings.


https://helpx.adobe.com/acrobat.html
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= Test 9: Content completely tagged.

= Test 10: Logical reading order.

= Test 11: Alternative text available for non-text content.
= Test 12: Correct syntax of tags.

= Test 13: Sufficient contrast for text.

Test 14: Spaces existent.

3.2 Creating accessible PDF documents

3.2.1 Requirements previous to design, layout and content of

the source document

Chapter 1 and Chapter 2 should be inspected in order to detect certain
problems that can affect the accessibility of the PDF file you are trying to

create.

3.2.2 Creating PDF files from existing documents

How to create an accessible PDF depends on the source of the document. If
the document is written with a word processor, it can be converted into a PDF

document using the Adobe Acrobat virtual printer.

The accessibility of the PDF document will depend directly on the accessibility
of the source document, because the more correct is the source document, the
more accessible will be the final PDF and fewer revisions or modifications
should be made. It is always advisable to check the accessibility of the
document. Therefore, before applying the following steps, it is important that
the source document has been analyzed for checking the aforementioned

accessibility characteristics.

The procedures detailed below to create and modify PDF documents have

been designed for Adobe Acrobat Professional. Although they could also work
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for later versions, small changes might be required for previous versions of
Adobe Acrobat.

Also, the processors in which the text documents are created can be many,
such as Open Office Writer and Microsoft Office Word, each with its different
versions. In this section, procedures to create PDF documents from these two
tools are presented. There exists bibliography with procedures for other options
(Carreras, 2009; Centro de Referencia en Accesibilidad y Estandares Web,
2009).

3.2.2.1 Creating PDF files from Open Office Writer documents

To create a PDF document from the word processor OpenOffice.org (Open

Office Writer), the following steps are required:
= Step 1. In menu “File”, select the option to “Export as PDF” format.

= Step 2. In the dialog that opened, the export options are showed. Be sure
that the following options are selected in tab “General - Tagged PDF and
Export bookmarks” (Figure 3-4).

= Step 3. In the window that appears, choose the location where the PDF file

will be saved, put a name for the file and finally click “Save” button.

Exporting as PDF is similar in the rest of Open Office programs.

3.2.2.2 Creating PDF files from Microsoft Word 2003/2007/2010

documents

In Microsoft Office Word 2007 or Microsoft Office Word 2010 there are two
ways to create a PDF file from a Word document previously created (Sama

Rojo & Sevillano Asensio, 2012-a):
= Using the Word functionality.

= Using the PDFMaker functionality of Adobe Acrobat Professional.


http://www.openoffice.org/en
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In both cases it is necessary to configure some accessibility options. The

configuration procedures and the creation of PDF files using the

aforementioned techniques are showed below.

Figure 3-4.

PDF Options - '

General |Initial View | User Interface |Links | Securityl

Range
@ Al
() Pages
) Selection

Images

() Lossless compression
@ JPEG compression

Quality 90%
[] Reduce image resolution 300 DPL

General
[7] PDF/A-1a
[7] Tagged PDF
Create PDF form

Submit format FDF
[ Allow duplicate field names

Export bookmarks

[] Export comments

[] Export automatically inserted blank pages
7] Embed standard fonts

[] Embed this document inside the PDF

[k

| Eport || Cancel || Hep |

Using the Word functionality

Options to export as PDF in Open Office.

To generate a PDF document from Microsoft Office Word 2007 or 2010 without
using PDFMaker, perform the following steps:

Step 1. In Word 2007, from the main window of the tool, go to menu “File >

Save as = PDF or XPS".

In Word 2010, from the main window of the tool, go to menu “File > Save &
Send - Create PDF/XPS Document - Create PDF/XPS”.

87



CHAPTER 3: CREATING ACCESSIBLE PDF DOCUMENTS

= Step 2. A dialog will open (Figure 3-5) to save the document. Then click
“Options” button and be sure that checkbox “Document structure tags for

accessibility” is selected and click button “OK”.

= Step 3. Select the location of the file, put a name to the PDF document and
click “Publish” button.

Now the PDF file can be opened by a PDF viewer.

ert'l::uns [ 2 |ih,|1

Page range

(71 Current page
Selection
i) Page(s) From: |1 = To: |1

Publish what
i@ Document
Document showing markup
Indude non-printing information
Create bookmarks using:
i@ Headings
Word bookmarks
Document properties
Document structure tags for accessibility
POF options
[] 150 12005-1 compliant (PDF/A)
Bitmap text when fonts may not be embedded
[| Encrypt the document with a password

| ok || canel |

b —

Figure 3-5.  Accessibility options in Word for saving as PDF.

Using the PDFMaker functionality of Adobe Acrobat Professional

PDFMaker is installed in the Windows Office applications when Adobe Acrobat
is installed. PDFMaker allows converting documents of these applications into
tagged PDF documents in which links, styles, bookmarks and the logical

structure of the source document are kept. Below are described three activities
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included in the PDFMaker configuration previous to the creation of PDF

documents from Word.

The first three procedures explained should be performed the first time that a
PDF file is going to be created from Office Word in the computer. The following
times only the last procedure “Creating a PDF file from a Word document” is

needed.

PDFMaker configuration from Adobe Acrobat
To configure this component from Adobe Acrobat, do the following:

= Step 1. From Adobe Acrobat Professional tool, select menu “Edit” and then

option “Preferences...”.
= Step 2. A menu will open, in which you have to click “Convert to PDF”.

= Step 3. A list with source formats will be showed. Select “Microsoft Office
Word” and click “Edit settings...”.

= Step 4. In the dialog “Adobe PDF settings for supported documents”, be
sure that option “Enable accessibility and reflow” (Figure 3-6). Finally, click
“OK”.

Activation of PDFMaker button bar

In Microsoft Office 2003 and earlier versions, the options to create PDF
documents are in the Adobe PDF menu; and in later versions (such as 2007 or
2010), the Acrobat ribbon provides the respective functionalities. When Adobe
Acrobat is installed in a computer, the options to generate PDFs are added
(Figure 3-7).

However, if the buttons of the PDF toolbar do not appear in Microsoft Word
after Adobe Acrobat is installed, the following steps should be followed to
activate them. Otherwise, i.e., if these buttons are already available from Word,
proceed to the next paragraph (Setting preferences for Adobe PDFMaker in
Microsoft Word).

In Microsoft Office Word 2003 or earlier versions:
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= Step 1. Go to menu “View” and click “Toolbar”.

= Step 2. Select option “Acrobat PDFMaker”.

Categories: Converting To PDF

Commenting Autodesk AutoCAD
Documents BMP

Full Screen Compuserve GIF
General HTML

Page Display InDesign
_— JDF Job Definition

3D JPEG

Accessibility JPEG2000

Batch Processing Microsoft Office Excel
Catalog Microsoft Office Power
Color Management Microsoft Office Word | |
Convert From PDF Microsoft Publisher
Convert To PDF = PCX

Forms PNG

Identity PostScript/EPS
International ‘4 L}

Internet

JavaScript Edit Settings...

1 {
Measurfng (20) Adobe PDF Settings for supported documents u
Measuring (30)

Meeting
Muttimedia Adobe PDF Settings:
Multimedia Trust
MNew Document Adobe PDF Security: ’ MNone v] Edit...
Online Services
Reading [] Add bookmarks to Adobe PDF file
Reviewing [¥] Add links to Adobe PDF file

Search Enable accessibility and reflow
Security

Click Edit Settings to view or edit settings for this file type.

Figure 3-6.  Options of converting Word documents in Adobe Acrobat

Professional.

Help | Adobe PDF | Acrobat Comments
o - ﬂl_\:|| Convert to Adobe PDF

g E‘ Convert to Adobe PDF and Email

— gj Convert to Adobe PDF and Send for Review

Change Conversion Settings

ﬁ: Embed Video and Convert to Flash Format

|E"| Insert Acrobat 3D Model [

z Tl’l 5 Mail Merge to Adobe PDF

Figure 3-7. PDFMaker in Microsoft Word 2003.
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In Microsoft Office Word 2007 or later:

Step 1. In Word 2007, click “Office” and then “Word Options”. In Office
2010, click tab “File” and then click “Option”.

Step 2. Click “Adds-In”, on the left side of the dialog box.
Step 3. Do one of the following:

- If “Add-In Acrobat PDFMaker Office COM” does not appear, choose
“COM Adds-In” in pop-up menu “Manage” and click “Find”.

- If “Office COM Add-In” of Acrobat PDFMaker appears in “Disable adds-
in application”, choose “Disable elements” in pop-up menu “Manage”

and click “Go”.

Step 4: Select “Office COM Add-In” of Acrobat PDFMaker and click
“Accept”.

Step 5: Close the Word application and start it again.

Setting preferences for Adobe PDFMaker in Microsoft Word

The following steps are necessary to assign the adequate parameters to

PDFMaker and create accessible PDFs.

Step 1. Choose one of the following options, depending on the Word

version:

- In Microsoft Word 2003 or earlier, go to menu “Adobe PDF” and select

“Change conversion settings”.

- In Microsoft Word 2007 or 2010, go to ribbon “Acrobat” and click

“Preferences”.

Step 2. In window “Acrobat PDFMaker” that appears after the first step,
check the following parameters (the names of the options may vary slightly

between different Office versions):
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- In tab “Settings”, the following boxes must be selected: “Add bookmarks
to the Adobe PDF file”, “Add links to the Adobe PDF file” and “Enable
accessibility and reflux with Adobe PDF file”.

- In tab “Security”, box “Enable text access to screen readers for users

with visual disabilities” must be selected.

- In tab “Word”, select boxes “Convert cross references and tables of
content in hyperlinks”, “Convert links of footnotes and endnotes” and

“Enable advanced tagging”.

- In tab “Bookmarks”, select box “Convert Word titles in bookmarks” and
choose the styles you want to convert into bookmarks in the PDF

document.

Creating a PDF file from a Word document
Perform the following steps to create a PDF file from a Word document.
= Step 1. Open the file from Microsoft Word.

= Step 2. Do one of the following, depending on the Word version with which

the document has been created:

- In Word 2003 or earlier, click “Convert to Adobe PDF” in menu “Adobe
PDF”.

- In Microsoft Office 2007 or 2010, click “Create PDF” in “Acrobat” ribbon.

= Step 3. In the dialog box, select “Save Adobe PDF file as” and put a name
for the new PDF file, choose the location where it will be saved and finally

click “Save”.

3.3 Creating PDF files from existing accessible

presentations

In this section, the process to be followed for creating a PDF file from an
accessible PowerPoint presentation is explained. The easiest method is

explained below, however, one of the two methods presented in the previous
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section can also be followed. The steps are very similar to those already

described for Microsoft Word.

= Step 1. Choose one of the following options, depending on the Office

PowerPoint version in which the presentation was created.

- In PowerPoint 2007, click “Microsoft Office” button and select “Save as”.

- In PowerPoint 2010, click menu “File” and select “Save as”. In
PowerPoint 2013, before accessing menu “Save as”, firstly select the

location of the file.

= Step 2. In the dialog box that appears, enter a name for the PDF file. In
menu “Type” select “PDF” and select the location where the file will be

saved. To finish, click “Save” button.

3.4 Evaluating accessibility of a PDF document

In this section, the steps necessary to evaluate the accessibility of a PDF
document using Adobe Acrobat Pro and PDF Accessibility Checker tools are

explained.

Sama Rojo & Sevillano Asensio (2012-a) recommend to work with the
aforementioned tools, according to the flow showed in Figure 3-8. This process
is necessary because the authors discovered that PDF Accessibility Checker

detects accessibility issues in documents that Acrobat detected as valid.

Complementary
checking

] ]
P K

Adobe Acrobat Pro

Initial checking Error correction Error correction

Figure 3-8. Accessibility evaluation process of a PDF document.
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It is important to note that the checking process should be cyclical, i.e., after
checking by using one of the tools, the issues reported have to be corrected

and then analyze again the document until no issues are detected.

In the following sections, the steps for each type of checking indicated in Figure
3-8 are described. The “Correcting errors” component is explained in section
3.6.

3.4.1 Initial checking

3.4.1.1 Adobe Acrobat Professional X

As mentioned in section 3.1.4.1, Adobe provides two types of accessibility
checking: quick and full. In this case, full checking is used. To access to it from
this tool, go to “Tools = Accessibility - Quick Check or Full Check™.

If full check is selected, a pop-up window will appear (Figure 3-9), in which the
user can choose between different options of reports and comments. In the

case of Quick check, a simple and quick check is executed.

In the advanced check settings window (Figure 3-9), the following options can

be selected:

= |n section “Report and comment options”, choose the directory where the
accessibility report will be saved. By default, it is saved in “My documents”

folder.

= In “Page range”, a page range can be selected, which is convenient when
the document is very large and different checkings for each section of the

document may be performed.

2 In other versions of Acrobat, it may be located in menu “Advanced” instead of in

“Tools”.
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= In section “Checking options” the following can be selected:

- The accessibility standard (Adobe PDF, Section 508 (U.S.) or World
Wide Web Consortium (W3C)) in “Name”, by default, “Adobe PDF” will

appear.

- The accessibility options that should be checked. For a full check,

selecting all options is recommended.

To proceed with the analysis, click button “Start checking”.

Accessibility Full Cheek [

Repert and Comment Qptions

Create Accessibility Repert Folder: F\Eva\Documents

Include repair hints in Accessibility Report

Create comments in document

Page Range

@ All pages in document () Pages from i to |i

Checking Options

Narmne: [Adobe PDF ']

Alternative descriptions are provided l
[¥] Text language is specified

Reliable character encoding is provided

[¥] &ll content is contained in the document structure
All form fields have descriptions

Tab order is consistent with the structure order I

List and table structure is correct

[ selectAl | [ Clear Al

Disclaimer

Hide Disclaimer

The Accessibility Checker can help you identify areas of your documents that may be in conflict with  »
Adebe's interpretations of the referenced guidelines. However, the Accessibility Checker does not =
check all accessibility guidelines and criteria, including those in such referenced guidelines, and Adobe s
Anes nnt warrant that vnore dacorents will Farnhe with ane erecifie noidelines ar renolatinne

Start Checking ] [ Cancel

Figure 3-9. Advanced check settings window of Adobe Acrobat.
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Once the analysis process has finished the results will appear, including links
and useful tips for performing corrections. Furthermore, you can go to the

directory selected for viewing the results of the accessibility report.

In Figure 3-10, “Accessibility checker” pane is showed, which is displayed after

a full checking.

Document [3 issues)

" Accessibility permission flag - Passed

%" Image-only POF - Passed

%" Tagged POF - Passed

&) Logical Reading Order - Needs manual chec

il

Skip Rule
Explain

" Primary langquage - "
L) Title - Failed

%" Bookmarks - Passe
) Color contrast - M| Check Again

Page Content (1 issuq  Show Beport
Forms (1 issue) Options
Alternate Text [1 issue)

Tables (1 issue]

Figure 3-10. Accessibility checker pane.

An icon which indicated the state is located beside each analyzed
characteristic. The elements that did not pass the checking appear as errors

and they must be corrected by the user. Below are listed all the possible states:

= “f? Passed: The element is accessible.

! Skipped by the user: the rule was not checked because it was not

selected in the dialog box “Accessibility checker settings”.

= &Needs manual check: the full checking function could not check the

element automatically. Check the element manually.

- “Failed: the element did not pass the accessibility checking.
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From this point, the accessibility issues detected can be corrected (see section
3.6). Once all errors are corrected, the second analysis can be performed with

the other suggested tool (PDF Accessibility Checker).
3.4.2 Complementary checking

The tool used for the complementary checking is PDF Accessibility Checker
(PAC).

PAC is a tool recommended by the consortium that regulates web technologies
(W3C) and, as aforementioned in section 3.1.4.2, it allows checking fourteen

criteria that an accessible PDF should meet.

In the PDF Accessibility Checker official website, information about its
installation and use can be found. In this section only the essentials are

explained, in order to it can be used when analyzing a PDF document.
PAC needs the following software previously installed in the computer:
= Operating system: Windows XP, Windows Vista or Windows 7.

= RDF Viewer: Adobe® Reader version 8 or later.

= Web browser: Mozilla Firefox 3 or later, Internet Explorer 8 or later, or

Google Chrome.
=  Microsoft .NET Framework 2.0 SP2 or later.

Using PAC is quite simple. To perform the technical analysis of a PDF file, run

the tool and do the following (Figure 3-11):

= Step 1. Download the PDF document to be analyzed. By clicking button

“Browse”, the location where the file is saved can be selected.
= Step 2. To start checking, click “Start”.

= Step 3. Review the summary of the results of the analysis. The elements

marked with a red cross are those that could not be validated.
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= Step 4. If the report has errors, you can click button “Report” to view the

details and determine the elements that can be improved or corrected.

urx_ PAC 2 - PDF Accessibility Checker 2 - BETA — |[
9 Zugang fOr alle PAC: PDF Accessibility Checker 2.0
Accés pour tous PALC is a free tool of the Foundation «Access for all= to
Accesso per tutti review the accessibility of PDF documents and
Access for all Forms. It serves as a tool for expents and testers,
More Information
PDF-File
Browse (1)
PDF/UA Check
[ st (2)
Results
Chedkpoint (3) Passed Warned Failed
A POF Syntax Dof DA 0
Fonts seof 0 ES 4
Content 26027 off 0/ 0
Embedded Files D of 0 4 1}
Natural Language 12’601 Qf 0 /4 1]
¥ Structure Elements 415 of 0 /s 4
Structure Tres 577 of 2 /i 0
Role Mapping 750 of 0 738
Alternate Desariptions 1456 of 0 4 178 38
[ Metadata 2¢f 0 /s 138
Document Settings 7 Qf 0 s o
x This PDF contains errors: Only partially accessible. (4) Report (5)
Tools
Screenreader Preview Document Statistics Logical Structure
Main sponsors: Powered by:
(1] SBPV F5A i w=
chwolzerischer Blinden
DIE POST S'J © oo & poF
Fédération suisse des mL />
aveugles et malvoyants

Figure 3-11. Results of a checking performed by PAC.

3.5 Initial technical checking for detecting issues that

require modifying the original document

In addition to the checking recommended to be performed for the source
document, creating a first version of the PDF document is suggested, with the

aim of performing an initial technical checking using Adobe Acrobat tool.

Checking accessibility helps detecting errors in some elements of the
document, which should be corrected in the application in which the source
document was created (i.e., OpenOffice or Microsoft Office) because they
cannot be corrected directly in the PDF document or correcting it manually from

Adobe Acrobat will be very difficult for the user.
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Therefore, based on the results of this first accessibility analysis, the necessary
changes should be carried out in the source document or presentation. Then
the PDF file will be created again and a new technical checking will be
performed from Acrobat, with the aim of checking whether the errors previously
reported have been solved. If so, other errors may be corrected directly from

Adobe Acrobat by the processes indicated in section 3.6.

Next, a method is proposed to address the accessibility issues that are

reported by Acrobat and that should be corrected in the source document.

= Step 1. Using one of the procedures previously described (sections 3.2.2
and 3.3), create the PDF file.

= Step 2. Using Acrobat tool, perform a full checking of the PDF file created.

= Step 3. In “Accessibility checker” pane, review whether errors have been
reported in the elements indicated in Table 3-5. The aspects that should be

reviewed and corrected in the source document are also indicated.

= Step 4. Once the issues mentioned in Table 3-5 have been corrected, a
new version of the PDF file can be generated and continue checking. If any
error was pending resolution, Adobe Acrobat can be used to solve it. Below

are indicated the procedures to be applied for each type of error.

Rule reported with error Element to be corrected in the source document

Document - Tagged PDF. For a PDF document is considered tagged, it should

Page content > Tagged include information about which elements are text,
content. which are titles, which are figures, which are lists,
etc.

If any error is detected by this rule, it is because
structural elements (titles, paragraph styles, lists,
bullets, among others) were not used in the
application in which the source file (text document
or presentation) was created, i.e., Microsoft Office

or OpenOffice.
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Rule reported with error

Element to be corrected in the source document

Document = Bookmarks.

Headings - Appropriate

nesting.

Document = Color contrast.

Page content > Character

encoding.

Tables > Rows.
Tables > TH and TD.
Tables > Headers.

Bookmarks facilitate navigation between sections of

the document.

If the document is organized into different sections,
it is important that a table of contents is inserted
when creating the document (in OpenOffice or

Microsoft Office) and when exporting it to PDF.

This category analyzes whether nesting styles used
for titles and subtitles of the sections of the
document are correct or not, i.e., it checks whether
styles have been used hierarchically (firstly Title 1,
then Title 2, Title 3, etc.).

Review the colors used in the different elements in
the source document, considering guidelines

provided in Chapter 1 for use of color.

Only fonts recognized by Acrobat may be used in
the text of the source document, so reading the
details of the issues generated is recommended to
determine the cause of the error. Once the origin of
the problem is detected, open the source document
in the application in which it was created and

change the font type.

If any error was reported in the tables of the
document, the source document should be
reviewed to detect what tables are not properly
structured. Correcting a table from Adobe Acrobat
requires the user a deep knowledge of its structure,

which is very complicated.

For this reason it is important that guidelines
explained in Chapter 1 for creating and managing
tables are taken into account to create the source

document from which the PDF file will be generated.
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Rule reported with error Element to be corrected in the source document
Lists - List elements Adobe Acrobat Professional, can detect to types of
Lists - Lbl and LBody accessibility issues in this category:

- When numbered lists or bulleted lists are not used

for creating lists.

- Nesting groups of elements is not correct or is not

clear.

Therefore, if an error is generated in the elements
referred to the left, the source document should be
reviewed to determine the elements that are

generating the error.

Table 3-5. Initial accessibility checking in a PDF document that involves

manual correction in the source document.

3.6 Correcting accessibility issues in a PDF file

Although the processes to create PDF files from accessible documents or
presentations have been explained before, some accessibility issues may still
persist. In this section, some of the most common errors that the analysis tools
can detect are presented, and also how to correct them directly on the PDF

document.

Adobe Acrobat Professional presents the results of the full check, organized
into several categories: Document, Page content, Alternative text, Tables, Lists

and Titles.

Acrobat offers the following options to solve the accessibility issues detected

after a full checking (Adobe, n.d.):

= Correct: Acrobat solves automatically the issue of the element or shows a

dialog box asking whether you want to correct the issue manually.

= Skip rule: It deselects this option in the dialog box “Accessibility checking
settings” for future checking in this document and changes the state of the

issue of the element to “Skipped”.
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Explain: It opens the online help.

Check again: It re-runs the checker for all elements. It is recommendable to

use this option after modifying one or more elements.

= Show report: It displays a report with links to tips about how to repair the

failed checking.

Options: It opens the dialog box “Accessibility checker settings”, where the

checking to be performed can be selected.

Although in some cases the automatic correction of Acrobat can be enough
for correcting minor problems, in other cases it is advisable to perform a

manual correction.
To correct automatically, do the following:
= Previous step: “Run the full check”.

= In “Accessibility checker” pane, click with the right mouse button on the

element marked with error and select “Solve”.

= On the element that the solution was applied, click with the right mouse
button again and select “Check again” to verify that the error has been

solved.

Below are indicated the categories of errors and the suggested tips to correct

them.

3.6.1 Document

Eight errors may occur in this category. In Table 3-6, the steps to be followed

for each error are showed:
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Element Description Correction
Indicator of The author of a document To establish the appropriate security
accessibility can specify that no part of settings, the following steps are:
permission. the accessible PDF canbe  _ g to menu “File > Properties’. In
copied, printed, extracted, the window “Document properties >
commented or edited. “Security”.
This configuration could - Select “No security” in menu
interfere with the ability of a “Security method”.
screen reader to read the
document, because these
readers should be able to
copy or extract the text of
the document in order to
convert it to speech.
Image-only It indicates whether the To recognize text in digitalized images,
PDF file. document has non-text automatic correction can be selected:
content that is not “Accessibility checker pane - Image-
accessible. If the document  only PDF file > Solve”.
seems to contain text but
does not contain any font it
could be an image-only
PDF file.
Tagged An untagged PDF hinders The way of correction suggested is to
PDF. screen readers work apply the tags manually, i.e., open the

because they will not be
able to determine the
correct reading order of the

elements of the document.

source file (document or presentation)
in the application, tag the content and

generate again the PDF.

These problems can also be corrected
from Adobe Acrobat. The steps
necessary to do so are explained in

the Acrobat help website.
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Element Description Correction
Logical If the content of the This rule must be manually checked.
reading document is not tagged Special attention should be paid on
order. using the appropriate tags,  text distributed in tables or columns, or
the screen reader willread  footer notes.
in wrong order. To check the reading order of the
document, go to pane “Order” (“View
- Show/Hide - Navigation panels >
Order™).
In “Order” pane, the information of the
PDF document can be viewed,
reordered or retagged.
Primary If the language has not To establish the language of a PDF
language. been established in the document:

original file (document or
presentation), it can be
performed in the PDF
document using Adobe
Acrobat Professional. When
the language is explicitly
established, the screen
reader will be able to know

the language to be used.

- Select “File” menu and then

“Properties”.

- In the window “Document properties”,
go to tab “Advanced”, locate the
section “Reading options” and select
the appropriate language of the

document.

3 In other versions it can be located in “View = Navigation panels = Order”.
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Element Description Correction

Primary The language for the whole  To establish the language in sections

language. document can be or specific words:

(Cont.) established, but also - If pane “Tags” is not visible, go to
different languages for menu “View” > Show/Hide >
different parts of the Navigation pane” > Tags™.
document.

- In pane “Tags”, locate the text
element to which a language will be
assigned, click with right mouse
button and select “Options >
Properties”.

- In dialog box “TouchUp Properties”,
select tab “Tag”, select a language in
“Language” and finally apply changes
by clicking button “Close”.

Title. The PDF document has no  If the source file did not have the

property title.

property title established, the value
can be assigned from Adobe Acrobat.
To do this, do the following:

- Go to “File” menu and select

"Properties”.

- In window “Document properties”, go
to tab “Description” and fill the
missing fields. Completing at least
title, description and keywords is

advisable.

- Close the dialog box, click “Accept”.

4 In other versions, it can be located in “View = Navigation panels = Tags”.
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Element

Description

Correction

Bookmarks.

If the document is short and
it is not necessary to
organize it into different
sections, checking of this

rule can be skipped.

Small adjustments can be performed
in document bookmarks from Adobe

Acrobat from “Bookmarks” pane.

If pane “Bookmarks” is not visible, go
to “View > Show/Hide - Navigation

pane - Bookmarks™.
In “Bookmarks” pane.

If you need to create a bookmark for a
section in the document, locate in the
main window of Acrobat the page and
the first line of the section that will be
marked. To create a new bookmark,
click button “New bookmark” and
assign a title to the bookmark. Finally,
to assign a location within the
document, click with right mouse
button over the bookmark title, select
“Set Destination” (Figure 3-12) and a
dialog box will appear, which asks “Are
you sure you want to set the
destination of the selected bookmark

to the current location?”. Click “Yes”.

If you need to modify or remove a
bookmark, click with right mouse
button over the bookmark and select

one of the available options.

5 In other versions, it can be located in “View = Navigation panels = Bookmarks”.
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Element Description Correction

Color When errors are detected in  In section 1.1.16 of Chapter 1, some

contrast. this rule, it is possible that guidelines about managing color were
the document includes explained for avoiding accessibility

content non-accessible for issues.

colorblind people. If any error is detected, it is preferable
to correct it in the source document
(the document from which the PDF file
was generated) and generate again
the PDF.

The other option is correcting it in
Adobe Acrobat. To do so, do the

following:

- Go to menu “Edit” (or “Acrobat” in
Mac platforms) and then

“Preferences”.

- In window “Preferences”, click

“Accessibility”.

- Select checkbox “Replace document
colors” and then select “Use high-

contrast colors”.

- In combo box “High-contrast color
combination”, select the most
adequate combination of colors and
click “OK”.

Table 3-6.  Errors discovered in category document.
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*®

Options ~

Go to Bookmark
Print Page(s)
Cut

Delete

Set Destination
Rename

Use Current Appearance as New Default
v Wrap Long Bookmarks

Properties...

Ctrl+X

OJECTS REGISTRATION FORM

ect title: |

ect type:

Ctrl+I

Figure 3-12. Assignation of a target to a bookmark.

3.6.2 Content page

O social
OFinantial
OEducational
O Political

O Environmental

3.6.2.1 Tagged content, annotations and multimedia elements

In this section, the process that allows correcting the accessibility issues

detected in the following rules is explained:

1. Tagged content: it checks whether the content of the PDF is tagged.

2. Tagged annotations: it checks whether all annotations are tagged, i.e., it

checks whether the annotations of the document (such as comments and

editorial marks - insert and highlight) are included in tree "Tags" or are

marked as artifacts.

3. Tagged multimedia elements: it checks whether all multimedia objects are

tagged.

Any error reported in these three checkings can be corrected through pane

"Content”.
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= Step 1. Open pane "Content". To do this, go to menu "View - Show/Hide

-> Navigation pane - Content".

= Step 2. In pane "Content", click with right mouse button on the element
(content, annotation or multimedia element) you want to tag and select

“Options - Create artifact".

As an example, the creation of an artifact for a text of the page is shown in
Figure 3-13.

|! Content ®

Options ~

= @ Evelution.pdf
D Pagel
D Page 2
D Page 3
D Page 4
D Page5
& D Page 6
D Annotations
Text:
Text:Sole Ut
Text: Delete
Ted: poss  Find...
Text:
Text: level
Text: . Highlight Content

Text: Properties...
A= - L = - — - ——

m

e f Raaling

Create Artifact...

Figure 3-13. Content pane. Create artifact.

6 In other versions it can be located in “View = Navigation Panels = Content”.
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= Step 3. To assign a tag to the content, go to "Tools” = Accessibility 2>
TouchUp reading order" and click on the element to be tagged (Figure 3-14,
step a). Then, in window "TouchUp reading order", select the type of tag to

be assigned (Figure 3-14, b).

= Step 4. To confirm the change, click "Close" button in window "TouchUp

reading order".
Repeat steps 2 to 4 for each page element you want to tag.

An alternative, instead of manually tagging element by element, is to let
Acrobat to assign automatically tags to the annotations. To do this, select "Tag

annotations" in menu "Options" of pane "Tags".

7 In other versions it can be located in “Advanced” instead of in “Tools”.
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Figure 3-14. Retouch reading order. Tag content.

To prevent further reported errors in the rules mentioned in this section, the
content, annotations or multimedia elements of the document must be included

in tree "Tags" or marked as an artifact.

3.6.2.2 Tabulation order

In a PDF document some elements can be navigated using the tab key, such

as links, fields in a form, comments and other annotations.

This rule checks whether the tabulation order is adequate depending on the

document structure.

If any error is detected by this rule, Adobe Acrobat Pro lets to automatically
correct the tabulation order, although some elements may not have been set

with a correct order.

To use the automatic option, go to pane "Accessibility checker - Page content

-> Tabulation order", right click on this last element and select "Solve".
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To manually correct the detected issues do the following:

= Step 1. Go to pane "Page thumbnails". If it does not appear, go to menu

"View - Show/Hide - Navigation pane - Page thumbnails".

= Step 2. In pane "Page thumbnails", click the first page of the document, go

to menu "Edit" and select "Select all".

= Step 3. Right click on one of the selected thumbnails and select option

"Page properties".

= Step 4. In dialog box "Page properties", locate tab "Tabulation order" and

select "Use document structure".

= Step 5. Finally, click "Accept".

3.6.2.3 Other checkings

Other two rules that are checked in category "Content page" are "Characters
encoding" and "Navigation links". To correct the issues reported in this rules, it
is necessary to modify the source document. For this reason, in section 3.5
(Initial technical checking for detecting issues that require modifying the original

document) the processes to avoid this type of errors were explained.

Finally, other three rules that are checked are: i) Screen flicker, ii) Scripts and
iii) Timed responses. Any error reported needs a manual correction and a more
advanced knowledge. The Acrobat help website (Adobe, n.d.) can be read to

find a way to correct the detected issues.

3.6.3 Alternative text

As mentioned above, alternative text for figures and non-textual content of a
document is important for people with visual disabilities. Some rules are
mentioned below, which are checked in this category, and also the way to

correct the detected errors.
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3.6.3.1 Alternative text in figures

If an alternative text was set for each of the figures inserted in the source
document, no errors should be found with this rule. However, if after running
the full check to the PDF document any error has been detected with this rule,

do the following:

= Step 1. Go to pane "Accessibility checker", expand category "Alternative
text", right click on "Alternative text of figures" and select "Correct" in the

drop-down box.

= Step 2. In dialog box "Set alternative text" (Figure 15), add the alternative

text to each figure that does not have it.

= Step 3. Once a text has been added to all figures, click "Save and close".

et T _@

Alternate Text:

| 0K | | DontAddAl-Ted |

Figure 3-15. Dialog box "Set alternative text" for a figure.

Other three rules are checked in this category but they are related to elements
that uncommonly are inserted in documents or presentations. Therefore, they

are not explained in this chapter.

3.6.4 Tables

Adobe (n.d.) recommends performing manually the correction of problems
detected in a table, due to the complex structure. However, if the tables were
created in a word processor like Microsoft Word, no errors should be detected
in Acrobat. Anyway, below there is a brief explanation about how to apply

corrections in a table using Acrobat.
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To check the accessibility of a table, it is necessary before to know their

elements and their relation.

In Figure 3-16 the components of a table are shown. Below are described each

of them:
CAFTION Table 1. Marks. Group A
THEAD | ™ Name Mark 1 Mark 2
| N 8 19
O Nb2 20 18
TFOOT I T  Average _19_ _15.5_

Figure 3-16. Example of a table with its elements.

CAPTION. Table title.

= THEAD. Table header.

= TFOOQOT. Table footer.

= TR. Table row. A <TR> element must exist for each row of the table.
= TD. Data cell.

= TH. Header cell.

The first three elements will help users who access the document using a

screen reader to know what information contains the table.

Considering these elements, the structure of the table shown in Figure 3-16

would result in the following code:

<table>
<caption>Table 1. Marks.
<thead>
<tr>
<th>Name</th>
<th>Mark 1</th>
<th>Mark 2</th>

Group A</caption>

</tr>
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</thead>
<tfoot>
<tr>
<th>Average</th>
<th>19</th>
<th>18.5</th>
</tr>
</tfoot>
<tbody>
<tr>
<td>Nbl</td>
<td>18</td>
<td>19</td>
</tr>
<tr>
<td>Nb2</td>
<td>20</td>
<td>18</td>
</tr>
</tbody>
</table>

The following can be observed in the indicated structure:

= From a <TABLE> element, tags <CAPTION>, <THEAD>, <TBODY> and

<TFOQOT> can derive. Of all the above elements, the latter is optional.

= Elements <THEAD>, <TBODY> and <TFOOT> must contain at least one

row tag <TR>.

= Each row element <TR> must contain one or more cell tags <TH> and

<TD> if it is a header cell or a data cell, respectively.

Given the above explanation, the correction procedure that can be applied to
improve these data structures is explained below. Table 3-7 shows some errors

that may occur and the procedure to solve them.

Rule Checking description

Rows This rule checks whether each row (TR) in a table is a child, i.e., it is
in a header (THead), body (TBody) or foot (TFoot) of the table.

TH and TD In an adequate table structure, a header cell (TH) and a data cell
(TD) are child of a row (TR).
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Rule Checking description

Headers Each table in a PDF document should have one header.

regularity Tables must contain the same number of columns in each row and
the same number of rows in each column.

Correction To solve the detected problems with this four rules do:

for the above

rules

Summary.

- Step 1. Go to pane "Accessibility checker" and determine what

checking of rule failed.
- Step 2. Go to pane "Tags", expand the root tag.

- Step 3. Locate the elements tagged with <Table> and perform the

following checkings:

- Each table row <TR> must contain header cells <TH> or data

cells <TD>.
- Elements <THead>, <TBody> or <TFoot> are under tag <Table>.

- Elements <THead>, <TBody> and <TFoot> contain table rows
<TR>.
- Each table row contains table headers <TH>, data cells <TD> or

both.

If the tag of the table does not contain those elements but rows,
columns and cells appear in the table in the document pane, tool
“Retouch reading order” should be used to select and define the

table or individual cells.

If the table contains rows that occupy two or more columns,
attributes ColSpan and RowSpan should be used in the tagging

structure.

Table summaries are optional, but may improve accessibility.
To add a summary to a table, do the following:

- Select “Tools — Accessibility — Retouch reading order”.

- Right click on the table that generated the error and select option
“Edit summary table”.

Add a summary and click “Accept”.

Table 3-7.
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3.6.5 Lists

Two rules are checked in this category: “List elements” and “Lbl and LBody”. To
understand the possible errors, firstly the difference between a list properly

created and another one is explained in Table 3-8.

Errors can be detected when the structure of the list is not respected (“List
elements”) or when elements of a list are not created using bulleted or
numbered lists (“Lbl and LBody"®).

To correct the issues detected in this category, do the following:

= Step 1. Go to pane “Accessibility checker”. In option “List elements”, click

the element that provoked the error and select “Show in tag pane”.

= Step 2. Create as many elements as needed, change the type of elements

or reorganize the existing ones by dragging them to the corresponding

location.
Correct list Incorrect list
- Element of list 1. Element of list 1.
- Element of element of list 1.1. Element of element of list 1.1.
- Element of tag 1.1.1. Element of tag 1.1.1.
- Element of tag 1.1.2. Element of tag 1.1.2.

- Element of element of list 1.2. Element of element of list 1.2.

- Element of list 2. Element of list.

8 A list structure is correct when the list has the following hierarchy: a list element (LI)
must contain elements of elements of list. Elements of elements of list only can contain

tag elements (Lbl) and body elements of elements of list (LBody).
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Table 3-8.  Sample lists.

3.6.6 Headers

If an error was detected in this category is because an inconsistency was found
on the nesting level of the styles used to mark the sections of the document. To

correct the error, do the following:

= Step 1. In pane “Accessibility checker”, right click on the element that
appears with an error in “Suitable nesting” and select option “Show in Tags

pane”.

= Step 2. In pane “Tags”, create the elements necessary or reorganize the

existing elements by dragging them to the corresponding tag.

Following the processes detailed in this section, most of accessibility problems
that a PDF document may present should have been solved so that it can also

be used by people with disabilities, especially visual.

Once the errors detected by Adobe Acrobat have been solved, a
complementary checking of the PDF document is suggested, using PDF

Accessibility Checker (PAC) analyzer.

The next section explains how a person who uses a support device (such as a

screen reader) will perceive the content of a PDF.

3.7 Reading a PDF document using a screen reader

Different software tools can be used to read aloud from a PDF file. One of the
most popular is JAWS, however, Acrobat products have also a feature

available to do so.

Before using the feature of reading out loud of Acrobat, it is necessary to
enable it. To do this, go to menu “View - Read out loud = Activate read out
loud”. From this point, various operations can be performed. Once the reading

aloud process has finished, it is recommended to disable this option.
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A video which shows how to read a PDF document from Adobe Acrobat Pro or

Adobe Reader is available at YouTube (Video2brain, 2013).

The options that can be performed using “Read out loud” are shown in Figure

3-17.

Read Out Loud Deactivate Read Out Loud Shift+ Ctrl+Y
Read This Page Only Shift+Ctrl+V
Read To End of Document Shift+Ctrl+B
Pause Shift+ Ctrl+C
Stop Shift+Ctrl+E

Figure 3-17.  Options of “Read out loud” feature.

These actions can be accessed from menu “View” and allow to manage or

control the reading sequence.
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Chapter 4. Creating accessible audiovisual

content
Translators: Authors:
Eva Garcia Lépez M? Carmen Cabrera Loayza
Antonio Garcia Cabot Universidad Técnica Particular de Loja, Ecuador
University of Alcala, Luis Bengochea Martinez
Spain Universidad de Alcala, Espana

The widely use of virtual classrooms at the universities has become a common
space for teachers and students to interact, both in distance courses or in
classroom courses as complementary education. This has allowed teachers to
include new learning resources, additional to the text document and

presentations commonly used.

The use of multimedia learning content provided by animations, simulations or
images and explanations recorded in video, which cannot be included in a
book, are increasing and the trend is growing up. This is an essential part of the
ecosystem of current students, who use tablets and smartphones for accessing
the recorded classes taught at universities around the world, as well as all

types of educational videos in platforms such as YouTube.

The video and audio educational resources can be included in classroom
courses, in virtual classes or in MOOC courses, where they can be showed to

the students many times. This provides an extra motivation to the students,

121



CHAPTER 4: CREATING ACCESSIBLE AUDIOVISUAL CONTENT

122

increasing their learning performance, contributing both to retention and
understanding of complex content (learning), and the application of knowledge

to solve new problems (skill).

Although some universities have technical and human teams for producing
professional video tutorials and other multimedia content, the creation of
educational videos or audiobooks can be done by teachers, using a basic

informatics equipment and easy and affordable applications.

Due to the aim of these audiovisual educational materials is completely didactic
and their target are the students of a specific course, it is not necessary to use

a complex and sophisticated production equipment.

However, the audiovisual materials pose new accessibility issues which are
important to be taken into account. It is important that the authors of this
content get the knowledge and skill that enable them to provide accessibility to

this content. In this way, the content could be accessible to any student.

In this section you will learn the concepts of accessibility in learning content of

audio and video, as well as the way to convert text documents into audio files.



GUIDE FOR CREATING ACCESSIBLE DIGITAL CONTENT

4.1 What should an accessible video have?

Implementing multimedia educational content (such as videos, which have
become a very important supporting material in the training process) has
proven to be efficient and useful in education as a means of knowledge
transfer. Taking this into account, its creation should consider a special focus
for users with sensory impairments, which may be visual and auditory

disabilities.

The main criteria to be considered when creating videos are explained in this
section, to convert them in accessible educational content (Sama Rojo &
Sevillano Asensio, 2012-b):

Transcript.

Captions.

Audio description.

Interpretation in sign language.

There are also other aspects to be taken into account (Moreno, Ruiz, Martinez,
Carrero & Martinez, 2008), which determine the accessibility of this content

such as:

= Access to multimedia content should be accessible.

- Content direct download.

- Playing content. Techniques:
- Playing in progressive download (false streaming).

- Streaming.

= User preferences and usability of access and user interaction with the

content.
- Size of the resource.

- Duration of the audiovisual content.

- Speed options and connection type for user preferences.
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Progress bar.
User agent/s associated with playing.

Formats (Windows media, Real, QuickTime, Synchronized

Multimedia Integration Language (SMIL)).

The criteria to be considered for creating accessible videos are explained in

detail below.

4.1.1 Transcript

A transcript is a text file that contains all spoken audio in the video, and which

can be downloaded by users. Transcripts can be read as a document or as a

real screenplay. As they contain the same information that captions, it could be

interesting to save them in a text format and then perform the necessary

changes to publish it as a transcript.

It is recommendable to create transcripts in a plain text format to avoid possible

accessibility issues. To be able to perform a transcript, both the audio and

visual content should be considered, and take into account the following

elements:

= Audio content.

Identification of speakers.
Content of the dialogues.
Audio events, such as music, laughter, applause and special effects.

All those audio elements that may be relevant to understand the

document.

= Visual content.

Description of actions.
Screenshots, images, diagrams, etc.
Description of people.

Description of expressions.
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Description of scenarios and locations.
Transcript of the text displayed on the screen.

All those visual elements that may be relevant to understand the

document.

4.1.2 Captions

Subtitling is adding a text at the bottom of a video at its same frequency. This

text improves accessibility of deaf and hearing impaired people, people who

speak another language and people with low literacy levels.

Using captions is very usual in audiovisual content, and it is necessary to follow

certain standards and accessibility best practices such as the following, which
have been taken from the international standard UNE 153020:2005 (Asociacion

Espafiola de Normalizacion y Certificacion, 2005):

= Captions will contain all audio information of the video: identification of

speakers, content of the dialogues and audio events such as music,

laughter, applause and special effects. All those audio elements that may

be relevant to understand the document or that provide information should

also be included.

= Captions should appear at the bottom of the screen occupying two lines or,

exceptionally, three. Different lines should be assigned for each character

and the text should be centered relative to the box.

= There are certain basic guidelines in the division of captions:

No separate words.

Separate long sentences as conjunctions.

The voice often marks the separations by pauses or inflections.
Separate lines or captions matching them with commas and dots.

Place three dots at the end of the caption and other three at the

beginning of the next.
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= Recommended speed by experienced professionals is set around 12
characters per second. In addition, captions’ understanding is improved with

a proper synchronization with the audio.
= There are some specific guidelines for captioning such as:

- Do not play abbreviations.

- Write numbers from zero to ten with letters, and the rest with Arabic

characters.
- ltis better to use parentheses than brackets.
- Use acronyms and short forms of Institutions or organizations.
- Avoid buzzwords.
- Use pronouns whenever possible.

- Use short forms of names of personalities and posts.

= Captions, insofar as possible, should be literal.

4.1.3 Audio description

Audio description is a tool useful for blind people or people with low vision. It is
the same that provides access to the visual aspects of theatre, media, visual art

and any activity where images are a critical element.

The UNE 153020 standard about auto description for people with visual
disabilities, published in Spain in 2005, defines auto description as "a support
system for communication, which consists of a set of technical and applied
skills in order to compensate for the lack of uptake of the visual part contained
in any kind of message, providing adequate audio information that explains or
translates, so that the visual impaired receptor can perceive the message as a
harmonious whole and in the most similar way to how a person who can see

perceives it".

The narration of the audio description is performed on an audio track different
to the audio track of the video, taking advantage of the spaces without dialogue

so as it does not interfere with the original audio of the video. In case there is
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not enough time between the dialogue to include the content of the audio

description, an extended audio description can be used (Sama Rojo &
Sevillano Asensio, 2012-b).

Audio description contains information on the following elements:

Description of actions.

Description of people.

Description of expressions.

Description of scenarios and locations.
Transcript of the text displayed on the screen.

All those visual elements relevant to understand the document.

The AENOR UNE 153020:2005 explains some requirements necessary to

audio-describe:

Analysis of the work: not all audiovisual works provide a good audio
description. Different criteria are analyzed on a first viewing, such as the
existence of "message gaps" to insert information, as well as saturation or
absence of this information and whether it is performed in the same

language than the audio information of the work.

Writing the screenplay: it is composed of information units included in the
"message gaps". For the screenplay is consistent, the standard says that
"The audio descriptor should consult the documentation about the
environment and the topic of the work". Thus, the information will fit to the
type of work and the needs of the public to which it is addressed. There are
also other characteristics to be taken into account, such as the plot of the

dramatic action, environments and plastic data.

Reviewing and correcting the screenplay: the necessary corrections made
will be helpful to adapt the screenplay to audio description standards. The
standard says that they should be reviewed by a person different from the
descriptor and including them into the final screenplay.
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= Speech: itis performed in the presence of the image described, and the
narrator is selected depending on the type of voice and the right tone for the
work, so that the voices are always clear to listeners. Also, avoid emotional

intonation, trying to make neutral phrases.

= Montage: in the mix, volumes, ambient effects and equalization with the

original soundtrack are equated.

It is important to use a clear and precise language and, if possible, use short
and easy to understand words. The narration should be placed in the message
gaps of the work, in order to not causing saturation of audio and information on

the spectator.

The objectivity of the information presented in the audio description is also
essential. A direct and simple description should be performed, trying to avoid
evaluations or interpretations of what is happening, which may distort what the

visual information conveys.

4.1.4 Interpretation in sign language

It is an activity of linguistic mediation that transmits a speech to a sign
language, which is composed of gesture-spatial expressions and visual
perception. By this interpretation, deaf people can communicate with the social
environment, either made by other deaf people or anyone who knows sign

language.

With verbal language, communication establishes a vocal-auditory channel,
and sign language does it by a gesture-visual-spatial channel. It is noteworthy
that in this language each person is assigned a unique and characteristic sign

to not have to spell his/her name on signs.

There are several laws and regulations that regulate and normalize the use of
the sign language. The requirements proposed by UNE 139804: 2007
(Asociacion Espanola de Normalizacion y Certificacion, 2007) standard are
detailed below, the same in which 37 requirements are established for such

use divided into several categories:
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General principles:

Linguistic sign language criteria defined by the everyday user community

should be applied, as well as those fixed or expressed through relevant

linguistic research results.

The person who makes signs should be a qualified person in sign
language.
The person who makes signs should participate in the preparation of

sign language material.

In any situation of interpretation, it is recommended to follow the codes

of conduct usually accepted in this field.

The signs should be adequate to the characteristics of the target

audience.

Appearance of the person who makes signs:

The clothing of the person who signs should have a high contrast with

his/her skin color.

The clothing of the person who signs should have a uniform color and

texture.
The clothing of the person who signs should not distort the silhouette.

The clothing of the person who signs should not contain elements that
highlight.

The person who signs should not wear jewelry or other ornaments.
The face of the person who signs should be free from unnecessary or

superfluous elements that diminish the perception of his/her facial

expression.

Staging and sign language uptake:

When having control over the background, it should maximize the

understanding of sign language.

The frame should be a medium scheme or a medium-long scheme.
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A good illumination of the face and body of the person who makes signs

without excess light should be guaranteed.

lllumination should avoid making shadows on the face of the person who

makes signs when his/her hands pass ahead of it.

[llumination should avoid making shadows in the background.

= Video characteristics with sign language:

The video should have 25 images per second minimum.

A resolution of 256 x 192 pixels should be used as minimum. A minimum

resolution of 352 x 288 is recommended.

In compression algorithms, video formats and video transmission
techniques, using standards or documents published by relevant

international organizations is recommended.

Compression algorithms, video formats and video transmission
techniques that allow playing on the most used platforms should be

selected.

A minimum bit rate suitable for the bandwidth of the target audience and

the type of transmission should be chosen.

Fitness for the use of values chosen of resolution, images per second,
bit rate and compression algorithm should be evaluated by tests

involving deaf people who use sign language.

If dissemination of video is used, facilities of the server should be
disabled for, when the connection quality degrades, automatically

decrease the frame rate of the video or prioritize the audio.

= Integrating sign language in web pages:

130

On websites, sign language should be offered in one of two ways:
- Embedded in a fixed area of a web page with additional content.
- Linked so that it can be played with the corresponding media player.

Users should be able to select a full-screen presentation of the content

with sign language, if possible with the technology used.
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- All content on a site that has been interpreted in sign language should

be accompanied by a representative icon of sign language.

- The same representative icon of sign language should be used in all

pages of the same website.

- The following representative icon of sign language is recommended to

be used.

- A page on the website should exist, which informs about the technical
details of contents in sign language, requirements on the users'
computers, requirements on their network connection and links to the

players needed.

- When a video with sign language is embedded, the user should be

offered the following controls, if permitted by the technology used:
- In scheduled or live broadcast: stop and play.
- In all other cases: stop, pause, play, rewind and forward.

- When a video with sign language is embedded and a timeout before

visualization occurs, the user should be informed about this process.

- When videos with sign language are offered to be downloaded, the user
should be informed about their size and estimated download times for

the most common types of connections.
- When videos with sign language are offered to be downloaded, each
video file should have a maximum duration of 2 minutes.
Incorporating alternatives to sign language:

- Adding voice and captions in sign language to the content is

recommended.
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- If captions are added, they should meet the standard UNE 153010, in all

applicable requirements for presentation in digital formats.

Using computer-generated sign language:

- When using computer-generated sign language, user testing should be
conducted with deaf people who use sign language to ensure their

suitability for use.

- Preparing content for computer-generated sign language should involve

qualified people in sign language.

4.1.5 Tools for creating accessible audiovisual content

For creating accessible educational content it is important to know the tools that

allow incorporating certain characteristics of accessibility to the resources.

Some of the tools are online, other desktop, some are free and some are for a

fee, i.e., there is a wide range of applications. Below are described the most

commonly used:

SMIL: developed by W3C. Multimedia presentations created by SMIL are
composed of audio, video, images and text elements, which are stored
separately and then dumped simultaneously when the presentation is
executed. It also allows enabling or disabling captions and audio

descriptions.

Synchronized Accessible Media Interchange (SAMI): a Microsoft

specification that allows incorporating captions to Windows Media Player.

Dragon naturally speaking: a speech recognition tool that generated

captions without exporting the text from a text editor.

Transcribe: a web tool that helps slowing the audio speech to transcribe it

more easily.

Universal subtitles: an open source collaborative web tool that allows

subtitling any video published in YouTube or Vimeo. It also allows users to


http://www.w3.org/AudioVideo
http://msdn.microsoft.com/en-us/library/ms971327.aspx
http://www.nuance.com/naturallyspeaking
http://transcribe.wreally.com/
http://universalsubtitles.org/
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include translations of captions, insert subtitled videos in web pages and

download captions in SRT format.

CaptionTube: a web application that allows creating and including captions
in YouTube videos. After importing a video, the user plays it and includes
the needed captions. Then, the captions can be exported to different
formats or publish them in YouTube. In section 2.6, this application is used

to add captions to a video.

YouTubeCC: a web application that allows creating captions for any

YouTube video, and also allows exporting it.

Overstream: a web tool that allows creating and synchronizing captions with
a video available in platforms such as YouTube, Vimeo, Google Video and

Myspace, among others, and storing it in the Overstream server.

Dotsub: a web application that allows creating, translating and including

captions in multiple languages in videos available on different platforms.

Aegisub: software that allows editing captions in different formats, and also
creating macros for easy editing. It has lots of options for personalizing
captions, such as color, typography, caption format, etc. Free license and it

can be used on Windows, OS X and UNIX platforms.

Subtitle workshop: a tool for creating, editing and transforming captions in
practically all existing formats, and performing several tasks related to

captions editing. Free license and it is available on Windows platforms.

Jubler: a tool for editing captions in text format. It allows creating new
captions or convert, edit and transform existing captions. It also allows
visualizing them in real time, checking spelling, translating them and editing
formats, among other features. Free license and it is available on Windows,
Linux and MacOs platforms.

MAGpie: a tool for creating captions and audio descriptions. Free license
and it is available on Windows platforms.
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= STAMP: a PowerPoint 2010 add-in that allows subtitling multimedia content

included in a PowerPoint presentation. Free license.

= FAB subtitler professional edition: one of the tools for professional subtitling.
There are several versions according to the needs of production: to produce
DVD, to live broadcast of subtitled TV programs, etc. Free license and it is

available on Windows platforms.

=  WInCAPS Qu4ntum: tool for creating captions in multiple formats and with
several options such as AutoTime for an automatic synchronization. Free

license and it is available on Windows platforms.

4.2 Creating accessible video tutorials

4.2.1 Video tutorials as educational content

The objective of video tutorials is reinforcing concepts and learning of certain
areas of knowledge that, by their nature, are very complex to learn with static
content such as books, tutorials, diagrams, etc. Currently the use of eLearning
platforms facilitates the use of this type of educational content, especially in

virtual education.

The idea is that teachers create short video tutorials, also called “training pills”
or “knowledge pills” (Maceiras, Cancela & Goyanes, 2010), which are small
pieces of educational content, created as learning objects of audio visual
content and designed to complement traditional training strategies and to
facilitate understanding of some aspects of the content that have greater

complexity or difficulty of understanding by students.

Some universities that offer their studies or that have released their content use
video tutorials to give a full explanation about the topics of the subjects. For
example, Massachusetts Institute of Technology (MIT) has released their
content, including audio visual content (called video lectures), through MIT
OpenCourseWare, which is the same that can be found in the MIT YouTube

channel and is based on recording of lectures.


http://office.microsoft.com/en-us/powerpoint-help/sub-%20titling-text-add-in-for-microsoft-powerpoint-stamp-HA102540315.aspx
http://www.fab-online.com/eng/subtitling/production/subtprod.htm
http://www.screensystems.tv/products/wincaps-subtitling-software
http://ocw.mit.edu/index.htm
http://ocw.mit.edu/index.htm
https://www.youtube.com/user/MIT
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Figure 4-1.  MIT YouTube channel.

In some cases, this type of video lectures meets the characteristics that a video
tutorial should have, but most of them do not meet the main characteristic,
which is the time duration of each video, due to most of them have a duration

over 30 minutes (Figure 4-2).

However, many of these video lectures have some accessibility characteristics
such as captions, annotations and translations, which allow users with

disabilities being able to use this content.

Another example of the use of video tutorials as educational content is that
applied in Universidad Nacional de Educacion a Distancia (UNED) of Spain.
They have created a number of audiovisual pills, oriented to complement
training of their students. In the website UNED Abierta (Figure 4-3) several
open source initiatives can be observed, such as COMA courses, OCW

courses, multimedia library, etc.
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MIT 18.S997 Introduction to MATLAB Programming Fall 2011

I - Massachusells
Institute of

Technology

18.5997, Fall 2011

Introduction to MATLAB
Programming

Yossi Farfoun

Lecture 1: Using MATLAB for the First Time

MITOPENCOURSEWARE
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Publicado el 14/02/2013
MIT 18.5997 Introduction to MATLAB F’rogrammlng FaII .'20‘1‘1
View the complete course: ocw.mit.edu/18-S99
Instructor: Yossi Farjoun

Mostrar mds

Figure 4-2.  Video lecture “Introduction to MATLAB Programming”, developed
by MIT OpenCourseWare, which meets some of the accessibility

characteristics.

COMA courses are of free access and use the same methodology as MOOCs
(Massive Online Open Course): massive courses, online and free. From the
start date, the content is uploaded, which consist of small video “pills”, after
which a small test can be put to ensure comprehension. Additionally there may
be a final exam with a greater number of questions. The courses can start and

finish when the students want.
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explicar multimedia explicar multimedia

Inicio Ayuda Sobre UNED Abierta

Figure 4-3. Open source initiative — UNED Abierta.

In most of the video tutorials created by UNED as educational content, several
accessibility characteristic are met. Among them, the duration of the videos is
within the recommended limits, they include captions and the presentation is

clear with tutor support.

La conjugacion del verbo en presente

Aleman para hispanohablantes: La conjugacion del verbo en pres...

UNEDcursoscoma - 1.432 videos 20.416

Figure 4-4. Video tutorial of the initiative UNED Courses COMA.
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4.2.2 Best practices for creating effective video tutorials

For creating video tutorials, the first thing to be considered is the quality content

provided to learning. For this, some mistakes are usually committed, which do

not guarantee that the video tutorial that is being created contributes to

students. Among the most common mistakes we can mention the following:

Creating video tutorials with duration of more than 30 minutes is not
advisable because students usually do not visualize them completely due to
their long duration. Thus, the recommended duration for video tutorials is
between 10 and 15 minutes maximum, explaining clearly and specifically

the subject to be learnt.

Recording video tutorials with background music is a common mistake. This

is not recommendable because it can interrupt the teacher’s explanation.

Having many movements in the video tutorial, for example, moving
excessively the mouse and opening, maximizing, minimizing or closing
windows may cause the users pay more attention to the movements on the

screen than to the explanation in the video tutorial.

At the time of recording, pop-ups should not appear, either of some instant
messaging application or Internet windows, as this may distract people who

are viewing the video tutorial.

Sometimes as part of the video tutorial we need to enter our desktop
computer, but it is usually disordered: it is advisable to leave only the icons

needed.

To achieve the expected results, do not try to teach more than one thing per
video tutorial. Users need to perform previous tasks, and this requires

knowledge and practice.

Once the most common mistakes are reviewed, the best practices to ensure a

successful creation of quality video tutorials are listed below:

First of all it is advisable to follow a process of creation, which carries to

some specific steps that ensure a better quality of a video tutorial:
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- Planning: before start creating a video tutorial, clarify what you want to

explain or transmit with it. The following questions could be asked:

What is the topic to be used?
What do we want to achieve with the creation of the video tutorial?
Will we improve learning by using this educational content?

Who is it for?

Once the answers to these questions are clear, we can continue with

the creation process.

- Preparing material: before starting recording the video tutorial, it is

necessary to know the materials that will be needed, such as images,

videos and chiefly what we are going to tell during this time. For this, it is

very important preparing a screenplay, which will contain everything we

will do since we start the explanation of the subject until its completion.

The following structure is recommended to be followed when creating a

screenplay:

Topic and greeting: the topic should be clear enough so users can
know from the beginning whether it is what they are looking for. A
greeting and a brief introduction to the subject are also needed in

this first part.

Video tutorial objectives: the main objective to be achieved by those

who see the video tutorial is specified in this part.

Video tutorial content: the content selected for the video tutorial
should be specific, since the aim of the video tutorial is clarifying or
strengthening a subject, not creating more confusion. This requires
that the content is as an explanatory guide where all that users have
to know is explained step by step. A clear language has to be used,

without ambiguities.

Conclusion and data: when the video tutorial is finished, it is
recommendable to give some conclusions about the subject or a

summary with the key points. It is also advisable to present the
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contact details (e-mail, blog, web page, twitter account, etc.) for

comments or questions about it.

- Recording: to start the recording of a video tutorial, firstly a tool has
to be selected from those that allow recording both video and voice.
The following section describes some tools that are specifically

designed to create video tutorials.

- Editing: once the video tutorial is recorded, the same or another
video editing tool can be used to add texts, arrows, images, audio,
zooming, etc. But it is advisable to try to do all these innovations

while recording the video tutorial.

- Publishing: when the video tutorial is ready, it will be then published
in our web site, in our YouTube account, etc. The idea is that after
our hard work, this educational content serves to all those who need
some explanations about this subject, so it is advisable to publish it

in collaborative access and free license sites.

Create short video tutorials, which can be published on a public website of

videos, such as YouTube, or in an institutional channel.

When creating video tutorials, also consider that they can be visualized on
mobile devices such as phones, iPads and tablets, which is an important

added value when used as an educational material.

Check the image quality obtained in each video tutorial, in order that they

can be visualized in full-screen mode.

Prepare the content as a presentation, with the items being highlighted and
guiding the subject being explained, so the static material will become a

dynamic one.

Speak clearly and concisely, so as to be heard clearly. Avoid stammer and

very long pauses.
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Be sure that the technical equipment to be used is in the best condition. If a

video tutorial is created and the audio is not good, it will not do much. So it

is advisable to use a good microphone and a good screen resolution.

Video tutorials should meet some accessibility characteristics (Sama Rojo &

Sevillano Asensio, 2012-b) such as those previously studied: transcript,

audio description, captions, sign language interpretation and others needed

based on the target audience. Depending on the type of material, certain

characteristics should be included, such as:

Video-only content: this kind of content is only composed of video, with
no events or audio content. To ensure the accessibility of this type of

content, two accessibility measures should be combined:
- A transcript.
- An audio description.

In this case it is common to create a description of the video content as a
transcript in text format. The following information should be included:
description of actions, people, expressions, scenarios and locations,
transcribe the text displayed on the screen or read it aloud, if an

alternative in audio format is being performed.

Video with sound documents: documents that contain video with sound
require a greater number of measures to be accessible because they
contain both visual and audio information. In this type of material the

following can be observed:

- If they will be broadcasted live or in recorded format, the content
should be subtitled. Interpretation in sign language is also very

common, although this option is not required by the standard.

- If the document will be broadcasted in recorded format, the following
measures should be met depending on the level of accessibility that

we need to ensure: captions, transcript and audio description.
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4.2.3 Basics of video editing

According to Wikipedia, video editing is the process of manipulating video

images. They can be created from videos, photographs, graphs or animations.

In most cases, audio is also included, which can be music or the characters’

dialogue, but there is also a kind of editing where audio is not used and only

visual media is used.

The basic concepts and tools used to create and edit videos are:

Clip: a piece of audio or video in motion.

Credits: references to everyone who took part or influenced the creation of
an audiovisual project. They are generally included at the beginning and at

the end of the video.

Digital edition: it consists of manipulating, using a video editing application,
media such as video files, photos, graphs or animations, and audio. Once

the project is created, rendering or recording are performed, thus obtaining
the final video, usually generated with MP4, AVI, MPEG2, WMV and MOV

formats, among others.

Frame: the smallest unit of a video. It is composed of one photo or still
image. The videos generally consist of 25 frames per second; but cinema
movies have 24. In videos with lower quality (or sometimes to create

interesting effects), the number may decrease.

Track: the channel where a clip can be included. It can be audio or video.

You can include as many as you want in order to edit and mix resources.

Pixel: abbreviation for “Picture cell”. It is a sample of the image information.
It is the smallest of a television picture element. The more pixels in an

image, the higher the resolution.

Rendering: computer process for creating tasks to generate a special effect,

animation or editing effects.
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= To trim: process that involves removing parts of a clip, which should not
appear in a project without removing them from the originally recorded

material. To trim, just adjust the start and end points of a clip.

= Resolution: the number of lines and pixels that make up a video image. The
higher the number of lines or pixels, the sharper and more detailed the

image is.

= Stop motion: animation generated frame by frame, i.e., still images or

photos are taken and then mounted so that they build a story.

= Storyboard: before filming or editing a film, a series of drawings are made
by cartoons similar to comics, in order to have a very rough guide about

how each decision will be made and how the different pieces are joined.

= Transitions: they may be audio or video transitions. It is the way in which
two different clips are hitched. The two most used and basic are “shear” or

“melt”.

4.2.3.1 Tools for creating and editing video tutorials

Nowadays there are several software applications used to create and edit

video. The most used tools are presented below.

= CamsStudio is an (open source) application that records the screen and
audio on a computer and creates a standard AVI video file or a Streaming

Flash (SWF) video. Available for Windows systems.

= Jing allows taking screenshots and saving them as video. Text boxes,
arrows or rectangles can be added to highlight certain points. Audio can be
recorded along with the video using a microphone. The results generated
can be sent by Screencast.com, Flickr, a FTP account, Twitter, etc.
Available for Windows and Mac OS X.

= Webinaria is an open source application to create screencasts. Available for

Windows systems.
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=  Wink allows creating tutorials and presentations that capture the screen,
and also allows adding text boxes, buttons, titles, etc. It supports EXE,

FLV, HTML, etc. as output files. Available for Windows and Linux.

= UltraVNC screen recorder is a screen recorder based on CamStudio. It

allows saving audio and screen captures. Available for Windows.

=  Windows media encoder allows capturing audio and high quality video with

high definition multi-channel audio. Available for Windows.

= BB FlashBack express allows recording from a video source, screen and
audio. It supports AVI or FLV files and also supports direct upload to known

video sharing sites. Available for Windows.

= CaptureFox (Firefox add-on) is a Firefox add-in that can record the screen
frame by frame to create tutorials. It also allows recording audio. Available

for all operating systems.

= Krut is a Java application (it Works on many platforms) that allows creating
screencasts. It saves movie files of selected parts of the screen in

QuickTime MOV format, including sound.

= FileLab is a video editor in the cloud that allows basic video editing, but has
a very simple and intuitive interface, quite similar to Sony Vegas’, where the
videos in which we are working can be seen. A 1 MB plug-in has to be

downloaded before using it.

= VirtualDub is a free capturing/edition video software. It works only with AVI

files, so this format has to be used to create a video with this application.

4.2.4 Creating video tutorials by capturing screen actions

In this section, a simple way to create video tutorials is explained. During the
creation process, images or screenshots may not receive the importance they
deserve, and also the actions performed in the computer, i.e., capturing the

actions on the screen or screencast.
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A screencast is a digital recording of the screen output and sometimes has
audio narration. In terms of teaching, educational content can be created by
explaining the functionality of certain tools, data management, browsing

websites, etc.

As mentioned in the previous section, there are different tools to capture screen
actions. Of these, the free tool QuickTime Player has been selected. To explain
how to create video tutorials using this tool, a mini video tutorial about how to
navigate a search open educational content website is showed, with the

following steps:

= Firstly, run QuickTime Player (if it is not installed, download and install it).

® QuickTime PlayermEdicién Visualizacion Compartir Ventana Ayuda

Nueva grabacion de pelicula 3N

Nueva grabacion de audio  ~C#N
Nueva grabacion de pantalla ~3N

Abrir archivo... %0
Abrir URL... ®U
Abrir recientes »

Figure 4-5. Creating video by capturing screen actions with QuickTime.

Select the type of recording to be performed:
- Film recording: including audio and video.
- Audio recording: audio only.

- Screen recording: the actions performed on the screen are recorded, but

it does not include audio.

In this case, select the screen recording option to capture all the actions
we perform. Before you click on the option to record, what we want to
capture has to be ready. In this example, the website is previously ready

to start navigating and recording the actions that will be performed.
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® QuickTime Player Archivo Edicion Visualizacién Compartir

Ventana Ayuda
000 Serendipity
Vo Serendipity (+1
L i Bl @ | @ serendipity.utpl.edu.ec ¢ | (B~ Google Q) ¥ A |B-
(] Mis visitados ~ | | Comenzarausa.. @ Apple ! Yahoo! ¥ Google Maps (3 YouTube [ | Wikipedia [] News > [ Popular~
| * @ Recently Bookmarked + [) Virtuoso SPARQ.. [ | NeOnwWiki [ SparqlEndpoints . [ W3C RDF Validat . ff; IHMC CmapTool.. [ | RDF Validatora.. [ } Startinga Projec.. [ ] GitReference . How do you clon

& & & Grabacién de pantalla

o

Serendipity

Linked OpenCourseWare Data Faceted Search

Figure 4-6.  Starting recording the actions on the screen with QuickTime.

= When clicking the “Record” button, a warning message will be showed.
® QuickTime Player Archivo Edicion Visualizacion Compartir  Ventana Ayuda C_' Dctﬂ-m'grahatéb
000 Serandipity
J:: Serendipity " + |

P

[E5] Més visitados = [ | Comenzar a usa...

- | Bl B | @ serendipity.utpl.edu.ec

c (@
@ Apple ! Yahoo! °® GoogleMaps W3 YouTube [ ! Wikipedia [] News ~ [] Popular =
hj ~ (A Recently Bookmarked + ) Virtuoso SPARQ...

ff; IHMC CmapTool... | | RDF Validatora... |

:: NeOn Wiki m SparglEndpoints...

LE w3c RDF validat...

& & Grabacién de pantalla

iSequro gque desea comenzar la grabacién de la pantalla?

Esta ventana se ccultard durante la grabacion, de medo que no se obstruya
el resto de la pantalla.

Una vez iniciada la grabacién, puede detenerla asi:

= Hacer clic M Detener grabacién en la barra de mends. Mostrarme

+ Pulsar Comando + Contral + Esc

( Cancelar ) Elni:iargrabaciﬁnj

Serendipity

Linked OpenCourseWare Data Faceted Search

Figure 4-7. Warning message while recording the actions on the screen with
QuickTime.

Click the “Start recording” option and it will automatically start recording

what you are doing on the screen. In addition, at the top of the screen the
button to “Stop recording” will be enabled.
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® Firefox Archivo Editar Ver Historial Delicious Marcadores Herramientas Ventana Ayuda ¢~ B Desener grabacion 3

800 Serendipity
jo Serendipicy ee
wi" @R

Carandinit

Figure 4-8. Recording the actions on the screen with QuickTime: button to

stop recording

= When everything planned for the video tutorial has been captured, select

the “Stop recording” option, and then the recording done will be displayed.

= Finally, select option “File > Save as”. In the window that appears, enter a

name for the video tutorial and the location where the file will be saved.

® QuickTime Player Edicion  Visualizaciéon Compartir Ventana
Nueva grabacion de pelicula X 3N —
—~ Nueva grabacién de audio "~ 8N
a4 - ~
| T Nueva grabacién de pantalla N
L | Abrir archivo... ¥0
>
CriadElE S R 32U
(] Més visitados = [ ' €o  Abrir recientes p lgleMaps @3 You
| .j * (J Recently Boukmitj Cerrar spW rqlEndpoints...
Guardar como... 385
Guardar para web... 4+ 38E

Volver a la versién guardada

Figure 4-9. Selecting option “Save as...” to save the video file obtained from

capturing screen actions with QuickTime.
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® QuickTime Player Archivo Edicién Visualizacion Compartir  Ventana Ayuda

B Grabacién de pantalla 3.mov

mn Serendipity 1 @ Grabacién de pantalla 3.mov | E}
] =] serendipity.utpl.edu.ec I i _ B~ coogle
b 1 ([« ») (22 = b (@ Peliculas & @
(@) Mas visitados ~ | | Comenzarausa.. @ Apple ! Yahoo! 1
] * @ Recently Bookmarked + [D Virtuoso SPARQ... [ | NeOn Wiki | 7 DISPOSITIVOS m (3 Buscador ! m .. 1 startingaP
'\ 7| pandora * Buscador...pityl.mov
EiDisk “ Busqueda...ipity.mov
(] Camtasia...ecordings '
UBICACIONES - [ Dataviz r2
a v
[ Dropbox + | ] Datavizl L
Format A )
iPhone (mavil)
iPhone
iPod
Apple TV
L [ Ocultar extensién | Ordenador D

HD 480p =
HD 720p
HD 1080p

Linked OpenCourseWare Data Faceted Search

00:00:00 # -00:02:04

Figure 4-10. Format types that QuickTime supports to save the video tutorial.

= Another option that can be chosen to save the video is “Save for web...”,
which allows exporting the file to optimized versions for web distribution, to

iPhone and desktop.

# QuickTime Player Edicion Visualizacion Compartir Ventana Ayuda
Nueva grabacion de pelicula “C3#N & Grabacion de pantalla 3.mov

Nueva grabacién de audio  ~ 3N Serendipity
Nueva grabacién de pantalla  ~%N

L Serendipity
| & ' Abrir archivo... ®¥0 |
<4 B $ s .
WRIE® (& o irurL.. 28U -
(8] Mas visitados ~ [ | €0 Abyrir recientes p tgleMaps @ YouTube | | Wikipedia [T News = [ Populi
.j ~ (@ Recently Bookmarke Cerrar s8W SparqlEndpaints... m W3C RDF Validat.., ¢y IHMC CmapTool
Guardar como... {+38S

Guardar para web... 4 %E

Volver a la version guardada

Figure 4-11. Selecting option “Save for web...” in QuickTime.
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® QuickTime Player Archivo Edicion Visualizacion Compartir  Ventana Ayuda

e é B Grabacion de pantalla 3.mov

Exporte versiones de su pelicula optimizadas para su distribucién
Serendipity L+l | web a un iPhone y al escritorio.

'l e & serendipity.utpl.edu.ec | Cree una pelicula de referencia gue seleccione automdticamente la mejor version :- E
= <+ para el dispositivo y el tipo de conexién a Internet, B
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[_liPhone (mavil)
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H.264, 5 Mbit/s de velocidad de datos maxima

( Cancelar )
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Linked OpenCourseWare Data Faceted Search

00:00:00 # -00:02:04

Figure 4-12. Selecting formats in QuickTime for web distribution.

= Most tools for capturing actions allow editing the recording. In this case, in

QuickTime the recording time can be shortened according to what needed.

® QuickTime Player Archivo Visualizacion Compartir Ventana Ayuda
Deshacer %7

Rehacer {r 38
| Serendipity Cortar #X B
1 & | opiar 2
<4 ml Bl M | 9D serendipity.ut Copiz rc
j regar dbV
Mas visitados ~ | ' Comenzaraus| [|iminar (] wiki
m] * @ Recently Bookmarked - [ vir >eleccionar todo #A  wac RDOF'
|  Seleccionar todo excepto los silencios  {r38A

Acortar... ®BT

Caracteres especiales...

Figure 4-13. Editing video using QuickTime.
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Figure 4-14. Editing video using option of limiting in QuickTime.

= The video tutorial is now ready, in a quickly and optimally way. As a final
step, publication in an open format and in a free website or repository is

advisable.

4.2.5 Using YouTube as a platform to publish, edit and subtitle

videos

YouTube is a website that originally allowed searching and sharing videos for
free, but it has now become a large-scale social network with new features,
among which are the ability to publish and edit videos, add audio, annotations
and captions. Below are explained these features and their contribution for

creating accessible videos.

4.2.51 Publishing videos

= To publish videos in YouTube, first a personal account on the website has
to be created. Once created, you will have your own channel, where you
can upload videos, save favorite videos, access to the history of searches,

create playlists, etc.
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A video can be added to the channel selecting “Upload”. You can create

videos using a webcam, a slides presentation or live Google+ hangouts.

D3 Upload - YouTube

<« C https://www.youtube.com/upload

You R Q upions

* Did you know you can set defaults for future uploads?

Select files to upload
Or drag and drop video files

Public -

HELP AND SUGGESTIONS

Figure 4-15. Options to create a video.

If you have a video ready, select option “Select files to upload”, select the
video from its location and enter the information required to be published. It
is important to verify that one of the following formats is used: .mov,
.mpeg4, .avi, .wmv, .mpegps, .flv, 3GPP, WebM.

Once the video is uploaded to the channel, it can be customized with
descriptions, tags or categories, and it can be edited or include annotations,
audio and captions.
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' PFeY
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- - -
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<« C https://www.youtube.com/upload Lol =
Youl[l Q Upload

* Did you know you can set defaults for future uploads?

Publish when ready

UPLOADING 49% Yourvideo will be kept private unti
Publish. Take your time entering y

ﬂ Your video is still uploading. Plea;  and publish when ready.

Basic info Advanced settings

Cicerone EspanaDirecto
Upload status:

Description

hitp:/fyoutu e KmCxh7oSha

Suggested tags:

+Cicerone

Figure 4-16. Selecting the option to upload a video.

4.2.5.2 Incorporating improvements
YouTube offers the following options:

= Enhancements, by which “Quick arrangements” can be made, such as
trimming video (the start or the end), rotating, image stabilization (if the
recording is very moving) or changing lighting, contrast, saturation and color

temperature.

= Automatic correction, which automatically corrects color and lighting,

according to the YouTube parameters.

= Effects, which allows changing the appearance of the video: black and
white, sepia, cartoon style, etc. To test it, click on a filter and see how it is

applied to the image.
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Figure 4-17. Adding improvements to a video using YouTube.

4.2.5.3 Incorporating audio

= The “Audio” option allows selecting a music track ideal for a video from a list

of music tracks.

= To save all changes made to the original video, select the option “Save” and
all effects will be saved for the video, or select “Save as” to create a copy of

the video with all the effects applied.

D 1 of 1 uploaded - YouTub x / I8 VouTube x \

€« C | @ httpsy /www.youtube.com/audio?v=EVb03DL32ig

YoulILi[ qQ Upload | g5+ | eon

Xeon30k /" Infoand Settings /" Enhancements & Audio W Annotations Captions -
DASHBOARD
VIDEO MANAGER IP eDiscovery 2013 (2) LS ﬂ
N
Live Events
wa Featured Tracks T
Playlists
Tags Venice Beach
Copyright Notices
Two St
Search History P
Lies - Garage
IP E-Discovery
o 2 & o Moth
COMMUNITY M e-Discovery: detectives in the digital age
Blue Danube (by
CHANNEL SETTINGS v strauss
AALYTICS . (Un)official video Grassy Hil
Strange Ways
CREATION TOOLS v

World Wap

Send feedback

AWalk Into Space

Figure 4-18. Incorporating audio to a video using YouTube.
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4.2.5.4 Incorporating annotations

= Annotations allow adding layers of text, links and active zones to a video,
which improves experience of videos by adding information, and interaction

and participation options.

= Once the video is uploaded, to create annotations go to menu “Video

manager - Edit > Add annotations”.

= The following annotations are allowed: speech bubble, note, title, spotlight

and label.

= Once the annotations desired are created, click “Publish” to display the

changes.

D1 of 1 uploaded - YouTub: x /' (O VouTube

<« C | 8 https//www.youtube.com/my_videos_annotate?v=EVb03DL32ig

A (11| Tube qQ Upload |~ T1-  Xeon380k

Kean3sik / Info and Settings #" Enhancemen ts & Audio B Annotations Captions “

DASHBOARD
VIDED MANAGER IP eDiscovery 2013 (2)

Live Events
+ Add annotation ¥
Playlists

Tags M Speech bubble

B o ion -
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Figure 4-19. Create annotations in a video using YouTube.

4.2.5.5 Incorporating captions and video transcripts

YouTube allows adding captions to a video using captions file, which contains
the text and information about the moment in which each line of text should

appear.

Similarly a transcript can be added to the video, which contains everything said

in the video and which is independent of the playback time of the video. If the
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video is in English, YouTube can use speech recognition algorithms to

determine the moment in which the words of the transcript should appear.

To add captions to a video, first you should have the file containing the captions

or transcript. Then, log in the YouTube account and do the following:

= In the username click option “Video manager” and the videos you uploaded

will appear, or you can upload or create a new video.

D3 1 of 1 uploaded - YouTuk % | (0 VouTube * — - P —  —

€« C | B https://www.youtube.com/timedtext?action_view=18v=EVb03DL32ig

Ynll':' Q Upload £~ | Xeon380k

Aeon360k # Infoand Settings #" Enhancemen its & Audio W annotations Captions “

DASHBOARD

VIDEO MANAGER IP eDiscovery 2013 (2)

Live Evenis

== Add captions >

Captions and subtitles help more people enjoy your videos.
Learn more

Flaylists
Tags

Copyright Hotices
Search History

Likes

COMMUNITY v
CHANNEL SETTINGS v
ANALYTICS v

CREATION TOOLS v

Send feedback

Figure 4-20. Adding captions to a video using YouTube.

= Select option “Edit” in the video and then the “Captions” option in the drop

down menu.

= Some options are displayed on the right side of the video. Click the “Add
new captions or transcript” button and then the button “Browse” to locate

and select the file containing the captions.

= Select a captions file or a transcript. If a transcript is to be uploaded, select
“Transcript file”; otherwise select “Captions file”. File types that can be

uploaded are *.sbv, *.sub and *.srt.

= Select the appropriate language, assign it a track name and finally click the

“Upload file” button.
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4.2.5.6 Configuring captions

= A video containing captions has the icon at its bottom right, and when

pressed, the options that can be performed are displayed.

ec .00 Introduction to Computer Science and Programming, Fal - YouTube
806 Lec 1 | MIT 6.00 Introduction to Computer Sci d P iing, Fall 2008 - YouTub
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()2 a8 (@ o compscnry= oLt atesare=c—overenpiay ot~ =T L8 T Wigw & (@ coose Q) @ [=]
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s visitados c le ©f yahoot ¥ I o be kipedi I ad
]~ ( Recently Bookmarked ~ ) Virtuoso SPARQ... { i NeOnWiki |4 SparglEndpeints... | W3CRDF Validat... ¢l IHMC CmapTool.. { | RDF Validatora.. { | StartingaProjec.. [ ! GitReference ., How deyouclon.. 2>
oD p— ]

Videcs populares 2120 =)

| | Lec 1] MIT 6.00 Introduction to Computer
» ._ Scien...
= de MIT

Lec 1 8.01 Physics I: Classical Mechanics,
Fa..

Lec 1| MIT 18.06 Linear Algebra, Spring 2005

[l -r*l Introduction | MIT 8.01 Classical Mechanics,
= Fa...
Ty
Walter Lewin Promo

Lec 1| MIT 8.02 Electricity and Magnetism,
= Spr..

Lec1|MIT6.001 jon to Computer Science and Programmi... Siguiante vidoo de MIT 6.00 nro to Computer Scienca & Progeamming,

Bl Lec 2 | MIT 6.00 Introduction to Computer
Science and Prog:

MIT - 2773 vidsos 1.495.183 rogramming, Fall 2008
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n
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Inglés B
2:44  in tackling technical problems, DESTACADOS
2:47__So that you will come away with a sense of what you can do, ] - 1:49

Figure 4-21. Configuring captions in a video using YouTube: captions menu.

= The available options are the following:

- Configuration: in this option some changes about visualization of
captions in the video can be performed, such as font type, font color,

background color, etc.

- The “Captions translation” option is also available to do it in other

languages, depending on the original one.

- Finally, an option to “Disable captions” is also available.

= Captions are only available in videos where the owner added them and in

some videos where YouTube provides them automatically.

= If a video contains captions, they can be enabled using the captions icon
that appears at the bottom of the video. This icon may look different

depending on where you are.
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= To change the captions language, click the captions icon. If the language
desired is not displayed, you can try with captions translated automatically

with Google Translate.

= To enable captions automatically translated, click the captions icon and

select “Translate captions”, select the language and press “Accept”.

= To always show or hide captions, access to the “Account settings”
webpage, select “Play” in the left menu and check or uncheck option “Show

captions always”.

= To disable them, click the captions icon and then select “Disable captions”.

Lec 1| 8.01 Physics I: Classical Mechanics, Fall 1999

Figure 4-22. Configuring captions in a video using YouTube: captions

configuration option.

4.2.5.7 Display transcripts

= To display the transcripts of a video, click the transcript icon that appears
below the video player. The transcript will move to show the current text
while the video is being played.
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= You can also click on any line of the text to go to that part of the video.

CIalE) Lec 1 | MIT 6.00 Introduction to Computer Science and Programming, Fall 2008 - YouTube

|/ D Lec 1] MIT 6.00 Introduction ta Ll

@nﬂi. v Youtube.com watch ™ 4gXkLMBleat ‘ ext= 141t M_Wigw c J(B- Gooas (&[] [¢]]
(5] Mis visitados = | Comenzarausa.. @ Apple ©f Yahoo! } Google Maps @ YouTube [ | Wikipedia [ News = [ Popular ~ I3 Marcadores -
] " (3 Recently Bookmarked * 1) Virtuoso SPARQL. | ! NeOn Wiki 4] SparqlEndpoints.. i) W3C RDF validat.. gy IHMC CmapTool.. | | RDF Validatora.. | Startinga Projec. | | GitReference ., Howdoyoudion.

Youl D) a o =
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-
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wr
[mn—" (e Rl

Figure 4-23. Showing the transcript of a video using YouTube.

4.3 Educational content with accessible audio

In this section, the accessibility issues that educational content comprising
documents with audio may have are studied, and also how to solve them and

make them accessible.

Documents with audio are those where an audio recording is contained,
performed using a microphone or any other recording medium and that can be
played on a device provided with the means. The audio collected may be

human or synthesized voices, sounds, music, etc.

Since the purpose of this workshop is creating accessible educational content
used in virtual training, only documents with audio recorded in a digital way will

be taken into account, thus excluding analog recording such as tapes.

4.3.1 Using audio elements in learning

Including audio educational content in training can be a valuable motivator for

students, e.g. by an original recording of the poet who is being studied, a
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conference of an important person in a certain subject, or a radio podcast with

an interview about the subject that is being studied.

The sense of hearing allows perceiving and communicating with the world. An
important part of learning occurs through this sense. For people with visual
disabilities, screen readers and appropriate descriptions of the images that
appear in an educational content may eventually replace the absence of visual
information. For people with hearing disabilities, adding accessible audio
educational content involves providing valid alternatives, such as a text that

contains the full content of the locution included in the audio document.

Although teachers can find educational audio content in learning objects
repositories, radio, television, etc. to include it into their course material, the
current digital technology allows recording and creating their own audio
resources. Although probably they do not reach the quality of a professional
recording, it is possible to create audio files with the ideal characteristics for the

purpose they serve: learning of their students.

4.3.2 Audiobooks as accessible educational content

The main elements for learning a subject have traditionally been paper books;
but with the advent of computers, digital books began to appear. More recently,
with the emergence of reading devices with smaller screens, such as tablets
and e-book readers, other e-book formats have become popular, and mainly
EPUB, which is an open source format in which the content is adapted to

different screen sizes of readers.

Another way that books have taken is recording the text read by an announcer
or a team of performers who lend their voice to the characters that appear in
the text. The books read could be broadcasted by a radio station and reach
people who were not able to read, because they had visual disabilities or

because they could not read.

Digital voice recording and the ability to save audio in easily distributable files
through the Internet have allowed the proliferation of audiobook repositories, in

which the main works of literature can be found, ready to be listened.
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Interestingly, the creation of audiobooks is not directed only to minimize
accessibility issues, but to an audience (especially young) who usually carry a
playback device with headphones, which allow listening to music but also

audiobooks, anywhere and anytime.

Therefore, the advantages obtained when using audiobooks as accessible

learning content are:

= |t allows students to access the content through the sense of hearing,

anytime and anywhere.

= |t provides an accessible alternative to textual content for people with visual

disabilities.
= People with hearing disabilities can use the textual version of audiobooks.

Leading universities in e-learning provide all written content in audiobooks
format, downloadable both in MP3 and DAISY formats.

Logically, when the content of a course is accessible, both the audiobook and
the text of the book should be available, because otherwise people with visual

or hearing disabilities may not be able to access to it.

Teachers of creators of educational content may not find the audiobook desired
on the Internet to include it to their course materials, but the current technology
allows creating your own audiobooks and therefore convert written educational
content into audio educational content. To do this, only a computer, a headset
and a microphone are needed. Installing Audacity is recommended for

recording and editing.

Audacity is a free and open source application, which can be installed on
Windows, Mac or Linux. It is developed by a team of volunteers and distributed

under GNU general public license. Its main features are:
= Recording:
- Recording voice from microphone.

- Recording from multiple input devices, mixing sounds.
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- Mixing tracks. For example, to make sound a background music in a

speech.
- Correction of volume levels during recording.
- Import and export:
Import and export WAV, AUIFF, AU, FLAC and OGG audio files.
- Import MPEG audio (including MP2 and MP3 files).
- Export MP3 files with the optional LAME encoder library.
- Import audio from video files.
Sound quality:
- Supports 16-bit, 24-bit and 32-bit samples.

- Sample rates and formats are converted using high-quality resampling

and dithering.

- Mix tracks with different rates or formats, allowing recording them into

one file.
Audio editing:
- Easy editing with Cut, Copy, Paste and Delete.
- Unlimited sequential Undo (and Redo) to go back any number of steps.
- Edit and mix large numbers of tracks.
- Remove static or other constant background noises.
- Set the volume to produce normalized files.
Accessibility:
- The application can be used with keyboard shortcuts.

- Excellent support for JAWS, NVDA and other screen readers.
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Audacity can be downloaded from the official website. For getting output files
with MP3 format, download and install the optional library LAME, available on
the official LAME library website, as described in the installation manual of

Audacity plugins.

The Audacity Graphical User Interface (GUI) shows sounds as graphs in each

of the stereo channels.
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: ﬁ_?...- FAER [L]
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Figure 4-24. Audacity graphical interface.

For example, a sound could be recorded using a microphone and then add a

piece of an audio file, and finally export it as an MP3 file.

In this way, new audio educational content can be created to be an alternative
to the textual educational content, thus providing accessibility to students with
visual disabilities and making them more attractive to students who usually

carry an MP3 player.


http://audacity.sourceforge.net/download/
http://lame1.buanzo.com.ar/
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Figure 4-25. Saving as MP3 file an audio edited.

4.3.3 Creating audiobooks from Word documents

It is usually desirable hearing a voice which changes intonation according to
the speech or emotions that the book transmits when listening to an audiobook,
but this is not always possible because it should have been created in a
professional studio. It is also not feasible (due to the large time required) that

teachers record with their own voice all the class notes.

An alternative to this problem consists of recording the text using an application
that recognizes the words and sentences of the text and, through a voice

synthesizer, records them into an audio file.

Logically, the resulting speech will not have the emotional elements of an
audiobook read and recorded by a person. In addition, the synthesizer should
have into account the pronunciation of the text language because otherwise the

result should be hardly intelligible.

Microsoft Word is one of the most used office software to create content by
teachers, so in this section how to create an audiobook from a doc or docx

document is explained.
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To do this, the doc or docx file has to be saved in a special format for creating
audiobooks, which allows subsequently be converted into an audio file using a

voice synthesizer. This format is DAISY.

DAISY is the standard format for audiobooks and other audible texts. This
format allows converting documents ready to be printed into audio documents,
and is especially designed for people with visual disabilities or dyslexia. It is
based on XML and MP3 formats and provides some additional features to an
audiobook, such as searching, placing bookmarks or controlling the reading

speed without distorting the voice.

Accessibility for tables and references is also provided, and has six levels of
navigation, including embedded objects such as images, graphs or

mathematical formulae in MathML.

DAISY is supported by a consortium created in 1996, consisting of international
organizations dedicated to develop aids for disabilities and recognized by the
NISO (National Information Standards Organization) as the official

maintenance agency of the DAISY/NISO standard.

4.3.3.1 Installing the DAISY add-in in Microsoft Word 2010

DAISY is installed as a Microsoft Word add-in (plugin). First the translator to
DAISY XML format has to be downloaded from the sourceforge website. When
the file “Daisylnstaller_x86.exe” is downloaded, run it and follow the

instructions.

Once it is installed, a new options menu appears in the menu bar of Microsoft
Word (Figure 4-27).

In this options menu, the option “SaveAsDAISY” is included (Figure 4-28).

The file can be saved as DAISY XML, which contains the text but not the voice;
or as Full DAISY, which shows the only option called “Narrator-DtbookToDaisy”
and which converts the document into the final DTB (DAISY Digital Talking

Book) format and includes the mp3 file with the speech of the text, using the


http://sourceforge.net/projects/openxml-daisy/
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default voice installed in Windows. These two options are also available to

translate various DOCX simultaneously.

i ™
ﬁ Daisy Translator Addin version 2.5.5.1 Setup - u

Welcome to the Daisy Translator Addin
version 2.5.5.1 Setup Wizard

| The Setup Wizard will install Daisy Translator Addin version
2.5.5.1 on your computer. Click Next to continue or Cancel to
a_‘ exit the Setup Wizard.
‘Dﬂé‘msny
| —
|
m !

Back

Cancel |

Figure 4-26. DAISY add-in installation dialogue.
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SavehsDAISY Mark As Manage Acronyms | Validate Import AddFootnote | Language Settings Help
~ Abbreviation Abbreviation T T
Sawe As DAISY Abbreviations Validate | DAISY Sty...| AddFootnote | Language | DAISY Sett...
E) Security Warning  Macros have been disabled. Enable Content x
EI-II-|-1:|-1-:-3-|:4 s 6171 B9 1 011131 13 [

Figure 4-27. New options menu in Microsoft Word: “Accessibility”.
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Figure 4-28. Options to save as DAISY in Word.
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4.3.3.2 Installing voices for audiobooks speech

Windows includes an accessibility tool called “Narrator” which allows that a
voice synthesizer plays audibly the content displayed on the screen. To access

this tool, go to “Control panel”, “Accessibility center” and select “Start narrator”.

The button “Voice settings” allows selecting the voice that will read the text.

@@v@' ¢ Panel de control » Todos los elementos de Panel de control » Centro de accesibilidad - | +3 | | Buscar er

Ventana principal del Panel de

control Facilitar el uso del equipo

# Cambiar configuracién Acceso rapido a herramientas comunes

administrativa Las herramientas de esta seccién le pueden ayudar a comenzar.
Windows puede leer y analizar esta lista automaticamente. Presione |a barra espaciadora para
seleccionar la herramienta resaltada.

B e ir de Micoaol, = 52 | | Detectar siempre esta seccién
S —

Archive Preferencias  Ayuda

El Narrador leera en voz alta la informacién que aparece en pantalla a

medida que navega con el teclade. & Iniciar Narrador

- ~
Configuracién principal del Narrader i Configuracién de voz: Narrador [é]
Hacer eco de las pulsacicnes de tecla del usuaric
pdal Seleccionar voz
Anunciar los mensajes del sistema
Esperanza -
[7] Anunciar notificacicnes de desplazamiento | Jorge
jtig] Microsoft Anna - English (United States) [
[ Iniciar el Marrader minimizado ScanSoft Isabel Drid0 16kHz -
Controlar si el Marrader se inicia al iniciar sesién Hadl X
Establecer velocidad [4 v]
Ayuda répida ] [ Configuracién de voz l [ Salir
Establecer velumen [9 v]
% Usar el equipe sin un mouse o teclado Ectablecer tono [5 v]
Configure dispositivos de entrada alternativg
-? Facilitar el uso del mouse [ == l i Cancelar ]
Ajuste la configuracion del mouse u otros di|
Facilitar el use del teclado

Figure 4-29. Selecting a voice for Windows narrator.

By default, only the “Microsoft Anna English (United States)” voice is installed
in Windows 7, which makes extremely annoying and unintelligible the speech in

languages different from English, due to its strong English pronunciation.

Also in this window other Narrator parameters can be configured, such as

speech rate, volume and tone.

In older versions of Windows (XP and earlier), the SAPI 4 interface was used.
The voices that SAPI 4 uses are not compatible with the new SAPI 5 interface,

which the latest applications use.
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Some voices in other languages can be downloaded from several websites,
such as from “AT&T Natural Voices” website, Acapela website or Nuance
Vocalizer website. In all cases, marketing is done by NextUp.com and

downloads are not free (they cost from 28€ to 36€ each).

Another classic voices provider for Narrators is Loquendo Text to Speech.
Today the company Loquendo has disappeared and is part of the company

Nuance.

Once the narrator voices have been installed, audiobooks can be created from

a Word document.

4.3.3.3 Creating audiobooks with Daisy

When the narrator voices have been installed and the default voice for
Windows has been selected, the creation of audiobooks can start. Before the
conversion, the .docx document should be validated because it may have some

element that cannot be converted.

-
MWiid9-08 3 0= = Matilde Asensi-El origen perdido.docx - Microsoft Word
m Inicio Insertar Disefio de pagina Referencias Correspondencia Revisar Vista Complementos Accessibility
abbr] abbr acr | acr | z E a% e «. er
£ e 0 5 o |l o & e AN <
SaveAsDAISY|  Mark As Manage Mark As Manage | Validate AddFootnote | Language Settings Version Translator

3 Abbreviation Abbreviation | Acronym Acronym Details Help~
DAISY ¥ML {from Single doc Acronyms Validate | DAISY Styles| AddFootnote | Language | DAISY Settings Help

Full DAISY ffrom single doog > Narrator-DtbookToDaisy |2t &' 1 8 1 & 1 7 1 8 8 a0 b e

| ¢
,@? DAISY XML (from Multiple doc

Full DAISY from Multiple docd  » EL ORIGEN pERDIDO

Matilde Asensi

Figure 4-30. Save file as “Full DAISY”.

The plugin asks for some metadata and options for the conversion process
(Figure 4-31). After this, the conversion starts (Figure 4-32).

When the process of creating an audiobook has finished, two folders will be
created, which contain the files of the audiobook in two different formats:

= Folder Z3986 has the “speechgen.opf” file. Open Packaging Format (OPF)

is a standard of the eBook specification and stores metadata such as title,
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language, creator, etc. This folder also has a XML file containing the text

and a MP3 file containing the audio of the audiobook.

= Folder Daisy202 has the same MP3 files but the text is saved in a HTML

file.

Narrator-DtbookToDaisy S50 S Sl e & @

Cutput directory |C:\Users\TDni\DesktDp Browse.. |

Document properties
Title: |Le55u:|r1 4

|
Creator: |Antonin and Eva

Publisher: |-

Llid: |5245052446252431542

DTBook Fix |App|y DTBook Fix routines j I

I¥ Apply sentence detection
I¥ Multi-language support
MP3 Bitrate |32 kbit/s

LefLe]

2.02 href target |text

<<Hide Advanced ‘ Translatel Reset ‘ Cancel ‘ i

Figure 4-31. Options dialog and metadata for converting to DAISY.

g ~

Pipeline Job Progress

| Running TTS Marrator (DAISY XML to DAISY Book)...

SpeechGen2 [9/14]

Cancel

Figure 4-32. Process of creating an audiobook.

In both cases, text and audio are linked, so that with an appropriate reader the
text can be followed while listening to it, or selecting the paragraphs you want

to listen. A recommended DAISY files reader is Adaptive Multimedia
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Information System (AMIS), developed by the DAISY Consortium and can be

downloaded and installed for free from their official website.

- N
< AMIS "Lessan 4" Default view mode - Self-voicing - Paused - [AMIS1] | oS S

File View Play Mavigate Bookmarks Info Help

E K BT .ﬁ EI

Navigation

Lesson 4

Conten

BASIC DATA OF THIS DOCUMEN
PART I. DESCRIPTION OF THE LI _
.- Welcome / Introduction to th
il| i Prior knowledge required

.- Learning objectives of the le:

Figure 4-33. Reading an audiobook synchronizing text and audio.

The MP3 file can also be extracted to be used as an independent audio file.

4.3.4 Creating audiobooks using the tool Balabolka

Balabolka is an application for converting Text-To-Speech (TTS). It uses the
voices already installed in the computer, which can be checked in Windows in
“Control pane - Accessibility center”. The application allows choosing the
voice to read the text. The text can be saved in any of the most popular
formats: WAV, MP3, MP4, OGG or WMA.

The text can also be copied to the clipboard and use Balabolka to read its
content. It is also able to extract the text of a document in the following formats:
AZW, AZW3, CHM, DjVu, DOC, EPUB, FB2, HTML, LIT, MOBI, ODT, PDF,
PRC and RTF; and customize font and background color, control reading from

the system tray or using hotkeys.

A version without graphical interface also exists, to create audiobooks from the

command prompt using commands.

Balabolka uses various versions of Microsoft Speech API (SAPI), which allows
modifying the voice parameters, including speed and tone. Users can define a
list of words to improve their pronunciation in the text. This is useful when you
want to change the pronunciation of some words. It allows saving audio files
with ID3 tags in MP3 files. This facilitates the text is displayed while the sound

plays in a suitable device (like MP3 music files).
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Balabolka can be installed as a normal application in Windows or using the

portable version, which allows running it on any computer without installation.

The graphical interface of the application has a window in which the text is
loaded, and a toolbar to work with it. It allows starting reading, changing the

voice of the speech, setting speed and tone, etc. (Figure 4-34 & Figure 4-35).

Balabolka - [Document]
e, ——

file Edit Text Speech Options View Tools Bookmark Help

Bo-das D es@e e@n| oo
[Microsft Anna linglés (Estados Unidos]] -] [ fbou ] [ Defat
Rete: D Pich: 0 Volume: 100
a0 ] y A0 y 10 0o U 100

HARRY POTTER AND THE CHAMBER OF SECRETS
by J. K. Rowling

(this is BOOK 2 in the Harry Potter series)

Criginal Scanned/OCR: Friday, April 07, 2000

v1io

(editwhere needed, change version number by 0.1)
CHAPTERR ONE

THE WORST BIRTHDAY

Motfar the firsttime, an argument had broken out over breakfast at
numhar fanr Privat Driva Mr Warnan Dorelav had hean wnkan in

Figure 4-34. Graphical interface of the application Balabolka.

-
%3 Balabolka - [Documentl]
File Edit Text Speech | Options | View Tools Bookmark Help
@ = ﬁ| @ @‘ Pronunciation Correction 3 | QB QEl v| [
[5API4| SAPIS |Micosoft 5f = Rate b
U Pitch v
[Microsoft Anna [inglés (Estad
@  Volume FE
Rate: 0 Reset Rate and Pitch  Ctrl+D Volume: 100
BV U 10 0 [N
i Audio Files... Shift+F5
% Settings.. Shift+F6
HARRY POTTER AND © 9 .
by J. K. Rowling F Spell Checker... Shift+F7
2  Audio Output... Shift+Ctrl+F5
(this is BOOK 2 inthe He @ TextImport...  Shift+Ctrl+F6
Qriginal Scanned/QCR: Clipboard Watch
vi0 )
(editwhere needed. chz Timer
After Saving of Audie File 4
CHAPTERR oN“E Voice ©  Microsoft Anna [Inglés (Estados Unidos]]

Figure 4-35. Selecting the voice of the speech.
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4.3.41 Creating audiobooks with Balabolka

When the reading parameters (voice, tone, speed, volume, etc.) are set and

tested with the text, conversion to an audio file in the desired format can start.

% Balabolka - [Documentl]
Edit Text Speech Options View Tools Boockmark Help
3 New Ctrl+N Elu|||
Open... Ctrl+ O
Reopen 4
@ Save Ctrl+5S
@ Save As.., Chrl+Alt+5 Pitch: 0
Images... (N
£ Save Audio File... Crl+W
g Split and Convert to Audio Files... Ctrl+Fg  |SECRETS
gy ID3 Tags.. Ctrl+]
38 Close Ctrl+Fd
&l Close Al Shift+Ctrl+F4
% Close All Except Current
by 0.1
Bit vy
CHAPTERR OMNE

Figure 4-36. Creating an audio file.

If the text is very long (e.g. a whole novel), playing the audio file generated can
take several hours. This is a disadvantage when trying to resume the speech
after having interrupted: it would be like a musical CD had all the songs in only

one track.

To solve this problem, the text document can be divided into smaller pieces, so
that each audio unit takes approximately five minutes. For indicating to the
application where the file has to be closed and start a new one, use the “Split

and convert to audio files” option in the menu.

Marks in the document have to be written in order to indicate the breakpoints.
As seen in Figure 4-37, there are several options.

The text read in each track can be included in the MP3 audio file as an ID3 tag,
in a similar way to how a song can include an ID3 tag with title, author,
performer, genre, etc. and also the song lyrics, which can be viewed on a

proper music player.
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Split the Text and Convert to Audio Files

- — e

Output File Folder:

Browse

Audio File Format: | WAV - Wave Audio Files

Base Output Filename: Document1

COutput File Maming

(@ sequence number after filename

() sequence number before filename

Voice: Microsoft Anna [Inglés (Estados Unidos)]

Starting Output File Sequence Number: 1

Split Method
by size of text blocks
[ by specified keywords in input tesxt
[ by two empty lines in succession

[ by lines where all letters are capital

Text Block Size: 1 KB
[ by named bookmarks
Split text at keyword and remave keyword from text
Pranounce number of block l
Test ] [ Split and convert ] [ Split Close

Figure 4-37. Options to divide the output file in various audio tracks.

-
1D3 Tags T .

2]

[¥] Set 1D3 tags

Information | Text

[ Add text to MP3 file for SAPI 5 and Microsoft Speech Platform)

Maximal length of text line {in characters): 150

Method of saving
1D3v2 synchronized text (SYLT)

Lyrics3v2 text (LYR)

The synchronized text can be saved in 103 tags inside the audio files (gt the same way as lyrics for songs).

Clear

OK

| [ Cancel

Figure 4-38. The audiobook created can include ID3 tags.
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4.3.5 Inserting audio in PDF documents

One of the most important characteristics of PDF files is that they can include
embedded multimedia files such as videos, audio or flash, making them more
attractive and thus enriching the educational potential of this material when

used in training.

The Adobe reader can play directly all H.264-compatible multimedia files. This
codec, also known as MPEG-4 part 10, is a video codec that allows high
resolution without excessive file sizes. If other non-compatible multimedia files
are included in a PDF, users will need to have installed the corresponding
playback applications. So, FLV, MOV and MP4 video files can be inserted into

a PDF document, as well as MP3 audio files.

Inserting audio in a PDF file allows teachers complementing the textual
information of the document and, from the point of view of accessibility,

providing an (auditory) alternative to the text reading.

Adobe Acrobat (not just Reader) is necessary to insert audio in a PDF file,

which is not free but widely used in many educational institutions.

The editing tool to be used is in menu “Tools - Multimedia - Sound tools”.

E, A Margarita Debayle.pdf - Adobe Acrabat Pro - - - - ‘
Archive Edicion  Ver Documento  Comentarios  Formularios m Avanzadas Ventana Ayuda
i Crear = @ Combinar ~ %‘] Colaborar ~ H} Protege LA AT * Litimedia ~ ,P Comentario ~
Seleccionar y Ampliar/Reducir L4
— = : .
L] = =] Q’ % 1 /2 T8 Eicion avangada » | Buscar i
Typewriter 3
Andlisis »
Multimedia @ Herramienta 3D

ﬁ Herramienta Flash
i Herramienta Senido
B Herramienta Video

Personalizar barras de herramientas...

Maostrar barra de herramientas Multimedia

A Margarita Debayle P
{Rubén Dario 1908) Pulsar para escuchar el poema ‘@l

Margarita, estd linda la mar,
y el viento

lleva esencia sutil de azahar;
yo siento

en el alma una alondra

ratae.

Figure 4-39. Tool for inserting audio in a PDF file.
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Previously, when the PDF document was created, an icon could have been
included to indicate to users that an audio is associated with the document and

where they have to click to listen to it.

With the tool selected, draw with the mouse the activation zone of the audio.

L

] L

Pulsar para escuchar el poema @]
i

Figure 4-40. Drawing the activation zone of the audio.

Then the data of the MP3 file and the playback options desired are entered.

Multiple multimedia files can be included in a PDF document.

i g ——— - “. (=3 |

r
Insertar sonido

Archivo: |J:LActuaIidad\[1201] Proyecto ESVIALNO-Taller 2\Recursos\A Margarita Debayle.mp3
Configuracién de inicio

Configuracién de activacion

Activar sit ’Se ha hecho clic en el contenido v]
Desactivar si: ’Se ha seleccionado "'Desactivar contenide" del mend contextual v]
Estilo de reproduccion: ’Reproducir contenide en ventana flotante v]
Ancho: |320 = Alte: (240 =
i Aspecto
| .
Ancho de borde: Sin borde -
{
| Imagen de poster

Mantener paster actual
() Recuperar cartel del multimedia

(@ Crear poster desde archivo

Archivo de poster |J:LActuaIidad\[1201] Proyecto ESVIAL\O-Taler 2\Recursos\EnBlanco.png

[
[¥] Mostrar opciones avanzadas [ Aceptar I’ Cancelar ]

H

h

Figure 4-41. Identification of the audio file and selection of playback options.
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When the file is saved, it can be distributed as usual and students just need a

PDF reader to see it and play the audio associated.

[ A Margarita Debayle.pdf - Adobe Acrobat Pro TN T T T oo o
Archiva Edicion Ver Documento C fvanzadas Ventana  Ayuda *
3 Crear * @ Combinar = &3] Colaborar = ([ Proteger = /' Firmar - B - P

OB ES &% 12 k) & (88 5% -] [ susor

A Margarita Debayle
(Rubén Dario, 1908)

Margarita, esta linda la mar,
y el viento

lleva esencia sutil de azahar;
yo siento

en el alma una alondra

Pulsar para escuchar el poema

|

Figure 4-42. When the audio inserted is played, a playback controller is

showed.

Another interesting option is including voice comments recorded directly with a

microphone and add them to the PDF document. This option is especially

useful in the tutoring process. For example, students may request a clarification

about the scope or the meaning of the text in a PDF, recording the question in

the PDF and submitting it to the teacher. The teacher, in turn, could add a new

recording with the answers to students.

To be able to insert comments in a PDF file, the option for commenting has to

be enabled in the creation phase. To do this, in menu “Comments”, check the

“‘Enable comments and analysis in Adobe Reader” option.

E-iwuw-w-mmm

dothven  Edbrstns 'Il'n.l:;u.vn:luduFm Homgrramls Svarcide Verlera  Spedd
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o g b par resmsin pod Cprrea eciebred o
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Ferfevat comantasce y anaina o Adoke Rnsde_

A hiary

By comonisncs

(Rubén @ Irfrema con imaman de pompsienct

Crlall

Chie1

v By Meeia T Comantass -

——
¥ peiintved

W

Figure 4-43. Enabling option for adding audio comments in a PDF document.
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In the document, now readers can insert a comment recording directly from

their microphone.

ﬁ A Margarita Debayle - copia.pdf - Adobe Reader =L
Archive Edicién  Ver Ventana Ayuda
@ @ 2 @ B @ ‘ ®) /2 | 71,5% . | lz‘ ¥ Herramientas : Firmar = Comentario | Al
n *| = Anotaciones
® %2 T &
A Margarita Debayle —— T, £ = T '1‘9
{Rubén Dario, 1908) Pulsar parg escuchar &f poema [@j =
B

Margarita, esté linda la mar Grabadora de sonidos i u
yvel ‘-'iento? '
lleva esencia sutil de azahar; | > 8 D | s (0)
vo siento -
en el alma una alondra AL
Cotan -
tu acento. . .
Margarita, te voy a contar = o tiene coment:
un cuento. m

Figure 4-44. The PDF reader can include voice comments.

From that moment, an icon will be visible in the document, with which the voice

comment included can be listened.

5 A gDt ot ot st 11 i
Archive Edicién  Ver Ventana Ayuda x
& e (= | ¥ .fl | | [ = Herramientas | Firmar . Comentario | Ampliado

] :
<
A Margarita Debayle — Luis
(Rubén Dario, 1908) Pulsar para escuchar el poema @l Clip de sonide (13 KB)
'
Margarita, esta linda la mar, ) |

Figure 4-45. All the comments performed will be visible in the PDF document

as icons.

Whenever audio is included in a PDF document, a textual alternative should be

provided with the audio description or the text of the speech.

4.4 Checking accessibility in audio and video files

By and large, accessibility of audiovisual content is achieved by providing
accessible alternative elements. It is important to attach audio descriptions to
the videos, especially for people with visual disabilities, so that they can follow
the sequence of actions in the video, complementing the sound and the original

176



GUIDE FOR CREATING ACCESSIBLE DIGITAL CONTENT

dialogues. For people with hearing disabilities, it is necessary to provide

alternative texts and the audio description of the documents.

Using the sign language using an interpreter is also possible, which is the most
common in conferences and live events, although an additional window can be
inserted in a video to display the sign language interpreter. However, the last
option is usually available only at a professional level, reserved for institutional
documents, and is not considered as a necessary requirement for accessible

educational content created by teachers.

Unlike reading, in which students can set the speed at which a text is read, in
audiovisual content the playback speed is set beforehand. This can be an
additional barrier to accessibility if, for example, the time to read the captions of
a video is not enough. It is therefore necessary that audiovisual educational
content used by teachers are played in a window with appropriate controls
(pause, continue, restart, etc.). In addition, these controls should also be
available through keyboard to allow people with visual or motor disabilities do

not have to use the mouse to control playback.

In short, accessible alternatives for audiovisual content can be grouped into five

categories:

= Audio and video playback controls with keyboard alternatives.
= Transcript of audiovisual content.

= Captions.

= Audio description.

= Sign language interpreter (reserved for professionals).
4.41 Accessibility checklist for audio documents

If audio documents are included as educational content, the following should be
checked to ensure their accessibility:

= Existence of alternative text. Check that an alternative text is included for all

the audio content. This can be done:
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- In the same document. For example, in a PDF file or in a webpage.
- Using a link from the original document to reach the alternative text.

Appropriate alternative text. Check that the alternative text allows identifying
not only the talk but also who is talking, noises (clapping, falling objects,
cars moving away, etc.) and everything that helps understanding the

meaning to be conveyed with the audio document.

Playback control. Check that the document can be paused and resumed,

restarted, etc.

4.4.2 Accessibility checklist for videos

Videos usually include a soundtrack, so that alternatives to make it accessible

should include both visual band and the soundtrack. In the latter case, the

accessibility requirements are the same as for other audio files, so the

soundtrack should follow the checklist of the previous section.

To ensure the accessibility of videos used as educational content, the following

should be checked:

Existence of alternative text.

(Requirement in common with audio documents).

Appropriate alternative text.

(Requirement in common with audio documents).

Playback control.

(Requirement in common with audio documents).
Besides the usual playbacks, the following should be included for videos:

- Resizing the window of the video playback, including the whole window

of the device used.

- Enable / disable captions. For captions in several languages, users

could choose between them.



GUIDE FOR CREATING ACCESSIBLE DIGITAL CONTENT

Captions.

Check that the alternative text provided is synchronized with the actions in

the video, and appear properly on the playback screen. To do this:

- Captions should correspond to the soundtrack, including dialogue and

sounds.
- The text displayed on the screen should not take up more than two lines.

- The time for displaying a caption should be enough to be read

comfortably.

- The font size must be appropriate, as well as its color and contrast to the

images in which overlies.

Captions can be stored in a different file from the video’s or being
embedded in the frames of the video. The advantage of the latter option is
that their appearance does not depend on the video player used to play it.

However, there are several drawbacks that make it inadvisable, such as:
- It does not allow hiding/displaying captions, as they always appear.
- It does not allow using captions in several languages.

- It does not allow searching by text, which some players have and which
facilitates moving to a particular video sequence in which the text

searched is, within captions.
Flashes and flickers.

Flashing or flickering video frames can cause epileptic seizures in people
with photosensitive epilepsy. Therefore, special care should be taken when
flashes appear in a video or sequences in which very clear images suddenly
change by other dark.

As a rule, no more than three flashes per second should appear or take up
more than a quarter of the screen. Also, flicker should not appear with a
frequency between 4 and 60 hertz.
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Free tools such as Photosensitive Epilepsy Analysis Tool (PEAT) (2012)

allow evaluating the potential danger of a video for people with this

sensitivity.

V‘ - UW Trace Center Photosensitive Epilepsy Analysis Tool (PEAT) (Beta Version 1.52)

File Capture Analysis Controls View Position Help

Ve

s

TRACE CENTER

UNIVERSITY OF WISCONSIN-MADISON

< Luminance flash:
< Red flash:
Extended Flash:

Lum flash diag:
Red flash diag:

(No file open)

-~

[

(No file open)

l

QL J®

O @
©O0 0 O

OO0®

Show warnings

(Mo file open)

Ready

Figure 4-46. PEAT Tool which allows evaluating the potential danger of a
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Chapter 5. Creating accessible web pages

Translators: Authors:

Eva Garcia Lopez Teresa Diez Folledo
Antonio Garcia Cabot Maria José Dominguez Alda
University of Alcala, Spain University of Alcala, Spain

Accessibility is very important when designing websites and webpages, in order

to ensure the use of Internet for all.

In 1994 the international consortium W3C was created, whose mission is to
lead the web to its full potential by developing protocols and guidelines that
ensure long-term growth. Within this consortium, WAI emerged, whose aim is
broadcasting the web accessibility principles to enterprises, governments,

institutions, developers and users.

At this moment the WAI recommends using the WCAG 2.0, published in
(2008), which will be the basis of the work of this guide, whose objective is not
teaching how to create a website or a webpage (this knowledge is considered a
prerequisite for this course), but to explain the steps to be followed and the

recommended checkings to create accessible webpages.

The tools that can be used to evaluate the accessibility of webpages in a

website are also detailed.
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5.1 Guidelines to create accessible web contents

WAL, entity to disseminate the web accessibility principles within the W3C
consortium, recommends developing web content following the WCAG 2.0
guidelines (World Wide Web Consortium, 2008).

These accessibility recommendations are based on four fundamental
principles, perceivable, operable, understandable and robust, under which
twelve guidelines are established, which provide the basic goals that authors
should work toward in order to make content more accessible to users with

different disabilities:
1. Perceivable:

1.1.Provide text alternatives for any non-text content so that it can be
changed into other forms people need, such as large print, braille,

speech, symbols or simpler language.
1.2. Provide alternatives for time-based media.

1.3. Create content that can be presented in different ways (for example

simpler layout) without losing information or structure.

1.4.Make it easier for users to see and hear content including separating

foreground from background.
2. Operable:
2.1.Make all functionality available from a keyboard.
2.2.Provide users enough time to read and use content.
2.3.Do not design content in a way that is known to cause seizures.

2.4.Provide ways to help users navigate, find content, and determine where
they are.

3. Understandable:

3.1.Make text content readable and understandable.
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3.2.Make Web pages appear and operate in predictable ways.

3.3.Help users avoid and correct mistakes.

4. Robust:

4.1.Maximize compatibility with current and future user agents, including

assistive technologies.

These guidelines have become an international standard on which a website

should be based from the early stages of design. For each of the guidelines,

success criteria are provided, which in turn are divided into three levels: A, AA
and AAA.

Finally, five conformance requirements are established, which must be

satisfied:

Conformance level: To achieve conformance with A, AA or AAA levels, a
webpage satisfies all the success criteria of the level, or an alternate version

conforming to the level is provided.

Full pages: Conformance (and conformance level) is for full Web page(s)

only, and cannot be achieved if part of a Web page is excluded.

Complete processes: When a Web page is one of a series of Web pages
presenting a process, all Web pages in the process conform at the specified

level or better.

Only accessibility-supported ways of using technologies: Only accessibility-
supported ways of using technologies are relied upon to satisfy the success

criteria.

Non-interference: If technologies are used in a way that is not accessibility
supported, or if they are used in a non-conforming way, then they do not

block the ability of users to access the rest of the page.

A detailed description of the aspects of the webpage to be considered for a

formal assessment of the level of compliance with the WCAG 2.0 (World Wide

Web Consortium, 2008) success criteria in levels A and AA is explained below,
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both of the webpage and the elements with accessibility requirements included
in it.
In each of the sections are described the success criteria that should be met

and the recommended checkings for each of them.

Finally, how to perform an overall evaluation of the accessibility of the webpage
is explained, both automatically (using the tools available on the web) and

manually (installing a free screen reader).

5.2 Developing an accessible website

5.2.1 Language of the website

The language of the webpage should be defined correctly so that browsers,
screen readers and other devices that work in various languages can identify it
and display correctly the information of the webpage. This will facilitate

understanding the content to all users, with or without disabilities.

If the content of a webpage are written in different languages, it is necessary to
identify the language in each part so that any application can perform the
necessary adaptations. For example, a webpage written in Spanish may
include a paragraph or quote in English, or a link to the English version of the

webpage whose text is in turn in English.

Guideline 3.1 (Readable) contains the success criteria 3.1.1 (level A) and 3.1.2
(level AA):

3.1.1. Language of page. The default human language of each Web page can

be programmatically determined.

3.1.2. Language of parts. The human language of each passage or phrase in
the content can be programmatically determined except for proper
names, technical terms, words of indeterminate language, and words or
phrases that have become part of the vernacular of the immediately

surrounding text.
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The language used, both in the webpage and in each of its elements, is defined
using the “lang” attribute on the HTML element of the body of the page or of the
corresponding element, if a different language used from the rest of the page.
You should check this attribute is defined for the entire webpage and for each
element (sections, paragraphs, links, etc.) that uses a different language, and

that it is correctly defined; i.e., the language used is accurately identified.

Using Web Accessibility Toolbar by Internet Explorer, option “Doc info - Show

lang attributes”.

5.2.2 Descriptive title of the webpage content

The title of the webpage allows users to quickly and easily identify the
information contained in the webpage. For people with cognitive disabilities and
low vision or other difficulties who use audio devices to navigate the web, it is
important that the title clearly describes the information in the webpage. On the
other hand, this description will appear in site maps or in search results,

allowing users to decide whether the webpage fits their needs or preferences.
Guideline 2.4 (Navigable) contains the success criterion 2.4.2 (level A).
2.4.2. Page titled:

- Web pages have titles that describe topic or purpose.

- The descriptive title of an HTML Web page is marked up with the
<title> element so that it will be displayed in the title bar of the user

agent.
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You should check that the title of the webpage that appears in the title bar at
the top of the screen® describes adequately the information contained on the
webpage. The option “Navigation = Title” in Web Developer Toolbar by Mozilla

Firefox, can be used to check it.

5.2.3 Information structure

The objective of a webpage is to convey its content so that its presentation
should not obstruct the access to it. Guideline 1.3 (Adaptable) contains the

following success criteria (level A):

1.3.1. Info and relationships. Information, structure, and relationships conveyed
through presentation can be programmatically determined or are

available in text.

1.3.2. Meaningful sequence. When the sequence in which content is presented
affects its meaning, a correct reading sequence can be programmatically

determined.

It is recommended to perform the following checkings.

5.2.3.1 Separation of content from the visual presentation

HTML tags to structure the content and CSS style rules to present the content
should be used together. The correct separation of presentation and content
can be checked by disabling CSS:

= Using Web Developer Toolbar for Mozilla Firefox, selecting the option “CSS
- Disable styles > All styles”.

° It may be not seen due to the CSS style rules used. It will be checked when they are
disabled or by viewing the source (check the existence of the tag <title> describing the
page content).
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= Using Web Accessibility Toolbar for Internet Explorer, selecting the option
“CSS - Disable CSS”.

Once the style rules are disabled, check that the page content is still

understandable and its meaning has not been modified.

5.2.3.2 Structured content

Content should be structured according to semantic criteria that provide
meaning and prioritize information. The elements and sections in the content
should be identified, distinguishing lists, headers, paragraphs, links, and data
tables. Semantic tags are used, which allow providing an additional meaning to
the content (important text highlighted, special text like an e-mail, etc.) and
more specifically the elements included in the webpage. This will prevent the
content presentation generates accessibility issues. Guideline 2.4 (Navigable)

contains the success criterion 2.4.6 (level AA):
2.4.6. Headings and labels. Headings and labels describe topic or purpose.

The following checkings are recommended to be performed:

Headers

Using clear and descriptive headers allows users understanding the structure
of the page and finding more easily the information searched. It is
recommended to check that the webpage contains headers that identify each

section of the content.

= Using Firefox Web Developer Toolbar to check the correct order, option
“Outline - Outline headings”. With this activation, how the headers are

organized can be checked, and so perform an evaluation of their use.
Tags

Using descriptive tags allows users identifying the elements on a webpage.
Once each component of the webpage is identified, it is recommended to verify

that they are correctly tagged and that the tag clearly indicates its purpose. The
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recommended checkings are detailed in section B, in which the accessibility

requirements of the different elements of a webpage are described.

5.2.3.3 Coherent, consistent and homogeneous presentation in

navigation elements

Navigation elements help users to know where they are within the website, to
move between the content and to identify the main information of the webpage,

facilitating accessibility.
Guideline 3.2 (Predictable) includes the success criterion 3.2.3 (level AA):

3.2.3. Consistent navigation. Navigational mechanisms that are repeated on
multiple web pages within a set of Web pages occur in the same relative
order each time they are repeated, unless a change is initiated by the

user.

In websites that consist of a large number of pages it is also recommended, for
facilitating the overall accessibility, to include a site map or a table of contents
in which a hierarchical list is included with all the pages that compose it. This
site map should contain the main sections and depict well the structure of the

website.
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Figure 5-1.  Site map.
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education

* Course Catalog
* Courses taught in English

> Courses in Social Sciences
for international studants

» Courses in Humanities for
international students

» Dissertation Research in
English and French

> Spanish Courses
> Other Languages

> Programs of the Franklin
Institute (Studv Abroad and

5.2.3.4 Correctly using HTML and CSS

Using wrong HTML tags or poorly defined style rules may lead support devices

to confusion. Guideline 4.1 (Compatible) includes the success criterion 4.1.1

(level A):

4.1.1. Parsing in content implemented using markup languages:

- Elements have complete start and end tags.

- Elements are nested according to their specifications.
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- Elements do not contain duplicate attributes, and any IDs are unique,

except where the specifications allow these features.
The following checkings are recommended:

= Check whether the HTML tags format is correct, because improper use of
tags can affect screen readers and other support products. Use the W3C

official validator (markup validation service).

= Check whether the CSS style sheets format used is correct: Use the W3C

official validator (CSS validation service).
5.2.4 Presentation of the webpage

5.2.4.1 Using color

In relation to the use of color, the perceivable principle contains Guideline 1.4
(Distinguishable) and under it the success criteria 1.4.1 (level A) and 1.4.3
(level AA):

1.4.1. Use of color: Color is not used as the only visual means of conveying
information, indicating an action, prompting a response, or distinguishing

a visual element.

1.4.3. Contrast (minimum): The visual presentation of text and images of text

has a contrast ratio of at least 4.5:1, except for the following:

- Large Text: Large-scale text and images of large-scale text have a

contrast ratio of at least 3:1;

- Incidental: Text or images of text that are part of an inactive user
interface component, that are pure decoration, that are not visible to
anyone, or that are part of a picture that contains significant other

visual content, have no contrast requirement.

- Logotypes: Text that is part of a logo or brand name has no minimum

contrast requirement.

The following checkings are recommended:


http://validator.w3.org/
http://validator.w3.org/
http://jigsaw.w3.org/css-validator
http://jigsaw.w3.org/css-validator
http://www.sidar.org/traducciones/wcag20/es/#visual-audio-contrast-without-color
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Check that there is an alternative to every information conveyed with

color differences in the webpage

It refers to situations in which each color has a meaning, such as forms that
highlight with a certain color the mandatory or wrong fields, or links identified
with different colors when their target opens in a new webpage. In all cases it
should be checked that another mecanism has been included to convey the
information, either by an alternative text, in the text label of the field or other

options.

Check values of color contrast and test color changes that may improve

the contrast
The following tools can be used:
= For Firefox, use the extension \WCAG contrast checker.

= Use the online analyzer Web Accessibility Evaluation (WAVE), which allows
testing colors to achieve the adequate contrast using the extension

“Accessibility evaluation toolbar”.

= |nstall and use the analyzer Colour contrast analyser, application that allows

checking specific points of the webpage.

5.24.2 Text size

About the text size, in the Perceivable principle is included Guideline 1.4

(Distinguishable), which contains success criterion 1.4.4 (level AA):

1.4.4. Resize text: Except for captions and images of text, text can be resized
without assistive technology up to 200 percent without loss of content or

functionality.

To verify this guideline, using the browser zoom at 200% is recommended, and

then checking that both the content and the page functionality are available.
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5.2.4.3 Sound on webpages

In Guideline 1.4 (Distinguishable), success criterion 1.4.2 (level A) can be

found:

1.4.2. Audio control: If any audio on a Web page plays automatically for more
than three seconds, either a mechanism is available to pause or stop the
audio, or a mechanism is available to control audio volume

independently from the overall system volume level.

When using a screen reader, it is necessary to be able to disable any sound

that prevent or interfere hearing the voice output.

Therefore, you should check that every sound with duration longer than three

seconds can be controlled by the user.

5.2.4.4 Flashes, blinks, movement and automatic refresh

Flashes, blinks or movements in the content of web pages are evaluated in this
section. These aspects refer to avoid causing flashes on the screen or rapid
changes in luminosity. A flickering or flashing screen may cause attacks to

users with photosensitive epilepsy.

First flashes on the screen should be evaluated, by applying Guideline 2.3 (Do
not design content in a way that is known to cause seizures) and the success

criterion 2.3.1 (level A):

2.3.1. Three flashes or below threshold: Web pages do not contain anything
that flashes more than three times in any one second period, or the flash

is below the general flash and red flash thresholds (level A).

W3C provides the PEAT (2012) tool. This is software that identifies the risks
that web content may have, if flashes, blinks or movements occur. To perform
the analysis it is necessary to capture navigation in the website being analyzed,
by creating an AVI video file. Once the capture of the page is done, a report

about it is written.
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Guideline 2.2 (Enough time) contains the success criterion 2.2.2. Pause, stop,
hide (level A):

2.2.2. For moving, blinking, scrolling, or auto-updating information, all of the

following are true:

- Moving, blinking, scrolling: For any moving, blinking or scrolling
information that (1) starts automatically, (2) lasts more than five
seconds, and (3) is presented in parallel with other content, there is a
mechanism for the user to pause, stop, or hide it unless the
movement, blinking, or scrolling is part of an activity where it is

essential; and

- Auto-updating: For any auto-updating information that (1) starts
automatically and (2) is presented in parallel with other content, there
is a mechanism for the user to pause, stop, or hide it or to control the
frequency of the update unless the auto-updating is part of an activity

where it is essential.

The following aspect to be evaluated is automatic refreshing the webpage. This
refers to those webpages that are refreshed at irregular intervals, i.e., without
the user requiring this refresh, which can cause the user be disoriented by the
refresh. Whenever possible, try to avoid automatic refresh, although sometimes
there is no choice but to use them. If necessary, the user should be able to
choose the moment when these refresh occur. The Firefox Web Developer
Toolbar can be used. This toolbar offers to evaluators the possibility of

disabling automatic refresh (Figure 5-2).
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(@) Disable-| & Cookiesw # €55+ [
3

Dizable Cache
Disable DMS Cache

Dizable Java

Disable JavaScript k

v Dizable Meta Redirects
Dizable Minimum Font Size
Disable Page Colors
Disable Popup Blocker
Disable Proxy r
Dizable Referrers

Figure 5-2. Disable automatic refresh in Web Developer Toolbar.

Once the automatic refresh is disabled, you should check whether the webpage

keeps all the functionality and aspect without using these techniques.

5.2.4.5 Limits on the interaction time with the webpage

Limiting the interaction time with a webpage may complicate reading the
content or performing functions such as filling out a form to users with low
vision or cognitive disabilities, who may need more time. It is recommended to
avoid its use whenever possible, allowing customization or extension when the
limit is necessary. In Guideline 2.2 (Enough time) is included the success

criterion 2.2.1 (level A):

2.2.1. Timing adjustable: For each time limit that is set by the content, at least

one of the following is true:

- Turn off: The user is allowed to turn off the time limit before

encountering it.

- Adjust: The user is allowed to adjust the time limit before
encountering it over a wide range that is at least ten times the length

of the default setting.
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Extend: The user is warned before time expires and given at least 20
seconds to extend the time limit with a simple action (for example,
"press the space bar"), and the user is allowed to extend the time

limit at least ten times.

- Real-time exception: The time limit is a required part of a real-time
event (for example, an auction), and no alternative to the time limit is

possible.

- Essential exception: The time limit is essential and extending it would

invalidate the activity.
- 20 hour exception: The time limit is longer than 20 hours.

It is recommended to check that the user can stop, adjust or extend the existing
time limits except in the two exceptions described: when the time limit is due to

a real-time event or is longer than twenty hours.

5.2.5 Access via keyboard

In the Operable principle are Guideline 2.1 (Make all functionality available from
a keyboard) and 2.4 (Provide ways to help users navigate, find content, and
determine where they are), and the success criteria 2.1.1, 2.1.2 and 2.4.3 (level
A) and 2.4.7 (level AA):

2.1.1. Keyboard: All functionality of the content is operable through a keyboard
interface without requiring specific timings for individual keystrokes,
except where the underlying function requires input that depends on the

path of the user's movement and not just the endpoints.

2.1.2. No keyboard trap: If keyboard focus can be moved to a component of
the page using a keyboard interface, then focus can be moved away
from that component using only a keyboard interface, and, if it requires
more than unmodified arrow or tab keys or other standard exit methods,

the user is advised of the method for moving focus away.
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2.4.3. Focus order: If a Web page can be navigated sequentially and the
navigation sequences affect meaning or operation, focusable
components receive focus in an order that preserves meaning and

operability.

2.4.7. Focus visible: Any keyboard operable user interface has a mode of

operation where the keyboard focus indicator is visible.

As an initial checking, an exploration of the website will be performed using the

keyboard to check whether all the functionality is kept.

Then the use of keyboard to interact with the website should be checked, first
verifying that keyboard traps have been avoided, i.e., the user always should
be able to exit the application with the tab key without getting “stuck” when

he/she finishes navigation. WCAG 2.0 recommends the following checkings:
1. Itis possible to use the tab key from the start to the end of the content.
2. The keyboard focus is not trapped in any of the content.

3. If the keyboard focus is trapped in any content, check that the available help

information explains how to exit the content using the keyboard.

About Guideline 2.4.3, which refers to the focus order, it is recommended to
check that the webpage contains a logical tabulation order and therefor a
logical navigation order. The default tab order starts in the first link or control of
the document, continuing in the order that these elements appear on the
webpage. The Internet Explorer bar, Web Accessibility Toolbal, can be used as

seen in Figure 5-3.

When the tab order is enabled, the order of every content while navigating the
webpage using the keyboard is showed on the webpage, by numbers, allowing

checking whether it is correct.
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Fieldset [ Labels

Paragraphs
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Tab Order

Tahinde:

Access Keys

Show Other Elements)

Figure 5-3. Show tab order in Web Accessibility Toolbar.

For checking the success criterion 2.4.7, moving through the webpage using
the keyboard is recommended, verifying that there is a visual mechanism that
indicates the position of the focus on the webpage. Thus users who rely on
keyboard to navigate can visually identify the element with which they are
interacting at all times. This mechanism may be, for example, a mark or a
highlighted border.

5.2.6 Embedded objects and scripts

Embedded objects such as scripts or Java applets should be fully accessible
without the need of an alternative provided the technology used supports
accessibility and the object or script has been developed in an accessible way.
This method provides dynamic documents and minimizes the workload on Web
servers, as part of the work is derived to clients. Accessible alternatives are
required, as well as providing information and functionalities included in the
programming elements through means which allow their correct interpretation

and availability to all users.

In conformance requirements of WCAG 2.0, the following is mentioned

(requirement 5):
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5. Non-interference: If technologies are used in a way that is not accessibility

supported, or if they are used in a non-conforming way, then they do not

block the ability of users to access the rest of the page. In addition, the Web

page as a whole continues to meet the conformance requirements under

each of the following conditions:

- When any technology that is not relied upon is turned on in a user agent.

- When any technology that is not relied upon is turned off in a user agent.

- When any technology that is not relied upon is not supported by a user

agent.

To evaluate this kind of technologies, Javascript should be disabled and check

that no information of the webpage is lost and it is still navigable. The option to

disable Javascript in the browser can be used, or the following tools:

= For Firefox, the Web Developer Extension.

= For Internet Explorer, the Web Accessibility Toolbar.

To disable Javascript using the option of the browser, for example in Firefox, go

to the tab “Content” (only in versions prior to Firefox 23).

If using Web Accessibility Toolbar for Internet Explorer, you could simulate that

the browser does not support JavaScript as shown in Figure 4.

[E Tables~ | E Frames~ | @ Doc Info.-| | & IE|~

v Toaggle Image L Sequridai

Togale Jawvascript

W
v Toggle Activesx
v Toggle C55

Text Size 4

iT. Inkernet Options Dialog " Color
Internet Explorer Accessibility Options
l windows Accessibility Options del cam
nnnnnn N ._ kAT CMRREGTE H

Figure 5-4. Disabling JavaScript with Web Accessibility Toolbar.
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Once the technology JavaScript has been disabled, a manual review of the
functionality of the website without JavaScript could be performed, and check
how this deactivation affects the website functionality. By doing this, although
user agents do not support this technology, alternatives to this should be

provided for accessing the content.

To validate the embedded objects of the page, as for scripts, it is necessary to
disable the technology that supports this type of objects. For this evaluation,
the Web Accessibility Toolbar for Internet Explorer is used to disable supporting

ActiveX objects, as seen in Figure 5-5.

- | 8 1E 3| & Dev | 7 aviewer

a | v ToggleImage

+ Refs -

v Toggle Javascript

Toggle ActiveX

v Toggle C55
Text Size *

Internet Opticns Dialog
Internet Explorer Accessibility Options
Windows Accessibility Options

Figure 5-5. Disabling ActiveX with Wed Accessibility Toolbar.

5.3 Accessibility of the webpage elements

5.3.1 Images

The accessibility of images on a website is essential for the correct overall
perception of the website. To evaluate them, they are divided into alternatives

to images and text images.

5.3.1.1 Alternatives to images

Recommendations related to the accessibility of images are within the
Perceivable principle. Guideline 1.1 (Text alternatives) contains the success

criterion 1.1.1 (level A):
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Non-text content: All non-text content that is presented to the user has a
text alternative that serves the equivalent purpose, except for the

situations listed below.

Controls, input: If non-text content is a control or accepts user input,

then it has a name that describes its purpose.

Time-based media: If non-text content is time-based media, then text
alternatives at least provide descriptive identification of the non-text

content.

Test: If non-text content is a test or exercise that would be invalid if
presented in text, then text alternatives at least provide descriptive

identification of the non-text content.

Sensory: If non-text content is primarily intended to create a specific
sensory experience, then text alternatives at least provide descriptive

identification of the non-text content.

CAPTCHA: If the purpose of non-text content is to confirm that
content is being accessed by a person rather than a computer, then
text alternatives that identify and describe the purpose of the non-text
content are provided, and alternative forms of CAPTCHA using output
modes for different types of sensory perception are provided to

accommodate different disabilities.

Decoration, Formatting, Invisible: If non-text content is pure
decoration, is used only for visual formatting, or is not presented to
users, then it is implemented in a way that it can be ignored by

assistive technology.

To evaluate whether this guideline is met, displaying the alternative text for
each image instead of the image should be enabled, and checking that no
information of the webpage is lost and is still navigable. The option to disable

browser images should be used, or the following tools:
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= In Internet Explorer, using the Web Accessibility Toolbar: option “Images ->

Remove images”.

= In Firefox, using the “Accessibility Evaluation Toolbar” extension. In this
toolbar, enable the option to display the alternative text, available at: “Text

equivalents - Show text equivalents”.

= In Firefox, using the Web Developer Extension. In this toolbar, the following

options can be enabled:

- Display alternative text with the image. Option available at: “Images >

Display alt attributes”.

- Display only alternative text. Option available at: “Images -> Replace

images with alt attributes”.

One of the exceptions aforementioned described referred to non-textual
content that serve as decoration. These images are used as graphical
resources for the design of webpages and do not provide any information or
functionality. These kinds of images should be included using CSS style
sheets. If included in the HTML code, it should be implemented so as to be
ignored by screen readers or similar support devices. To do this, check that no

description or alternative text (attribute alt="") is included.

For functional images, used to serve as link to a webpage or a file, the
alternative text associated to an image should clearly describe the objective of

the link. The following is an example of the correct use of the alternative text:

=

5.3.1.2 Text images

< Link to email.

Text images are considered within the Perceivable principle, in Guideline 1.4
(Make it easier for users to see and hear content including separating

foreground from background). Under it is the success criterion 1.4.5 (level AA):
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1.4.5. Images of text: If the technologies being used can achieve the visual
presentation, text is used to convey information rather than images of

text except for the following:

- Customizable: The image of text can be visually customized to the

user's requirements. This occurs when the following can be set:
- Font type.

- Size.

- Color.

- Background.

- Essential: A particular presentation of text is essential to the
information being conveyed. It is considered essential because if

deleted, the information of functionality of the content would change.

An example of these text images can be to include a logotype on a webpage,
the logo of a university or a bank. In this case, the success criterion is met

because it is essential to include the text of the logotype to convey information.

Figure 5-6 does not allow modifying the characteristics aforementioned, and
uses a textual alternative that correctly describes the image but not its
functionality. This is an important aspect for allowing its reading using screen

readers and making it accessible for users with visual or cognitive disabilities.

Universidad de Alcald

Figure 5-6. Image with the logo of the University of Alcala.
5.3.2 Multimedia (audio, video, presentations)

If a webpage includes multimedia elements, their accessibility should be
evaluated according to what explained in Unit 4 of the workshop.
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5.3.3 Forms

One of the elements of a webpage where more accessibility issues can be
found is forms. The aspects to be taken into account so that these elements

are accessible for all users are described below.

5.3.3.1 Labels of form controls

A label describes the purpose of a control, if correctly defined, allowing all
users to know it even when using support devices. In Guideline 3.3 (Input
Assistance) and 4.1 (Compatible) are included the success criteria 3.3.2 and
4.1.2 (level A):

3.3.2. Labels or instructions: Labels or instructions are provided when content

requires user input.

4.1.2. Name, role, value: For all user interface components: the name and role
can be programmatically determined; states, properties, and values that
can be set by the user can be programmatically set; and notification of
changes to these items is available to user agents, including assistive

technologies.

Checking that all controls that require it have a label

Mombre Introducido c,

[lahel for="idpersona 1] |E|ija persona del PAS (Personal de Administracion y Servicios}l

| [id="idpersona1"] | Seleccione un nombre o |

|[5|be fDF"idDersDnaZ"]IElija persona del PDI (Personal Docente & Investigadur}|

| [id="idpersonaZ2"] | Seleccione un nombre W |

id="botonverdztos") || Ver Datos )

Figure 5-7. Labels highlighted in a form using Web Accessibility Toolbar.
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= Using the Web Accessibility Toolbar for Internet Explorer, with option
“Structure - Fieldset / Labels”, LABEL items can be highlighted (Figure
5-7).

= Using the Web Developer Toolbar for Firefox, option “Outline - Outline

custom elements”.

Checking that labels are correctly placed

A label should be placed immediately before or after its control, in the same line
(or above the control, if the line is different) or the control should be placed
within the label (Figure 5-8).

Nombre:

Figure 5-8.  Form control label placed before it.

To check the correct placing of the labels, the webpage can be accessed,
disabling styles. This checking can be performed using the available options to

disable styles in the toolbars:

= Using Web Developer Toolbar for Mozilla Firefox, option “CSS - Disable
styles > All styles”.

= Using Web Accessibility Toolbar for Internet Explorer, option “CSS >
Disable CSS”.

5.3.3.2 Required fields

The required fields should be clearly identified. It should also be checked, as
explained in page 191, that they are identified in an alternative way to the
commonly used visual indicator (color or asterisk) to ensure the accessibility of

the form.
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5.3.3.3 Unforeseen changes in the webpage

Accessing or entering data in the form controls should not cause changes in
the webpage, except when the user has been previously warned. Guideline 3.2

(Predictable) includes the success criteria 3.2.1 and 3.2.2 (level A):

3.2.1. On focus: When any component receives focus, it does not initiate a

change of context.

3.2.2. On input: Changing the setting of any user interface component does not
automatically cause a change of context unless the user has been

advised of the behavior before using the component.

Therefore, it should be checked that no changes are produced, unless notice,
when entering information in the form controls. WCAG recommends including
buttons to Send, Confirm and See data, which indicate that this change will

OcCcur.

Elija persona del PAS (Personal de Administracion y Servicios)

Seleccione un nombre W |

Elija persona del PDI (Personal Docente e Investigador)

Seleccione un nombre e |

Figure 5-9. Button indicating that a change will occur on the screen.

5.3.3.4 Errors in data entry

Users should be informed about the errors in data entry, if it occurs. Guideline
3.3 (Input Assistance) contains the success criteria 3.3.1 (level A), 3.3.3 and
3.3.4 (level AA):

3.3.1. Error Identification: If an input error is automatically detected, the item

that is in error is identified and the error is described to the user in text.

205



CHAPTER 5: CREATING ACCESSIBLE WEB PAGES

206

3.3.3. Error suggestion: If an input error is automatically detected and
suggestions for correction are known, then the suggestions are provided
to the user, unless it would jeopardize the security or purpose of the

content.

3.3.4. Error prevention (legal, financial, data): For Web pages that cause legal
commitments or financial transactions for the user to occur, that modify
or delete user-controllable data in data storage systems, or that submit

user test responses, at least one of the following is true:
- Reversible: Submissions are reversible.

- Checked: Data entered by the user is checked for input errors and

the user is provided an opportunity to correct them.

- Confirmed: A mechanism is available for reviewing, confirming, and

correcting information before finalizing the submission.

To check it, wrong data will be entered in the corresponding fields, checking
whether errors are detected and suggestions are obtained about the correct
data entry. These criteria complement criterion 3.3.2. described in 5.3.3.1 about

information in form fields.

It should also be checked, in the case of errors described in criterion 3.3.4, that

option for confirming, reviewing or resending data has been included.

5.3.3.5 Using and submitting the form is independent of

supporting scripts

A form should not lose functionality if JavaScript is disabled (see section 5.2.6).
To check whether a form depends on scripts, the tools for disabling it included

in Web Developer Toolbar and Web Accessibility Toolbar can be used.

Check that, once the scripts support has been disabled, the form can be filled

out and submitted correctly.
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5.3.3.6 Using and submitting the form is independent of the

device used

A form should be usable by any input device, either a stylus or a keyboard or a
voice browser. Therefore, in the case of including scripts in forms, device-
independent event handlers (also called application triggers: onfocus, onblur,

onselect, onchange) should be used.

Web Accessibility Toolbar for Internet Explorer has an option to assist in this

task: “Structure - Event handlers” (Not in recent versions).

A window appears with the result, allowing to know the number and type of
event handlers used and to check that no mouse-dependent (onclick,

onmouseover) or keyboard-dependent (onkeypress) handlers are used.
5.3.3.7 Accessing the form via keyboard

As described in 5.2.5, all the elements of a webpage should be operable only
with keyboard. It will be necessary to check that the tab order of the elements

in a form is correct.

= A manual checking can be done through the interaction elements of the
page and observing that not inconsistent jumps occur between controls and

the tab order follows the logical reading order of the page.

= Using Web Accessibility Toolbar, option “Structure - Tab order indicator”,

the tab order for the interaction elements of a page is showed (Figure 5-10).

= |t can also be checked using a screen reader such as NVDA or JAWS

(demo).

5.3.3.8 In complex forms, with lots of input data, the information is

correctly grouped

In forms with lots of input data, the controls should be grouped according to
their meaning and functionality. To group several controls element FIELDSET
is used, and element LEGEND is used for the mandatory group description.
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urstudies

entras and departments
ternatianaL relations

: :
esearch and innovation

niversity life

Figure 5-10. Showing the tab order in Web Accessibility Toolbar.

= To check if elements FIELDSET and LEGEND are correct, the following can

be performed manually:

- Disabling CSS styles, as described in 5.2.3, and checking that the
border representing FIELDSET appears.

- Using Web Accessibility Toolbar for Internet Explorer, option “Structure
- Fieldset / Labels”.

- Using Web Developer Toolbar for Firefox: “Outline - Outline custom
elements - Fill out with FIELDSET and LEGEND”.

5.3.4 Navigation mechanisms

The consistency and clarity of navigation mechanisms directly influence the
ability of identification, recognition and understanding the structure of the
website, facilitating that users find what they are looking for, regardless of their
capacities. The steps recommended to be followed for checking and evaluating

the accessibility of web navigation elements are detailed below.
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5.3.41 Bypass blocks

In a website frequently some content blocks are repeated in its different pages,
such as the links section or the table of contents or an image common to all

pages. Guideline 2.4 (Navigable) contains the success criterion 2.4.1 (level A):

2.4.1. Bypass blocks: A mechanism is available to bypass blocks of content

that are repeated on multiple Web pages.

It is recommended to check, manually or using a support device, that there is a
mechanism to bypass blocks: either through links at the top of the page that
jump this content (leading to the main content), using a proper headers
structure that allows to support devices navigating at different levels of header
page (5.2.3.2) or defining hotkeys (accesskey). The following checkings can be

performed:
= Using Web Accessibility Toolbar, option “Structure - Access Keys”.

= Using Web Developer Toolbar, with option “Information - Display Access

Key”.
5.3.4.2 The text of links clearly identify their target or functionality

It should be sufficiently clear what resource will be accessed by users when a
hyperlink is activated, even when read out of context. Guideline 2.4 (Navigable)

includes the success criterion 2.4.4 (level A):

2.4.4. Link purpose (in context): The purpose of each link can be determined
from the link text alone or from the link text together with its
programmatically determined link context, except where the purpose of

the link would be ambiguous to users in general.
The following checking is possible to be performed:

= Using Web Accessibility Toolbar, option “Doc info - List links”, a list of the
links in the webpage is obtained, indicating the text of each link, its URL, its
title and its target (where the link opens).
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= Using Web Developer Toolbar, option “Information = View link information”,
although the information showed is more limited, because only the URL of

each link is indicated.

|[@Docwiow] @ ~ | @ 0er | S avie

Page Information [new window]

Metadata Information [new window]

Show Lang Attributes
Show Titles

Skip Links

| List Links [new window]

JavaScript / Mew Window Links

| List Downloadable Files [new window]

View Partial Source

DO Viewer

Figure 5-11. Showing the list of links.

If the list of links is not obtained, navigating with the tab key for checking the
coherency is also possible, or using a support instrument such as a screen

reader, which access linearly to the information of webpages.

If the link is performed through an image, the alternative text should work as
the link text, so that you should check that the text is sufficiently descriptive of

the functionality or target of the image.

5.3.4.3 Checking the consistency of links

Two identical links should refer to the same target or resource and vice versa,
two links to the same target should be showed similarly. Broken links (wrong or
non-existent) should be avoided in a webpage. Guideline 3.2 (Predictable)

includes the success criterion 3.2.4 (level AA):

3.2.4. Consistent identification: Components that have the same functionality

within a set of Web pages are identified consistently.
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W3C Link Checker is an online tool developed by the W3C that allows checking
the links of a webpage and generates a detailed report, which contains the line
where the link is, the error code obtained and the error description returned by
the server. The depth level to which you want to perform the analysis of the

links can also be defined.

= Using Web Accessibility Toolbar, option “Check - W3C link checker >

Check current page”, this application can be used.

= Using the “Tools” menu of the Web Developer Toolbar, option “Validate
links”, W3C Link Checker can be used.

List of broken links and other issues

There are issues with the URLs listed below. The table summarizes the issues and suggested actions by HTTP response status code

Code | Occurrences | What to do

.
[3%)

0 3 The link is forbidden! This needs fixing. Usual suspects: a missing index_html or Overview html, or a missi

i
=

0

48 The link i1s broken Double-check that you have not made any typo, or mistake in copy-pasting If the link ¢

& Line: 300 http://'www.uah.es/estudios/otros_estudios/inicio.shtm

Status: 404 Not Found

The link is broken. Double-check that you have not made any typo, or mistake in copy-pasting. If the link points to a resource that no longer exists, you may

Figure 5-12. Report obtained about the links of a website.

5.3.4.4 There is more than one path to each of the pages in the

website

Different options to visit the pages of a website should be offered. Thus users
can navigate selecting the most comfortable and simple way for them: people
with cognitive disabilities may prefer a table of contents or a sitemap while
others with visual disabilities may navigate easily using a search or exploring
the website sequentially, going from one page to another. Guideline 2.4

(Navigable) contains the success criterion 2.4.5 (Level AA):

2.4.5. Multiple ways: More than one way is available to locate a Web page
within a set of Web pages except where the Web Page is the result of, or

a step in, a process.
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WCAG recommends including tables of contents or sitemaps, including a
search function that allows locating the content or creating links in the

homepage to all other pages of the website and links between related pages.

| Search

_

Figure 5-13. Search function in a website.

5.3.4.5 Unforeseen changes in the webpage

As aforementioned, unexpected behaviors by users should be avoided, as they
may confuse or mislead them, thus impacting in the accessibility of a website.
Guideline 3.2 (Predictable) has the success criteria 3.2.1. and 3.2.2. (level A):

3.2.1. On focus: When any component receives focus, it does not initiate a

change of context.

3.2.2. On input: Changing the setting of any user interface component does not
automatically cause a change of context unless the user has been

advised of the behavior before using the component.

Checking whether there are links that open in new windows

On a web page, opening a link in a new window can be performed in two

different ways: using the attribute target or using JavaScript.
To check it, in both cases:

= Using Web Accessibility Toolbar, option “Doc info - JavaScript / New
window links”. This option will show in an alert message the number of links
using attribute target and the number of links using JavaScript in attribute
href. In addition, it informs with a graphic icon about existing links that open

in a new window.
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= Using option “Information - Display link details” in the Web Developer
Toolbar, the content of attributes href and target (if used) of each link in a

web document can be observed.

After verifying the existence of links (textual or graphical) that open in a new

window, you should check that users are provided with information about it:

= Included in the text of the link or in its attribute title. Using option

“Information - Display tittle attributes” of the Web Developer Toolbar.

= Including a graphical element that indicates visually to users (and through

its alternative) the opening of a new window.

= Including the text "Opens in a new window" in the link and show it as a

tooltip using CSS when the focus is on the link.

Checking whether there is automatic redirection

Automatic redirection is directing the user to a different web page without
his/her prior consent. This behavior causes disorientation and is a malpractice

for accessibility and usability of a website, so it should be avoided.

= Using the Web Developer Toolbar, option “Disable - Disable meta

redirects”, redirections in the page can be disabled.

5.3.5 Tables

Data tables place information in rows and columns, thus describing a
relationship between cells in the same row and/or column. This structure can
be easily observed visually, but it should be also conveyed to users who want

to access the table in a non-visually way.

Guideline 1.3 (Adaptable) contains the success criteria 1.3.1. and 1.3.2 (level

A), and the following is stated:

1.3. Create content that can be presented in different ways (for example

simpler layout) without losing information or structure.
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1.3.1. Info and relationships: Information, structure, and relationships conveyed
through presentation can be programmatically determined or are

available in text.

1.3.2. Meaningful sequence: When the sequence in which content is presented
affects its meaning, a correct reading sequence can be programmatically

determined.

These checks can be performed after differentiating between layout tables and

data tables.

5.3.5.1 Layout tables

To layout and place elements, developers should use style sheets. However,
when a table is necessary to layout, the order of the information in the table
should be understandable when it is linearly transformed. Success criterion
1.3.1. states that using structural elements in a way that it does not represent
the structure or relationships in the content is a failure. Information and implicit
relationships in the visual format should remain when changing the

presentation format.

= Using Web Accessibility Toolbar by Internet Explorer, option “Tables -

Linearize”.

5.3.5.2 Data tables

Data tables allow showing information related between the elements that
compose it, being structured in rows and columns so that the relationship is
easily understandable both in a visual and non-visual way. Thus, the cells of
each row and/or column should be properly identified when creating data

tables.

Firstly, tables should have a title, element CAPTION. The title of a table

describes its nature. It can be checked:

= Using Web Accessibility Toolbar by Internet Explorer, option “Tables -

Show data tables”.
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= Using Firefox Web Developer Toolbar, option “Outline - Outline table >

Captions”.
To correctly check the accessibility of the elements in a data table, be sure that:
= Row and column headers are properly identified using element TH.
= They are properly associated with their cells using the scope or id attribute.
The table headers can be displayed:

= Using Web Accessibility Toolbar by Internet Explorer, option “Tables >

Table header”, the existence of headers is checked.

= Using Firefox Web Developer Toolbar, option “Information - Display table

information”.

Header cells categorize the information in their row or column. To convey that
information to users, it is necessary to use mechanisms that allow associating
headers with cells of the table. Mechanism scope performs the association.

This method is used in headers and indicates the header scope, either row or

column or a group of rows and columns.

[E Miscellaneous~ # Ou

Display Abbreviations
Display Access Keys
Display Anchors

Display ARIA Roles

Digplay Div Dimensions
Display Div Qrder

Display Element Information
Display Id & Class Details
Display Link Details
Display Object Information
Display Stack Levels
Display Tab Index

Display Table Depth
Display Table Information
Display Title Attributes

Display Topographic Information

Figure 5-14. Activation of association using scope.
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For checking the existence of this association method, Firefox Web Developer
Toolbar will be used. To activate this option within the toolbar, do the steps

showed in Figure 5-14.

This option also allows checking the existence of a table summary through
attribute "summary". A summary of the relationships between cells is very
important in tables with nested headers, cells occupying several rows or
columns, or other relationships that are not so evident in an analysis of the
structure of the table, but that can be visually observed. A summary can also

describe the function of a table in the current document.

5.3.6 Frames

Frames are used to organize pages in different areas so that different web
pages are displayed in each frame. The web pages can be independent or be
related. The use of frames is strongly discouraged, and structuring web pages
in different sections is recommended. However, frames are dealt in WCAG 2.0
as any other content, so it is possible to apply accessibility criteria on them.
The way to link documents in frames may mislead some users, so they may

have difficulty establishing relationships between the content in frames.

Frames evaluation is based on two success criteria in WCAG 2.0. The first one,

4.1.2. (level A) is under principle 4 (Robust):

4.1.2. Name, role, value: For all user interface components (including but not
limited to: form elements, links and components generated by scripts),
the name and role can be programmatically determined; states,
properties, and values that can be set by the user can be
programmatically set; and notification of changes to these items is

available to user agents, including assistive technologies.

Any component of the user interface must be correctly determined with its
name, role and value, so that the content is interpreted by browsers, media
players, screen readers, voice recognition software or other devices. You

should check that every frame has a title describing its content (title) and the
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relationship between the frames of the page, using (if necessary) a long

description (longdesc) in one of the frames for this purpose.
= Using Web Accessibility Toolbar, option “Frames - Frame Name / Title”.

The other success criterion related to frames is 2.4.1 (level A) of Guideline 2.4.
Provide mechanisms for helping users with disabilities to navigate, locate

content and determine where they are:

2.4.1. Bypass blocks: A mechanism is available to bypass blocks of content

that are repeated on multiple web pages.

This success criterion aims to allow web users to directly access the primary
content of pages, avoiding unnecessary blocks. The content shown should
keep linearity to maintain consistency between the document structure and
visual structure. This makes the browser interprets the format of the blocks of
the document and users can select some parts to be read. The recommended

checking has been described in 5.3.4.

Frames should include an equivalent accessible alternative (tag NOFRAMES)
including links to descriptions of the frames of a page and navigation

mechanisms to navigate the web site.

5.3.7 Lists

Lists are groups of interrelated elements. They may be Ordered, Disordered
(<ul>) or Definition lists (<dI>). Lists should be used for this purpose and not to

establish certain formatting effects such as indentation effect.

The main problem with lists is that blind users may be lost in their structure,
especially in nested lists and in those that do not specify the nesting level for

each list item.

For numbered lists, compound numbers are more informative than simple
ones. Thus, a numbered list “1, 1.1, 1.2, 1.2.1, 1.3, 2, 2.2, ...” provides more

context than the same list without compound numbers.
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A text label should be provided before or after the sentence of the list item to
ensure that users understand the differences between the items of the list
indicated visually. To verify that lists are correctly structured, Web Accessibility

Toolbar can be used, option “Structure - List items”.

e

Guide for International
Researchers

Figure 5-15. Labels identifying a list and its items.

Avoiding images is recommended, containing or not additional information
about the content of the list, such as bulleted lists. However, if used, an

equivalent text as described in 5.3.1. should be provided.
5.4 Overall accessibility evaluation of the webpage

5.4.1 Device independence

Regardless of the device used to access web content, information should
always be available and accessible for users. This intends to any user,
anywhere and anytime can access to all information using any device, thus
avoiding web fragmentation in accessible spaces only for certain devices. In
recent years, due to growth in the variety of devices to access the Web, it is

important to develop accessible content from any device.

The first checking to be done is an evaluation of functionality and the
appearance of the page in the most currently used browsers: Internet Explorer,

Mozilla Firefox, Google Chrome, Safari and Opera.
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In addition to the manual evaluation using the aforementioned browsers, the
automatic tool SortSite can be used. The tool (0) also evaluates the most

currently used mobile technologies (iOS, Android and BlackBerry).

Browser Internet Explorer Firefox  Safari  Opera Chrome i0s Android BlackBerry
Version 7.0 8.0 9.0 10.0 £20 21 5.0 6.0 <120 <26 27 4.0 5.0 6.0 £3.0 40 =71 10.0 Key

Citicallssies ® ® ® ©® ® @© ©® ® ® @ VO PO ® © ©® © @ Missing content or functionality on some browsers
Mailssies @ @ @ © © © @ @ @ © © Q0 0 Major layout or performance problems on some

browsers

Minorkstes © @ @ © © O 0 @ @ © O Q0 0 Minor layout or performance problems on some

browsers

Figure 5-16. Evaluation of browsers and technologies with SortSite.

5.4.2 Functionality of the webpage using a screen reader

NonVisual Desktop Access (NVDA)reads the content shown on the screen for
blind people or people with visual disabilities, either by passing the cursor over
the page content (with the application enabled) or by using the keyboard by
combining a set of keys that allow users to navigate the web content. It uses
different sounds to indicate the user what action is he/she performing, e.g. if it

is an edition area (enter text) or a button to perform an action.

Using this application allows checking the accessibility of the elements of the
page, checking whether all the elements can be read, checking the problems to

read a web page with many links and if there is a correct reading order.

5.4.3 Detailed automatic accessibility validation of a webpage
according to WCAG 2.0.

Using at least four different tools is recommended because some tools can

overcome the limitations that others have.

The four online WCAG 2.0 evaluation tools recommended (you must provide

the URL of the page to be evaluated) are:
= TAW.

=  AChecker.
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= eXaminator.

= Tingtun Ckeckers.

5.4.4 Obtaining an overall rating of the accessibility of the

webpage

There are automatic tools to obtain an overall rating of the accessibility of a

webpage, such as eXaminator or eGOVMON.

= eXaminator is an online tool that evaluates the accessibility of a webpage,
using as reference the techniques recommended by WCAG 2.0, although it
does not include all the success criteria, and giving a score between 1 and

10 as a quick indicator about the accessibility of pages.

= Tingtun Checkers (n.d.) is still under development. It evaluates the
accessibility of a webpage and generates a list with the evaluated criteria,

and the result is a score of the page between 0 and 100.


http://examinator.ws/
http://accessibility.tingtun.no/en/pagecheck2.0
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Glossary

Accessibility checker: Tool for checking whether a PowerPoint presentation includes

any aspect that may be a trouble for users with disabilities.

Accessibility status report: The accessibility report summarizes the results of the
accessibility checking. It contains links to tools and documentation that help to

solve problems.

Accessibility: Accessibility means, as stated in ISO/TC 16027, “the usability of a
product, service, environment or facility by people with the widest range of

capabilities”.

Accessible PDF: PDF document that has been subjected to a process of accessibility

checking and has passed technical checkings.
Accesskey: Keyboard shortcuts for common tasks.

Alternative text: Text that appears when the mouse is over a figure or an object, and
helps people who use screen readers to understand the content of the figures

in the presentation.

Alternatives to images: Text describing the image and appears on the location of the

image when it cannot be displayed.

Assistive products: According to the 2007 version of ISO 9999, “an assistive product
is any product (including devices, equipment, instruments, technology and
software) especially produced or generally available, for preventing,
compensating, monitoring, relieving or neutralizing impairments, activity
limitations and participation restrictions”. Assistive products are those created
to allow or facilitate a person with disabilities performing certain tasks and that,
due to his/her functional limitations, may need to be compensated. In the case

of assistive products for communication and information, this standard defines
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them as “devices for helping a person to receive, send, produce and process

information in different forms”.

Attribute: Some additional information can be added in some HTML elements. That

information is called attribute.

Audio video Interleave (AVI): A multimedia container for audio and video that allows
simultaneously storing a data stream of video and multiple audio streams, and

it is played by an external program called codec.
Audioblog: A blog variant, in which authors regularly publish audio files.
AVI:  Acronym for Audio Video Interleave.

Captcha or CAPTCHA: Acronym for Completely Automated Public Turing test to tell

Computers and Humans Apart.

Cascading Style Sheets (CSS): Technology developed by W3C in order to separate
structure and presentation. CSS style rules define the presentation of the

webpage, allowing defining different rules for different devices.

Check accessibility: Process by which a tool checks whether a document meets

certain accessibility standards.

Completely Automated Public Turing test to tell Computers and Humans Apart
(CAPTCHA o Captcha): It is a challenge-response test used in computing to

determine when the user is human or not.

Contrast: Relative difference in intensity between a point of a figure and its

surroundings.

Create accessible PDF files: A predefined action that automates may tasks, it checks
the accessibility and provides instructions for those elements that require

manual corrections. Locate and correct quickly problematic areas.
CSS: Acronym for Cascading Style Sheets.
DAISY: Acronym for Digital Accessible Information System.

Design for all or universal design: The condition which must be ensured by
environments, processes, assets, products and services, also by objects or
instruments, and tools and devices, must be understandable, usable and
practicable by everybody, with security, comfort, and autonomy and in natural

conditions, without having to make or adaptations or specialized design.
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Digital Accessible Information System (DAISY): Is the standard format for

audiobooks and other audible texts.

E-book or electronic book: The main feature of readers is that they use an ink
technology without backlight, so that they do not fatigue sight. When using
books in EPUB format, readers can set the font size, thus reconfiguring

automatically the pages of the book to avoid scrolling on the screen.

Electronic PUblication (EPUB): An open source format for electronic books aimed to
be read in an e-book reader. In format EPUB, the content adapts to different

screen sizes.

Element or tag FIELDSET: Tag used to define logical groups of form elements. It is

jointly used with tag LEGEND, which names those groups.
EPUB: Acronym for Electronic PUblication.

Event handlers: Functions performing specific actions when an action happens on
the page (a mouse click, a key is pressed, the mouse is over, an image is

loading, etc.).

eXtensible Markup Language (XML): Is a meta tag language used to store data in a

readable way.

Headers: HTML tags defining special paragraphs, formatted as titles, for which a
larger font size and bold text are set. There are various types of headers, which
differ in the font size used: <h1> for larger headers, <h2> for second level

headers and so on until <h6>, which is the smallest header.
HTML: Acronym for HyperText Markup.

HyperText Markup Language (HTML): The most used markup language to describe

the structure and information when creating web pages.

JavaScript An interpreted programming language that allows improving the user

interface and dynamic web pages.
Keyboard shortcuts: Key combinations for common tasks.

Logical event handlers or device independent: Functions performing actions when
an action happens and does not depend on a specific device (a page is

loading, an element receives focus, an option is selected, etc.).
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Luminosity: Also called clarity, it is a property of colours. The darker the colour, the

weaker the luminosity.

Magnifier: It is software that expands images and texts. This type of application allows
zooming the text characters and other content shown on the screen to sizes
set by the user. Currently, computers have added this accessory known as a

magnifying glass or screen magnifier to the/their accessibility tools.

Moving Pictures Experts Group 2 (MPEGZ2): A group of audio and video codification
standards for transmission signals, which include digital terrestrial, satellite or

cable television.

MP3: Compressed digital audio format with loss. It is part of standard MPEG-1 audio
layer. Due to the low file size and the ability to adjust the quality, it has become

a standard and is supported by most players.

MP4: A multimedia container format standard specified as a part of MPEG-4. It is
most-commonly used to store digital audio and digital video streams, especially
those defined by MPEG, but also can be used to store other data such as

subtitles and still images.
MPEG2: Acronym for Moving Pictures Experts Group 2.
Narration: Story recorded about the content of the presentation.

Navigation elements: Navigation systems are the elements of an interface that allow

navigating the different sections and pages of a website.

Outline view: PowerPoint tool that shows the structure of the slides in a presentation

and their text as an outline.

PDF document: A file that may contain text, figures and tables, published in one of

the most used formats to distribute files on the web.
PDF: Acronym for Portable Document Format (see PDF document).

Photosensitive epilepsy: Type of epilepsy in which the attacks are caused by visual

stimuli such as flashing lights or alternating images.

Podcast: Free audio file, which contains interviews, speeches, music, tutorials, etc.
and which can be downloaded and listened in a computer or music player.
They originally appeared as audible versions of blog posts and were distributed

by RSS. Today, many radio stations and television include on their websites
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podcasts with programs already released, so that they can be downloaded by

users and listened on demand.

Reader: It is a software tool that enables people with visual disabilities to navigate and
interact with the operating system and its applications, including web browsers.
This software application attempts to identify and interpret what is displayed on
the screen. Then this interpretation is showed to the user via text-to-speech

synthesizers, sound icons or a braille output.

RGB: Colour model based on additive synthesis. It allows to represent a colour by

admixture of the three primary colours of light: red, green and blue.

Screen readers: Software that allows using the operating system and applications by
using a speech synthesizer that “reads and explains” what is displayed on the
screen, which helps people with severe visual disabilities or completely blind

people.

Script, applet or Java object: It is a program that can be embedded in a HTML
document, i.e., in a webpage, incorporating improvements. The program will be

automatically downloaded and will run on the user’'s machine.

Selection pane: PowerPoint tool that shows all objects in a slide and the order in

which they will be read by a screen reader.

Semantic tags: Tags making up the semantic web, some tags do not truly provide
new functionalities but are used to compose sites indicating what are the code
blocks of a web (header, article, section, footer), rather than how they should

be depicted.
SMIL: Acronym for Synchronized Multimedia Integration Language.

SRT: The format extension of software SubRip, which is free and open source
software, whose main function is to rip or extract the captions and their

synchronization time of a video.
STAMP: Acronym for Subtitling Text Add-In for Microsoft PowerPoint.

Subtitling text add-in for Microsoft PowerPoint (STAMP): Subtitling Text Add-in for

Microsoft PowerPoint. It is a Microsoft PowerPoint add-in for editing captions.

Synchronized Multimedia Integration Language (SMIL): W3C standard for
multimedia presentations. Language SMIL allows integrating audio, video,

images or text with proper synchronization using XML files.

231


http://es.wikipedia.org/wiki/Hypertext_Markup_Language

GLOSSARY

232

Tags or HTML tags: Marks used to indicate the beginning and end of a page element.
All tags have the same format, starting with the less-than sign "<" and ending

with the greater-than sign ">".

Target attribute: The HTML target attribute is used to open a link in a target different

than the current window.

Timed Text Markup Language (TTML): File format of synchronized text markup

language used to create captions.

Tooltip: Visual aid that appears when the cursor is placed over any graphic element,

providing additional information about it.
TTML: Acronym for Timed Text Markup Language.

Usability: The extent to which a product can be used by specified users to achieve
specified goals with effectiveness, efficiency and satisfaction in a specified

context of use.

WAV: Digital audio format without data compression, developed by IBM and
Microsoft. It was widely used at the beginning of the digital age, but nowadays

its use has declined.
WCAG: Acronym for Web Content Accessibility Guidelines.

Web Content Accessibility Guidelines (WCAG): Document that explains how to

create accessible web content for people with disabilities.

Windows Media Audio (WMA): Is an audio format owned by Microsoft, similar to
MP3.

Windows Media Video (WMV): A generic name given to the set of compression
algorithms located in the set of video technologies developed by Microsoft,

which is part of the framework Windows Media.
WMA: Acronym for Windows Media Audio.
WMV: Acronym for Windows Media Video.

XML: Acronym for eXtensible Markup Language.
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